# Contents

## About This Manual

- What Is QuickField? ................................................................. 10
- How to Use this Manual ......................................................... 10
- Conventions .............................................................................. 11

## Chapter 1  Getting Started

- Required Hardware Configuration .............................................. 12
- QuickField Installation ............................................................. 12
  - Autorun Applet ................................................................... 13
  - Using QuickField Setup Program ....................................... 13
- QuickField password (for Professional version only) ............. 14
- Modifying, Repairing and Removing QuickField .................. 15
- Installing Several Versions of QuickField Simultaneously ..... 15
- Application-Wide Options ...................................................... 16

## Chapter 2  Introductory Guide

- Basic Organization of QuickField ........................................... 18
- Window Management Tips ..................................................... 20
  - Problem Window .............................................................. 20
  - Document Windows .......................................................... 21
  - Tool Windows .................................................................. 21
  - Properties Window ........................................................... 22
- Overview of Analysis Capabilities .......................................... 22
  - Magnetostatic Analysis ....................................................... 22
  - Transient Magnetic Analysis ............................................. 23
  - AC Magnetic Analysis ...................................................... 24
  - Electrostatic Analysis ....................................................... 25
Chapter 3 Problem Description 31
Structure of Problem Database .................................................. 31
Editing Problems .................................................................... 31
    Editing problem description properties ................................ 32
    Establishing Coupling Links .................................................. 33
    Setting Time Parameters ...................................................... 35
    Automatic Time Step Size Calculation in Transient Analysis ...... 36
Choosing Length Units ............................................................. 38
Cartesian vs. Polar Coordinates ............................................... 39
Problem Properties Window .................................................... 39

Chapter 4 Model Geometry Definition 41
Terminology ............................................................................ 41
Geometry Description ............................................................. 42
    Creating Model Objects ....................................................... 42
    Basic Objects Manipulation ............................................... 44
Drag and Drop and Clipboard Editing ....................................... 49
Undo/Redo Operations ............................................................ 56
Definition of Properties, Field Sources and Boundary
    Conditions ........................................................................... 59
Meshing Technology .............................................................. 59
Geometry Model Properties Window ......................................... 61
Tuning the View of the Model .................................................. 62
Zooming .............................................................................. 63
Model Discretization Visibility ................................................ 63
Background Grid .................................................................... 64
Exchanging Model Fragments with Other Programs .................... 65
Importing Model Fragments from DXF Files .............................. 65
Exporting Model Fragments to DXF Files ................................. 66
Copying Model Picture to Windows Clipboard ..................... 66
Exporting Model Picture ............................................................ 66
Printing the Model.............................................................................. 67

Chapter 5  Problem Parameters Description  68
Editing properties of materials and boundary conditions .......... 69
Creating a New Label........................................................................ 70
Editing Label Data........................................................................... 70
Editing Data in DC and Transient Magnetics.............................. 71
Editing Data in AC Magnetics......................................................... 76
Editing Data in Electrostatics ......................................................... 81
Editing Data in DC Conduction Problems................................. 83
Editing Data in AC Conduction Problems................................. 85
Editing Data in Transient Electric Analysis .............................. 87
Editing Data in Heat Transfer Problems...................................... 89
Editing Data in Stress Analysis .................................................... 91
Periodic Boundary Conditions.................................................... 95
Editing Curves................................................................................ 96
Temperature Units........................................................................... 97
Using Formulas.............................................................................. 98
Copying, Renaming and Deleting Labels................................. 109

Chapter 6  Electric Circuit Definition  111
What is a Circuit?.............................................................................. 111
How to Create a Circuit ................................................................. 112
Adding Electric Components to the Circuit............................ 112
Specifying Properties for Circuit Components....................... 112
Adding Components Representing Model Blocks to the Circuit................................................................. 114
Connecting Circuit Components with Wires............................ 114
Editing Circuit................................................................................ 115
Moving, Copying and Resizing Circuit Elements....................... 115
Rotating Circuit Components....................................................... 116
Deleting Circuit Elements............................................................. 116
Chapter 7  Solving the Problem  117

Achieving Maximum Performance ........................................... 118
Adaptive Mesh Refinement ................................................... 118

Chapter 8  Analyzing Solution  120

Building the Field Picture on the Screen ................................ 121
Interpreted Quantities ......................................................... 121
Field Presentation Methods .................................................. 126
Field Picture Constructing ................................................... 127
Zooming ............................................................................ 130
Selecting a Time Layer .......................................................... 130
Animation ............................................................................ 131
Calculator Window ................................................................ 132
Examining Local Field Data .................................................... 133
Analysis of Connected Electric Circuit ...................................... 133
Current and Voltage Time Plots for the Circuit Elements .... 135
Parameter Calculation Wizards ................................................ 136
Inductance Wizard ................................................................. 137
Capacitance Wizard ............................................................... 140
Impedance Wizard ............................................................... 142
Editing Contours .................................................................. 143
X-Y Plots ............................................................................. 144
X-Y Plot Control ................................................................. 145
Calculating Integrals ............................................................ 146
Data Tables .......................................................................... 169
Table Columns ...................................................................... 169
Table Rows .......................................................................... 170
Plots and Tables versus Time .................................................. 171
Time Plot ............................................................................. 172
Time Plot Curves ................................................................. 173
Time Dependencies Table ....................................................... 174
Controlling the Legend Display ................................................. 175
Trajectories of Charged Particles ............................................ 175
Theoretical Background ......................................................... 175
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Trajectories ........................................................................ 176</td>
</tr>
<tr>
<td>Export of Field Calculation Results ........................................... 179</td>
</tr>
<tr>
<td>Printing the Postprocessor Pictures ............................................. 179</td>
</tr>
<tr>
<td>Copying the Postprocessor Pictures .............................................. 179</td>
</tr>
<tr>
<td>Field Export into File .................................................................... 180</td>
</tr>
<tr>
<td>Additional Analysis Opportunities ................................................ 181</td>
</tr>
<tr>
<td>Field Distribution Along the Contour Harmonic Analysis ................. 182</td>
</tr>
<tr>
<td>Partial Capacitance Matrix Calculation for the System of Conductors .... 182</td>
</tr>
</tbody>
</table>

**Chapter 9  Working with 3D Problem**

| Introduction ................................................................................. 186 |
| Creating 3D Model by Extrusion ............................................... 187 |
| Creating 3D Model by Importing from CAD .................................. 188 |
| 2D and 3D problems ..................................................................... 189 |
| 2D problems ................................................................................ 189 |
| 3D problems ................................................................................ 190 |
| Problem definition – adding 3D features .................................... 190 |
| Geometry model in the 3D subsystem .......................................... 191 |
| Creating 3D Model by Extrusion ............................................... 192 |
| Creating 3D Model by Importing ............................................... 196 |
| 3D View of the Model Editor ..................................................... 197 |
| Manipulation with 3D view ......................................................... 198 |
| Image rotation, panning and zooming ......................................... 200 |
| Object selection ........................................................................... 202 |
| Hidden and Transparent Bodies ................................................... 204 |
| Cutting the Model by a Plane ...................................................... 205 |
| Text label assignment to the 3D model objects ............................ 206 |
| Control of the Density of 3D Mesh ............................................. 207 |
| 3D Finite Element Mesh .............................................................. 207 |
| Editing material properties and boundary conditions .................... 209 |
| Solving 3D problems ..................................................................... 209 |
| Result analysis ............................................................................ 209 |
| Calculation results window ......................................................... 210 |
| Result presentation modes control .............................................. 211 |
Field view presentations ........................................................... 212
Local field values calculation ..................................................... 229
Integral calculation ................................................................... 230

**Chapter 10 Add-ins** 233

Add-ins Available in QuickField ................................................ 234
Advanced Add-in Features ....................................................... 234
Adding, Editing and Deleting Add-ins ........................................ 234
Creating Your Own Add-ins ..................................................... 235
Add-in Properties Dialog Box ................................................... 235
Add-in Menu Item Dialog Box .................................................. 237

**Chapter 11 Theoretical Description** 238

Magnetostatics ........................................................................... 239
Field Sources ........................................................................... 239
Boundary Conditions ............................................................... 240
Permanent Magnets .................................................................. 242
Calculated Physical Quantities .................................................. 242
Inductance Calculation ............................................................. 244
Transient Magnetics .................................................................. 245
Field Sources ........................................................................... 247
Boundary Conditions ............................................................... 248
Permanent Magnets .................................................................. 249
Calculated Physical Quantities .................................................. 250
AC Magnetic ............................................................................ 252
Field Sources ........................................................................... 255
Boundary Conditions ............................................................... 256
Calculated Physical Quantities .................................................. 257
Impedance Calculation ............................................................. 260
Electrostatics ............................................................................ 261
Field Sources ........................................................................... 261
Boundary Conditions ............................................................... 262
Calculated Physical Quantities .................................................. 263
Capacitance Calculation ............................................................ 264
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Conduction Analysis</td>
<td>265</td>
</tr>
<tr>
<td>Field Sources</td>
<td>266</td>
</tr>
<tr>
<td>Boundary Conditions</td>
<td>266</td>
</tr>
<tr>
<td>Calculated Physical Quantities</td>
<td>267</td>
</tr>
<tr>
<td>AC Conduction Analysis</td>
<td>268</td>
</tr>
<tr>
<td>Field Sources</td>
<td>269</td>
</tr>
<tr>
<td>Boundary Conditions</td>
<td>269</td>
</tr>
<tr>
<td>Calculated Physical Quantities</td>
<td>270</td>
</tr>
<tr>
<td>Transient Electric Analysis</td>
<td>272</td>
</tr>
<tr>
<td>Field Sources</td>
<td>272</td>
</tr>
<tr>
<td>Boundary Conditions</td>
<td>272</td>
</tr>
<tr>
<td>Calculated Physical Quantities</td>
<td>274</td>
</tr>
<tr>
<td>Heat Transfer</td>
<td>275</td>
</tr>
<tr>
<td>Heat Sources</td>
<td>276</td>
</tr>
<tr>
<td>Boundary Conditions</td>
<td>277</td>
</tr>
<tr>
<td>Calculated Physical Quantities</td>
<td>278</td>
</tr>
<tr>
<td>Stress Analysis</td>
<td>279</td>
</tr>
<tr>
<td>Displacement, Strain and Stress</td>
<td>279</td>
</tr>
<tr>
<td>Thermal Strain</td>
<td>283</td>
</tr>
<tr>
<td>External Forces</td>
<td>284</td>
</tr>
<tr>
<td>Restriction Conditions</td>
<td>284</td>
</tr>
<tr>
<td>Calculated Physical Quantities</td>
<td>285</td>
</tr>
<tr>
<td>Coupled Problems</td>
<td>287</td>
</tr>
<tr>
<td>Importing Joule Heat to Heat Transfer Problem</td>
<td>288</td>
</tr>
<tr>
<td>Importing Temperature Field to Stress Analysis Problem</td>
<td>288</td>
</tr>
<tr>
<td>Importing Magnetic Forces to Stress Analysis Problem</td>
<td>288</td>
</tr>
<tr>
<td>Importing Electric Forces to Stress Analysis Problem</td>
<td>289</td>
</tr>
<tr>
<td>Importing Magnetic State to DC or AC Magnetic Problem</td>
<td>289</td>
</tr>
<tr>
<td>Importing Temperature Field to AC Magnetic Problem</td>
<td>290</td>
</tr>
</tbody>
</table>

Index

243
About This Manual

What Is QuickField?

Welcome to QuickField Finite Elements Analysis System. QuickField is a PC-oriented interactive environment for electromagnetic, thermal and stress analysis. Standard analysis types include:

- Electrostatics.
- DC and AC conduction analysis.
- Linear and nonlinear DC and transient magnetics.
- AC magnetics (involving eddy current analysis).
- Linear and nonlinear, steady state and transient heat transfer and diffusion.
- Linear stress analysis.
- Coupled problems.

During a 15-minute session, you can describe the problem (geometry, material properties, sources and other conditions), obtain solution with high accuracy and analyze field details looking through full color picture. With QuickField, complicated field problems can be solved on your PC instead of large mainframes or workstations.

How to Use this Manual

This manual has eleven chapters:

**Chapter 1.** “Getting Started”, describes first steps of using QuickField. In this chapter, you will learn how to install and start the package.

**Chapter 2.** “Introductory Guide”, briefly describes the organization of QuickField and gives an overview of analysis capabilities.
Chapter 3, “Problem Description”, explains how to specify the analysis type and general problem features.

Chapter 4, “Model Geometry Definition”, explains how to describe geometry of the model, build the mesh, and define material properties and boundary conditions.

Chapter 5, “Problem Parameters Description”, introduces non-geometric data file organization, and the way to attach this file to the model.

Chapter 6, “Electric Circuit Definition”, describes the circuit schematic editor.

Chapter 7, “Solving the Problem”, tells you how to start the solver to obtain analysis results.

Chapter 8, “Analyzing Solution”, introduces QuickField Postprocessor, its features and capabilities.

Chapter 9, “Working with 3D Problem”, describes QuickField capabilities for solving and analyzing three-dimensional problems.

Chapter 10, “Add-ins”, describes QuickField add-ins, and methods of their creation and use.

Chapter 11, “Theoretical Description”, contains mathematical formulations for all problem types that can be solved with QuickField. Read this chapter to learn if QuickField can solve your particular problem.

Conventions

In this manual we use SMALL CAPITAL LETTERS to specify the names of keys on your keyboard. For example, ENTER, ESC, or ALT. Four arrows on the keyboard, collectively named the DIRECTION keys, are named for the direction the key points: UP ARROW, DOWN ARROW, RIGHT ARROW, and LEFT ARROW.

A plus sign (+) between key names means to hold down the first key while you press the second key. A comma (,) between key names means to press the keys one after the other.

Bold type is used for QuickField menu and dialog options.
CHAPTER 1

Getting Started

Required Hardware Configuration

Operating System:
- Windows XP with Service Pack 2 or later,
- Windows Vista,
- Windows 7,
- Windows 8,
- Windows 10.

Peripherals:
- USB port for hardware copy-protection key (not required for Student’s version or workstation installations of networked Professional versions).

QuickField Installation

QuickField can be supplied on a CD, or packed in ZIP-archive. Depending on the format, do the following:

- Professional QuickField in a ZIP-archive - unpack the archive preserving the directory structure and run Autorun.exe from the root of the unpacked directory tree.
- Student QuickField in a ZIP-archive - unpack the archive in the same way and run Setup.exe.
- QuickField on a CD - insert the CD and, if not started automatically, run Autorun.exe from the CD root.
**Autorun Applet**

On the left side of the Autorun screen you can see several menu topics organized in a scrollable tree. When you highlight a topic, additional topic-related information appears in the bottom pane. To execute the command associated with this topic double-click it or click Run in the right-bottom corner of the window.

Menu topics allow you to:

- See the complete QuickField User's Guide in Adobe PDF format (Read User’s Guide command);
- Learn QuickField interactively (Virtual classroom command);
- Find technical support and sales contact information (Contact Us);
- Install QuickField (Install QuickField command group).

With the Student version of QuickField the last command starts QuickField installer.

With QuickField Professional the installation steps depend on the type of license you purchased. For single-user license, choose the Single-user QuickField option below.

If your QuickField is licensed for multiple users, install the workstation component (Network: workstation option) on every workstation, and the license server (Network: license option) on the server computer.

**Using QuickField Setup Program**

QuickField installer can be launched either from the Autorun applet or manually by running Setup.exe found in the unpacked ZIP-archive with QuickField.

*Note.* Installation of QuickField always requires administrator privileges.

First of all, installer offers to review the license agreement. To continue the installation, you must accept its conditions checking I accept the license agreement. That activates the Install and the Advanced buttons. We strongly recommend choosing Install which automatically installs all components of QuickField in the default folder.

Still, if you want to change the installation folder, or, for some reason, skip installation of individual components, choose Advanced. The
installer will first prompt you to select the installation folder for QuickField and its help system. Secondly, it will display the tree of QuickField components. To skip installation of a component, click the down arrow to the left of the component's name and choose *Entire feature will be unavailable*. Having finished with the tree click *Install* to begin the installation process.

Having transferred all necessary files to your hard drive the installer might ask you to reboot the system. Press *OK* to agree. If you have other software protected by Sentinel hardware key (e.g. another version of Professional QuickField), installer might also ask whether you want to upgrade the Sentinel system driver. We recommend you to agree. Then attach the protection key to your computer (to the license server computer in case of network license) and wait for the notification message that the device is detected and ready to go. After that, QuickField is ready to use.

If you met any troubles answering the questions of QuickField Setup program you may try to find answers in the *Installation Guide.htm* file in the *Doc* folder on your QuickField compact disk.

**QuickField password (for Professional version only)**

After the end of installation you are ready to start QuickField for the first time. Before that, you must attach your hardware copy-protection key. Having installed the single-user licensed QuickField attach the key to the USB port of your computer. Otherwise, attach the key to the USB port of the computer acting as a license server and be sure that the license server software is properly installed and running. This procedure is detailed in *NetLicence.htm* file in the *Doc* folder on your QuickField compact disk.

During the first run of QuickField you must enter the password supplied by Tera Analysis Ltd. The password is a case insensitive string of 16 Latin letters uniquely identifying the hardware copy-protection key and the purchased subset of QuickField options. Every time you change the key or the set of options you must enter the new password to activate it.

If you upgrade QuickField without changing the subset of options, you can use the same password with the upgraded version of QuickField. To make it possible you need to choose *Edit->Password* from QuickField menu.
In its first run QuickField should not be used as automation server (e.g. from LabelMover or ActiveField samples). In such case its behavior would be unpredictable since there would be no way to enter the password. To avoid this, we recommend starting QuickField in interactive mode immediately after the installation.

Modifying, Repairing and Removing QuickField

Having installed QuickField you can always modify or repair its configuration or uninstall it from your computer. To do that, open the Control Panel and start the Add/Remove Programs (or Programs and Features, depending on the Windows version you are using) applet. After that, choose QuickField from the list of installed software and choose the appropriate item from the menu.

Installer provides you with three options:

- **Modify** (or **Change**) lets you to add another QuickField component or remove any optional QuickField component that was installed on your computer;
- **Repair** automatically restores the installed QuickField configuration. For example, you might need it having unintentionally deleted some of mandatory files or after virus attack.
- **Remove** (or **Uninstall**) completely removes QuickField from your hard disk.

Installing Several Versions of QuickField Simultaneously

When you install QuickField alongside one or several older versions installed in different folders, old installations remain usable. You can even run them simultaneously. However, you should be aware that each copy of QuickField attempts to register itself in the system registry as the default handler of all QuickField documents and automation requests. Any client program that uses QuickField will be served by the copy of QuickField that was registered last. To register another version of QuickField as the default handler, start it in interactive mode. On Windows Vista and later Windows versions with UAC QuickField
successfully registers itself only when it is started with administrator’s privileges.

If you remove (uninstall) any of installed QuickField versions, a part of information related to other versions is also removed from the system registry. To restore usability of another QuickField version after such action, you would have to start that version in interactive mode.

**Application-Wide Options**

QuickField Options panel may be displayed using the command **Tools>Options…** in the main menu. Left pane of the window shows the list of the options, and the pages for viewing/editing the chosen option are shown in the right pane. Pressing the **OK** button saves the options. Options are stored separately for each user of the computer.

- **Problem location** allows selection of the folder, where the search starts for loading or saving the problem files. If this field is empty, search starts from the current folder.
- QuickField may open the last used problem at start. This behavior may be cancelled using the switch **Open last problem**.
- Length units may be adjusted anytime individually for each problem. Default value is meter, but it may be changed using the **Length Units** option.
- **Temperature units**, selected in the Option panel, are applied to all QuickField problems. They are used for display of temperatures in numerical values or plots, but do not affect the internal stored data and results, which are always kept in Kelvins. If it is necessary to enter the numerical value or formula in units other than set in the Options panel - it can be done by addition the suffix ",K" for Kelvins, ",C" for Celsius degrees or ",F" for Fahrenheit degrees to the right of the value.
For example: \(10+25(t-1), K\)
Comma separates the value and temperature unit. Unit letter may be lowercase or uppercase. Suffix with temperature units is shown in the string only if the value is defined by formula and temperature units in it are different from the default units.

- The **number precision** option allows selection of the significant digits number ranging from 2 to 8 in the data entry fields or in the results display. Some parameters are displayed with the precision one less or one more than set in this option. Default precision value is 5. This value is appropriate for most users.

- The option **DXF Import tolerance** sets the allowed geometrical tolerance as a fraction from the model size, which may also be defined in the geometric model properties panel. If the distance between nodes is less than the set tolerance they will be merged during the import.

- Default number of the color levels for the QuickField color map display is 20. This parameter can be changed using the **Color grades** option.

- The option **Animation step** is related to the AC problems, i.e. problems formulated in the frequency domain. Default frame step for the animated field presentation is 5 degrees. This parameter may be adjusted here.

- Model editor and circuit editor save the history of user actions for possibility of reversing them. Maximal undo level is 100 commands. This value should satisfy most of QuickField users, but if necessary it may be changed using the option **Undo depth**. Larger value of the undo depth uses more memory.
This chapter briefly describes the basic organization of the QuickField program. It presents an overview of the available capabilities.

The aim of this chapter is to get you started with modeling in QuickField. If you are new to the QuickField, we strongly recommend you to study this chapter. If you haven't yet installed QuickField, please do so. For information on installing QuickField, please see Chapter 1.

Basic Organization of QuickField

In QuickField, you work with several types of documents: problems, geometry models, material libraries and so on. Each document is opened into a separate window within the main application window of QuickField. You can open any number of documents at once. When switching between windows, you switch from one document to another. Only one document and one window are active at a time, so you can edit the active document. Editing actions are listed in the menu residing on the top of main window of QuickField. Menu contents are different for different document types. You can also use context-specific menus, which are available by right-button mouse clicking on specific items in document window.

The QuickField documents are:

Problem corresponds to specific physical problem solved by QuickField. This document stores the general problem parameters, such as the type of analysis ("Electrostatics", "Magnetostatics", "Heat transfer" and etc.) or the model type (planar or axisymmetric). The detailed description of working with problems is given in Chapter 3.

Geometric Model is a complete description of the geometry, the part labels and the mesh of your model. Several problems may share the same
model (this is particularly useful for coupling analysis). Editing models is described in details in Chapter 4.

*Property Description or Data documents* are specific to types of analysis (Electrostatics data, Stress Analysis data, etc.) These documents store the values of material properties, loadings and boundary conditions for different part labels. Data documents can be used as material libraries for many different problems. The detailed description of how to specify material properties and boundary conditions is given in Chapter 5.

*Electric Circuit* defines the associated electric circuit and the parameters of its elements. You can associate circuits with problems of the following types:

- AC Magnetics
- Transient Magnetics

For the problem to be solved and analyzed, it must reference the model and data documents. For convenience, the problem can reference two data documents at once: one document containing properties for commonly used materials (material library), and another document containing data specific for the problem or group of problems.

The last of QuickField documents stores the solution results. QuickField creates it while solving the problem. The file always has the same name as and belongs to the same folder as the problem description file. Its extension is .res.

Between sessions, QuickField documents are stored in disk files, separate file for each document. During the session, you can create new documents or open existing ones. The detailed description of how to get and explore the results of the analysis is given in Chapter 7 and Chapter 8.

Using this very flexible architecture, QuickField helps you build and analyze your design problems very quickly. In analyzing a problem, the typical sequence of phases that you go through with QuickField is depicted in the flowchart below:
Window Management Tips

QuickField is a multi-document application, so you can work with several documents – geometry, materials, results, etc. – at once. We will discuss dealing with specific documents later; here are the common principles for creating and opening documents, switching between the editors and arranging the windows.

There are three basic window types in QuickField:

1. The Problem window presents the structure of the problem and its components.
2. The Document window shows graphics and tables related to the model geometry, or the field picture, the circuit, etc.
3. Tools windows display additional information and provide control functions.

Windows of each type can be differently arranged on the screen.

Problem Window

The problem window is normally docked on the left side of the main QuickField window. When several problems are open at once, their windows can be docked side by side, or in a column, or they can be tabbed.
Window Management Tips

in a single pane, leaving maximum space for graphics. This window can also be left floating on top of the other windows.

To move the problem window, simply drag it to the new position holding by the window title. While dragging, the possible docking positions are shown by the diamond shaped arrows. When you move the pointer over the diamonds, QuickField shows the corresponding rectangle where the window can be docked if you release the mouse button.

Document Windows

QuickField document windows, such as the model editor, the field plot, or the electric circuit window, occupy the main area of the QuickField workspace; they cannot be docked. For fast switching between these windows, there is a tab bar near the bottom edge of the main window, similar to the Windows task bar.

A document window can be minimized to an icon, or maximized, or arranged with its regular size and position, which you can change by dragging any corner or edge of the window. This is useful to display several document windows at once. QuickField can also tile all document windows automatically, when you choose **Tile Vertically** or **Tile Horizontally** in the **Window** menu.

Some document windows can be split into two or four panes. To split the window, drag the small gray rectangle on top of the vertical scrollbar or on the left of the horizontal scrollbar. You can also choose **Split** in the Window menu. To switch between panes, click it with the mouse or use **F6**.

To restore the single view, double-click the splitter or drag it to the window border until it disappears.

Tool Windows

Finally, the tool windows—the field calculator, color legend, circuit elements list, etc.—are usually docked within the corresponding document window. Like the problem window, you can drag and dock tools within their parent’s boundaries. When floating, tools can be dragged anywhere on the screen, even to another monitor.
Properties Window

The Properties window can be opened using the Properties command in the View menu. This window is docked to the problem window (as shown in the picture) by default or can be switched to floating. The Properties window displays different editing fields relevant to the current object (the problem, geometry model, etc.) Some properties are for information only (shown in grey), the others can be changed by typing in the new value or selecting from the dropdown list. The changed property value comes into effect immediately.

Overview of Analysis Capabilities

This section provides you with the basic information on different analysis capabilities. For detailed formulations of these capabilities, see Chapter 11.

Magnetostatic Analysis

Magnetic analysis is used to design or analyze variety of devices such as solenoids, electric motors, magnetic shields, permanent magnets, magnetic disk drives, and so forth. Generally, the quantities of interest in magnetostatic analysis are magnetic flux density, field intensity, forces, torques, inductance, and flux linkage.

QuickField can perform linear and nonlinear magnetostatic analysis for 2-D and axisymmetric models. The program is based on a vector potential formulation. Following options are available for magnetic analysis:

Material properties: air, orthotropic materials with constant permeability, ferromagnets, current carrying conductors, and permanent magnets. B-H curves for ferromagnets can easily be defined through an interactive curve editor, see the "Editing Curves" section in Chapter 5.

Loading sources: current or current density, uniform external field and permanent magnets.

Boundary conditions: Prescribed potential values (Dirichlet condition), prescribed values for tangential flux density (Neumann condition), constant potential constraint for zero normal flux conditions on the surface of superconductor.
**Postprocessing results:** magnetic potential, flux density, field intensity, forces, torques, magnetic energy, flux linkage, self and mutual inductances.

**Special features:** An integral calculator can evaluate user-defined integrals along specified contours and surfaces. The magnetic forces can be used for stress analysis on any existing part (magneto-structural coupling). A self-descriptive Inductance Wizard is available to simplify the calculation of self- and mutual inductance of the coils. The magnetic state of the media calculated using the demagnetization curves of all the involved materials can be remembered for future use. In particular, it allows for calculation of self- and mutual differential inductances of multi-coil systems.

**Transient Magnetic Analysis**

Transient magnetics allows performing transient or steady state AC analysis designing a variety of DC or AC devices such as electric motors, transformers, and so forth. Generally, the quantities of interest in transient magnetics analysis are time functions of magnetic flux density, field intensity, external, induced and total current densities, forces, torques, inductance and flux linkage. The transient magnetic field simulation can be coupled with electric circuit. The circuit can contain arbitrarily connected resistors, capacitors, inductances, and solid conductors located in the magnetic field region.

**Material properties:** air, orthotropic materials with constant permeability, ferromagnets, time-dependent current carrying conductors, and permanent magnets. B-H curves for ferromagnets easily defined with interactive curve editor, see the "Editing Curves" section in Chapter 5.

The electrical conductivity of material can depend on temperature. The dependence of conductivity on temperature is given in tabular form using the Curve Editor. The temperature value can be defined for each block by a number or a formula of time and coordinates.

**Loading sources:** time-dependent current or current density, uniform external field and permanent magnets. Electric circuit can contain any number of time-dependent current and voltage sources. QuickField introduces powerful Formula Editor allowing to define time dependency with a wide set of intrinsic functions.
**Boundary conditions**: prescribed potential values (Dirichlet condition), prescribed values for tangential flux density (Neumann condition), constant potential constraint for zero normal flux conditions on the surface of superconductor.

**Postprocessing results**: magnetic potential, flux density, field intensity, external, induced and total current densities, forces, torques, magnetic energy, flux linkage, self and mutual inductances.

**Special features**: a special formula editor allows specifying virtually any type of time-dependent sources (currents and current densities, Neumann boundary condition). An integral calculator can evaluate user-defined integrals along specified contours and surfaces. The magnetic forces can be used for stress analysis on any existing part (magneto-structural coupling). Joule heat generated in the conductors can be used for transient heat transfer analysis of your model (electro-thermal coupling). QuickField provides a special type of inter-problem link to import field distribution from another problem as initial state for transient analysis. Transient magnetic field simulation can be coupled with electric circuit. The circuit can contain arbitrarily connected resistors, capacitors, inductances, and solid conductors located in the magnetic field region.

**AC Magnetic Analysis**

AC magnetic analysis is used to analyze magnetic field caused by alternating currents and, vise versa, electric currents induced by alternating magnetic field (eddy currents). This kind of analysis is useful with different inductor devices, solenoids, electric motors, and so forth. Generally the quantities of interest in AC magnetic analysis are electric current (and its source and induced component), voltage, generated Joule heat, magnetic flux density, field intensity, forces, torques, impedance and inductance. The AC magnetic field simulation can be coupled with electric circuit. The circuit can contain arbitrarily connected resistors, capacitors, inductances, and solid conductors located in the magnetic field region.

A special type of AC magnetic is nonlinear analysis. It allows estimating with certain precision the behavior of a system with ferromagnets, which otherwise would require much lengthier transient analysis.

Following options are available for AC magnetic analysis:
Material properties: air, orthotropic materials with constant permeability or isotropic ferromagnets, current carrying conductors with known current or voltage.

The electrical conductivity of material can depend on temperature. The dependence of conductivity on temperature is given in tabular form using the Curve Editor. The temperature value can be defined for each block by a number or a formula of coordinates. In addition, the temperature field can be imported from a linked problem of heat transfer analysis.

The tab Core loss allows entering properties for the soft magnetic material, which are required to calculate the core losses in it.

Loading sources: voltage, total current, current density, uniform external field. Electric circuit can contain any number of time-dependent current and voltage sources.

Boundary conditions: prescribed potential values (Dirichlet condition), prescribed values for tangential flux density (Neumann condition), constant potential constraint for zero normal flux conditions on the surface of superconductor.

Postprocessing results: magnetic potential, current density, voltage, flux density, field intensity, forces, torques, Joule heat, magnetic energy, impedances, self and mutual inductances.

Special features: An integral calculator can evaluate user-defined integrals along specified contours and surfaces. The magnetic forces can be used for stress analysis on any existing part (magneto-structural coupling); and power losses can be used as heat sources for thermal analysis (electro-thermal coupling). Two wizards are available for calculation of the mutual and self-inductance of coils and for calculation of the impedance.

Electrostatic Analysis

Electrostatic analysis is used to design or analyze variety of capacitive systems such as fuses, transmission lines and so forth. Generally the quantities of interest in electrostatic analysis are voltages, electric fields, capacitances, and electric forces.

QuickField can perform linear electrostatic analysis for two-dimensional, axisymmetric and three-dimensional models. The program is based on
Poisson's equation. Following options are available for electrostatic analysis:

**Material properties**: air, orthotropic materials with constant permittivity.

**Loading sources**: voltages, and electric charge density.

**Boundary conditions**: prescribed potential values (voltages), prescribed values for normal derivatives (surface charges), and prescribed constraints for constant potential boundaries with given total charges.

**Postprocessing results**: voltages, electric fields, gradients of electric field, flux densities (electric displacements), surface charges, self and mutual capacitances, forces, torques, and electric energy.

**Special features**: An integral calculator can evaluate user-defined integrals along specified contours and surfaces. Floating conductors with unknown voltages and given charges can be modeled. Electric forces can be imported into stress analysis (electro-structural coupling). A Capacitance Wizard is available for calculation of the self- and mutual capacitance of the conductors.

**3D analysis limitations**: current QuickField version does not support the anisotropic materials and coupled problems in 3D Electrostatic analysis.

## DC Conduction Analysis

DC conduction analysis is used to analyze variety of conductive systems. Generally, the quantities of interest in DC conduction analysis are voltages, current densities, electric power losses (Joule heat).

QuickField can perform linear DC conduction analysis for two-dimensional, axisymmetric and three-dimensional models. The program is based on Poisson's equation. Following options are available for DC conduction analysis:

**Material properties**: orthotropic materials with constant conductivity.

The electrical conductivity of material can depend on temperature. The dependence of conductivity on temperature is given in tabular form using the Curve Editor. The temperature value can be defined for each block by a number or a formula of coordinates.

**Loading sources**: voltages, electric current density.
Boundary conditions: prescribed potential values (voltages), prescribed values for normal derivatives (surface current densities), and prescribed constraints for constant potential boundaries.

Postprocessing results: voltages, current densities, electric fields, electric current through a surface, and power losses.

Special features: An integral calculator can evaluate user-defined integrals along specified contours and surfaces. The electric power losses can be used as heat sources for thermal analysis (electro-thermal coupling).

3D analysis limitations: current QuickField version does not support anisotropic materials, temperature-dependent conductivity and coupled problems in 3D DC Conduction analysis.

AC Conduction Analysis

AC conduction analysis is used to analyze electric field caused by alternating currents and voltages in imperfect dielectric media. This kind of analysis is mostly used with complex insulator systems and capacitors. Generally, the quantities of interest are dielectric losses, voltage, electric field components, forces, and torques.

The following options are available for AC conduction analysis:

Material properties: air, orthotropic materials with constant electric conductivity and permittivity.

Boundary conditions: prescribed voltage values (Dirichlet condition), prescribed values for boundary current density (Neumann condition), constant potential constraint for describing conductors in surrounding dielectric media.

Postprocessing results: voltage, electric field, current density, power and losses, forces, and torques.

Special features: An integral calculator can evaluate user-defined integrals along specified contours and surfaces. Electric forces can be imported into stress analysis (electro-structural coupling); and electric losses can be used as a heat source for the thermal analysis (electro-thermal coupling).
Transient Electric Field

Transient electric analysis is a generalization of electrostatics and conduction analyses:

- An electrode potential or induced current density (field sources) can be an arbitrary function of time;
- Dielectric materials can be moderately conductive, to account for dielectric losses;
- Electric conductivity and permittivity of any material can vary with electric field.

In contrast to electrostatics, prescribed electric charge density cannot be a field source.

This analysis type may be used to study the field distribution in objects subjected to pulse sources, e.g., lightning-induced overvoltages. It may also be applied to design modern insulation constructions, which include nonlinear field equalizing elements, varistor overvoltage protection, and other applications, which involve zinc oxide varistors, semiconductive ceramics, and similar materials.

The following options are available for transient electric analysis:

**Material properties**: air, orthotropic materials with electric field dependent conductivity and permittivity.

**Boundary conditions**: prescribed voltage values (Dirichlet condition), prescribed values for boundary current density (Neumann condition), constant potential constraint for describing conductors in surrounding dielectric media.

**Postprocessing results**: voltage, electric field, conduction and displacement current density, ohmic and reactive power and losses, forces and torques.

**Special features**: A calculator of is available for evaluating user-defined integrals on given curves and surfaces. Capacitance wizard is a convenient tool to calculate the capacitance using different methods.

Thermal Analysis

Thermal analysis plays an important role in design of many different mechanical and electrical systems. Generally the quantities of interest in thermal analysis are temperature distribution, thermal gradients, and heat
Transient analysis allows you to simulate transition of heat distribution between two heating states of a system. QuickField can perform linear and nonlinear thermal analysis for two-dimensional and axisymmetric models; and linear steady-state thermal analysis for three-dimensional models. The program is based on heat conduction equation with convection and radiation boundary conditions. Following options are available for thermal analysis:

**Material properties**: orthotropic materials with constant thermal conductivity, isotropic temperature dependent conductivities, temperature dependent specific heat.

**Loading sources**: constant and temperature dependent volume heat densities, convective and radiative sources, Joule heat sources imported from DC or AC conduction or AC or transient magnetic analysis.

**Boundary conditions**: prescribed temperatures, boundary heat flows, convection, radiation, and prescribed constraints for constant temperature boundaries.

**Postprocessing results**: temperatures, thermal gradients, heat flux densities, and total heat losses or gains on a given part; with transient analysis: graphs and tables of time dependency of any quantity in any given point of a region.

**Special features**: A postprocessing calculator is available for evaluating user-defined integrals on given curves and surfaces. Plate models with varying thickness can be used for thermal analysis. The temperatures can be used for thermal stress analysis (thermo-structural coupling). Special type of inter-problem link is provided to import temperature distribution from another problem as initial state for transient thermal analysis.

**3D analysis limitations**: current QuickField version does not support anisotropic materials, non-linear dependencies (dependence of the thermal conductivity or volume power of the heat source from the temperature), radiation boundary condition, transient analysis and coupled problems.

**Stress Analysis**

Stress analysis plays an important role in design of many different mechanical and electrical components. Generally, the quantities of
interest in stress analysis are displacements, strains and different components of stresses.

QuickField can perform linear stress analysis for 2-D plane stress, plane strain, and axisymmetric models. The program is based on Navier equations of elasticity. Following options are available for stress analysis:

**Material properties**: isotropic and orthotropic materials.

**Loading sources**: concentrated loads, body forces, pressure, thermal strains, and imported electric or magnetic forces from electric or magnetic analysis.

**Boundary conditions**: prescribed displacements, elastic spring supports.

**Postprocessing results**: displacements, stress components, principal stresses, von Mises stress, Tresca, Mohr-Coulomb, Drucker-Prager, and Hill criteria.
Problem Description

Structure of Problem Database

A special database is built for each problem solved with QuickField. The core of the database is the problem description, which is stored in file with the extension .pbm. The problem description contains the basics of the problem: its subject, plane, precision class, etc., and references to all other files, which constitute the problem database. These files are the model file, with standard extension .mod, or .m3d, the connected electric circuit file .qcr (where applicable) and physical data (property description) files with extension .dms, .dhe, .des, .dtv, .dcf, .dec, .dht, or .dsa, depending on the subject of the problem.

The problem description may refer to one or two files of physical data. Both files have the same format, and differ only in purpose. Usually, the first data file contains specific data related to the problem, as the second file is a library of standard material properties and boundary conditions, which are common for a whole class of problems.

Depending on the problem type, you may share a single model file or a single data file between several similar problems.

While solving the problem, QuickField creates one more file—the file of results with the extension .res. This file always has the same name as the problem description file, and is stored in the same folder.

Editing Problems

- To create a new, empty problem description, click New in the File menu and then select QuickField problem in the list that appears. Then enter the name and path of the new problem. You can also create a new problem as a copy of another problem being currently
opened. In that case new problem inherits all the properties of the sample one and the referenced model and data documents are copied if necessary.

- To open an existing document, click **Open** in the **File** menu, or use drag and drop features of Windows.

Open problem documents are shown in a special view to the left of main QuickField window. In problem view, you can edit problem description options and references to files. The tree shows the names of files, which the problem currently references.

- To change problem settings or file names, click **Problem Properties** in the **Problem** menu or context (right mouse button) menu.
- To start editing a referenced document (model, data, secondary data or other problem referenced as coupling link), double-click its name in the tree, or click **Edit File** in the context menu, or click correspondent item in **Edit** menu.
- To solve the problem, click **Solve Problem** in the **Problem** menu or context (right mouse button) menu.
- To analyze the results, click **View Results** in the **Problem** menu or context menu.

**Editing problem description properties**

![Problem Properties - Circuit1.pbm](image)

- **Problem Type:** AC Magnetics
- **Frequency:** f = 100 Hz
- **Length Units:** Millimeters
- **Coordinate System:** Cartesian
- **Precision:** Normal
- **Geometry:** Circuit1.mod
- **Data:** Circuit1.dhe
- **Library Data:**
- **Circuit:** Circuit1.qcr
- **Location:** C:\Users\Public\Documents\QuickField 6.3 Student Examples

**OK**  **Cancel**  **Help**
**Problem type:** Select the type of analysis, which your problem belongs to.

**Model class:** Select the geometry class of your model: Plane-parallel, Axisymmetric, 3D Extrusion or 3D Import. The first two classes lead to two-dimensional analysis, where the last two introduce three-dimensional analysis (see chapter 9). Enter the length of plane-parallel model in z-direction (perpendicular to the model plane) into the \( L_z \) field. Default depth of the model \( L_z \) is one meter.

**Precision:** Select the precision you need. Note that higher precision leads to longer solution time.

**Formulation:** Select the formulation of planar stress analysis problem.

**Frequency:** Type the value of frequency for the time-harmonic problem. Note the difference between frequency \( f \) and angular frequency \( \omega \): \( \omega = 2\pi f \).

**Files:** Edit the file names of your model, data files, and circuit file (if applicable). You may use long file names. If the name is given without the full path, it is assumed with respect to the problem description file. You can also click Browse to select file in any folder on your hard disk or the network.

**Edit:** Instantly loads selected file into the new QuickField window.

**Establishing Coupling Links**

The stress analysis, heat transfer, and transient magnetic problems can incorporate data, which come from other analysis types. The data types are:

- electric and/or magnetic forces;
• temperature field for the stress analysis;
• power losses generated by the current flow for the heat transfer;
• remembered (frozen) magnetic state of the materials from another problem;
• temperature field for calculating of the temperature dependent electrical conductivity;

Transient problems can import initial state of field distribution from another steady state or transient problem (at specified time moment in case of importing from transient into static problem).

To establish a link between the problem that imports data and the problem that originates them, click **Links** tab in problem description dialog box.

To add a data link:

1. Select the type of the data in the **Data Type** list;
2. Type a name of the source problem in the **Problem** box, or click **Browse** button to make the selection from the list of existing problems;
3. In case the source problem is of transient analysis type, specify the time moment you wish to import in the **Time** field; if this specific time layer does not exist in the results file, the closest time layer will be imported;
4. And, click **Add** button to add the link to the list of data sources.

To change a data link:
1. Select the link of choice in the **Data Sources** list;
2. Change the source problem name or the moment of time as necessary;
3. And, choose **Update** button to update the link in the list of data sources.

To delete a link:

1. Select the link of choice in the **Data Sources** list box;
2. And, click **Delete** button to delete the link from the list of data sources, or use **Delete All** button to delete all data links at once.

The links to the imported data are considered to be a part of the problem description. The changes made in them are preserved only if you choose **OK** when completing the problem description editing. And, vice versa, if you would choose **Cancel** button or press **ESC**, the changes made in data links will be discarded along with other changes in problem description.

### Setting Time Parameters

With problems of transient analysis type, you need to set up the time parameters, before the problem can be solved. To do so, click **Timing** tab in the problem description dialog box.

**Calculate up to**: Specify the period of time you wish to simulate. Simulation always starts at ‘zero’ time moment.
**With the step of:** Specify the step size for the calculation. In transient analysis, this is the most important parameter controlling the precision of calculations in time domain: the smaller the step, the better the precision. Usually you will have minimum of 15 to 20 steps for the whole integration period. It may have sense to start with bigger value of this parameter and then decrease it if the result seems to change not smoothly enough.

If for some model you cannot estimate suitable time parameters, we recommend that you set some arbitrary value for the time period, and set the step size to have 5-7 points of integration, and then explore the X-Y plots against time in several points in the domain to tune the parameters.

**Auto:** specifies that QuickField should calculate step size automatically.

**Store the results every:** defines the time increment for saving the results of calculation to the file. This value must be equal or greater than the step size.

**Starting from the moment:** defines the first point to be written to the file. If this value is zero, the initial state will be written.

**Initial temperature:** Enter the temperature value for the initial (zero) moment of time. Temperature may be defined as a constant or coordinate-dependent formula. If the initial temperature is not defined, it is considered zero. If the initial temperature value (formula) is set and also the coupled problem provides the initial temperature distribution then the imported temperature has a priority.

---

**Automatic Time Step Size Calculation in Transient Analysis**

In transient analysis, QuickField is now capable to automatically calculate and adjust the time step size for the integration process.

To calculate the initial time step size, the following conservative estimate is used:

\[ \Delta t_0 = \min \left( \frac{\xi^2}{4\alpha} \right) , \]

where \( \xi \) is the "mesh size" (diameter of a mesh element) and
\[ \alpha = \frac{\lambda}{\rho c} \] — for problems of heat transfer,

\[ \alpha = \frac{1}{\mu \sigma} \] — for magnetic problems.

The ratio \( \zeta^2/4\alpha \) is evaluated in all the mesh elements in the model, and the smallest value is used as an initial time step size.

As the solution progresses, the time steps are adjusted automatically by an adaptive time stepping scheme.

The next time step is adjusted by

\[ \Delta t_{n+1} = k \Delta t_n, \]

where \( k \) is a scaling factor varying from 0.25 to 4.0 (with discrete values of 0.25; 0.5; 1.0; 2.0; 4.0) and dependent on behavior of potential and its time derivative, as well as all the time- and coordinate-dependent sources and boundary conditions in the model.

The two factors are taken into account when choosing the value of \( k \):

- The norm of time derivative variation on previous time step in all mesh nodes:

\[ \Delta \bar{u}_n = 2 \frac{||\dot{u}_n - \dot{u}_{n-1}||}{||\dot{u}_n|| + ||\dot{u}_{n-1}||} \]

- The inverse of characteristic time:

\[ \omega_n = \frac{\{\Delta u_n\}^T \{F_n - F_{n-1}\}}{\{\Delta u_n\}^T [K_T] \{\Delta u_n\}} \]

In thermal analysis \( \{F_n\} \) is the heat flow vector associated with conduction, convection, and radiation. In magnetics \( \{F_n\} \) is a vector of induction, \( u \) - is a potential value, and \( K_T \) is a stiffness matrix in the finite-element analysis.

The actual value of scaling factor \( k \) is chosen based upon two dimensionless characteristics: \( \Delta \bar{u}_n \) and \( 2\pi/\Delta t_n \omega_n \), by means of predetermined proprietary threshold tables, and the smaller is considered to be used for the next time step size, thus guaranteeing to produce smooth and accurate time dependency in every spatial point of the model.
Choosing Length Units

QuickField allows you to use various units for coordinates when creating model's geometry. You can use microns, millimeters, centimeters, meters, kilometers, inches, feet, or miles.

Chosen units are associated with each particular problem, which gives you freedom to use different units for different problems. Usually units of length are chosen before creating the model geometry. It is possible to change units of length later, but it does not affect physical dimensions of the model. So, if you create your geometry as a square with 1 m side and then switch to centimeters, you will get a square measured 100 cm by 100 cm, which is the same as it was before. To actually change size of the model you should rather use Scaling option of the Move Selection command of the Model Editor (see page 63 for details).

The choice of length units does not affect units for other physical parameters, which always use standard SI units. E.g., the current density is always measured in A/m² and never in A/mm². The only physical quantity that is measured in chosen units of length, is the displacement vector in stress analysis problems.
Cartesian vs. Polar Coordinates

Problem geometry as well as material properties and boundary conditions can be defined in Cartesian or polar coordinate systems. There are several places in QuickField where you can make choice between Cartesian and polar coordinate systems. Using Coordinate System section in problem description dialog box you can define the default coordinate system associated with a problem. The same option is also available in the Model Editor and in the Postprocessor. Definition of orthotropic material properties, some loads and boundary conditions depends on the choice of the coordinate system. You can choose Cartesian or polar coordinate system for each element of data individually and independently from the default coordinate system associated with the problem. This choice is available in the dialog boxes of the Data Editor.

Problem Properties Window

The Properties window can be opened using the Properties command in the View menu. This window is docked to the task windows by default or can switched to floating.

The Properties window dynamically displays the current problem's properties.
Here you can review and modify the common properties of the problem such as problem type, class, accuracy, and geometry or material data file names. Changing certain problem parameters will invalidate the existing solution. In this case you will be given a warning.

To link a problem in the “Coupled problems” section, select the imported physical property type and choose or enter the name of the source problem. The new link will be checked and if the problem meets the coupling criteria, the new link will be added to the list. To remove an existing link, simply clear the source problem filename from the corresponding property.
This chapter describes the process of building the geometric model—a type of QuickField document describing the problem geometry.

The information given here describes the two-dimensional modelling. The chapter 9 contains detailed information concerned three-dimensional analysis. Nevertheless, to understand how to create and modify the 3D geometry model you likely need to know the basics of 2D modelling.

**Terminology**

*Geometric Model*, or simply *Model*, is the name we use for the collection containing all geometric shapes of a problem. Besides being an object container the model helps to link the contained objects with related material properties, field sources, and boundary conditions.

*Vertex*, *edge* and *block* are three basic types of geometric objects contained by QuickField models.

Each *Vertex* represents a point. Point coordinates could be either explicitly specified by user or automatically calculated by QuickField at the intersection of two edges. For each vertex you can define its mesh spacing value and its *label*. The mesh spacing value defines the approximate distance between mesh nodes in the neighborhood of the vertex. Define vertex *label* to link a vertex with, for example, a line source or load.

Each *Edge* represents a linear segment or a circular arc connecting two vertices. Model edges do not intersect each other. Creating new model edge QuickField splits it as many times as needed at intersection points with existing model edges and at the points represented by existing model vertices. QuickField also automatically creates new model vertices representing intersection points of the new edge and splits the old model.
edges at these points. Define edge label to link an edge with, for example, related boundary conditions.

Each Block represents a continuous subregion of the model plane. External block boundary is a sequence of edges. Blocks might contain holes. Each of internal boundaries separating a block from its holes is either a sequence of edges or a single isolated vertex.

All blocks included in field calculation must be meshed and labeled. QuickField can mesh any subset of model blocks. The mesh density depends on mesh spacing values defined for model vertices. These values are either calculated automatically by QuickField or specified for particular vertices by the user. Define block label to link the block with, for example, related material properties or distributed field sources.

Each Label is a string of up to 16-character length. Labels establish the correspondence between model objects - blocks, edges, and vertices - and numerical data describing such real world entities as material properties, loads and boundary conditions. Any printable characters including letters, digits, punctuation marks and space characters are permitted. Labels cannot begin with space; trailing spaces are ignored. Labels are case sensitive.

*The Mesh Spacing value* defines an approximate distance between mesh nodes in the neighborhood of a model vertex. Mesh spacing property is associated with vertices and measured in the current units of length. Setting mesh spacing values for some vertices you can control the accuracy of the solution.

## Geometry Description

Model development consists of three stages:

- Geometry description and manipulation;
- Definition of properties, field sources and boundary conditions;
- Mesh generation.

## Creating Model Objects

To describe model geometry create vertices and edges that form boundaries of all subregions having different physical properties. Use Move and Duplicate operations to adjust shapes and coordinates of
created objects to your needs. To perform editing actions upon several objects at once use the selection mechanism. Assign labels to blocks, edges, and vertices to link them with such real world objects as material properties, boundary conditions and loads. Build mesh in all blocks participating in field calculation.

There are two options available for creating the finite element mesh for your model:

- Fully automated method that generates a smooth mesh with a density based on region's dimensions and sizes of geometrical details. This option does not require any information from the user.
- The second method allows you to choose the mesh density. In this case you need to define the spacing values at few vertices of your choice. Spacing values for other vertices are calculated automatically to make the mesh distribution smooth.

**Creating Edges**

To create new edges:

- Choose **Insert Mode** in the Edit menu, or click the **Insert Vertices/Edges** toolbar button or context menu item, or press INS, to switch model view into insert mode.
- Specify the angle of the new edge in the New Edge Angle box on the toolbar. Use one of the predefined angles provided in the list, or type another value in the edit box. To create a linear segment specify zero angle.
- Left-drag the mouse from the starting point of the edge to its end, or use SHIFT+DIRECTION keys. The ends of the created edge can coincide with the existing model vertices, otherwise QuickField automatically creates the new vertex (vertices) as needed, so that QuickField, adding the new edge to the model, always connects two existing model vertices together. Switch on the snap to grid option (default), to force the new vertices on the current grid. Navigating with the keyboard, use the CTRL key to fine tune the points.

**Creating Vertices**

To create new vertices:

- Choose **Insert Mode** in the Edit menu, or click the **Insert Vertices/Edges** toolbar button or context menu item, or press INS, to switch model view into insert mode.
• Make sure that current coordinate grid settings fit coordinates of the vertices you want to create.
• Use mouse or DIRECTION keys to move the cursor to the vertex insertion point and double-click the left mouse button or press ENTER.

Or:

• Choose Add Vertices from the Edit menu.
• Enter new vertex coordinates and click Add. Repeat if you need more vertices.
• Click Close.

Attraction Distance

To avoid small unrecognizable inaccuracies in geometry definition, new vertices or edges cannot be created very close to the existing objects. Creation of new geometric objects is controlled by the value we denote by $\varepsilon$ and call the attraction distance.

The following rules apply to creation of new vertices and edges.

• New vertices cannot be created within $2\varepsilon$-neighborhood of the existing vertex.
• New edge cannot connect the ends of the existing edge and lie inside its $\varepsilon$-neighborhood.

The value of $\varepsilon$ is proportional to the size of the visible region, so to create very small details you would have to zoom in the model window.

Basic Objects Manipulation

Objects Selection

To select geometric objects:

1. If the Insert Mode is on, press INS to switch it off.
2. Keep CTRL pressed if you want to add objects to the selection set instead of replacing it.
3. Click any model object to select it alone, or press any mouse button outside of selected objects and drag diagonally to select all objects that entirely fit inside the displayed rubberband rectangle.
Note. Keep in mind that when you click inside a block QuickField select neither boundary edges nor vertices. Similarly, when you click in the middle of an edge QuickField does not select either of its ending vertices. This might be important for correct understanding of such model operations as **Delete**, **Duplicate**, and **Move**.

If you want to select a block and its boundary edges or an edge and its ending vertices, drag the mouse to select the required objects with a rubberband rectangle.

You can also use **Select All** and **Unselect All** commands in the **Edit** or context menu. Note that you can select objects of different types - blocks, edges or vertices - at once.

The set of selected model objects is shared between the windows displaying the model. If several windows display the same model, selected objects are highlighted in all of them.

**Keyboard shortcuts:**

- Select All       CTRL+A
- Unselect All     CTRL+D

To select all model objects having the same label, click this label in the **Problem Tree View**.

**Geometric Objects: Duplicating and Moving**

The Duplicate feature allows easily create geometric objects at regularly defined coordinates. To duplicate:

1. Select the set of model objects (vertices, edges and blocks) you want to duplicate.
2. Choose **Duplicate Selection** from the **Edit** or context menu. QuickField will display the **Duplicate Selection** dialog asking for parameters.
3. Choose the required transformation, enter its parameters in the dialog fields, and click **OK**. QuickField will add the duplicated objects to the model automatically selecting all of them. The rest of the objects will be unselected.

QuickField copies labels and spacing values associated with duplicated objects wherever possible. New model blocks are always unmeshed.
Chapter 4 Model Geometry Definition

The first copy of a model object is always the result of the specified transformation applied to the object itself. When the transformation allows to create several copies of every involved object simultaneously, the second and the following copies of any object are the results of the transformation applied to the preceding copies.

You can also move the selected objects to another location. The only limitation is that QuickField will not perform moves that change the model topology. You cannot move vertices or edges into any block or out of the containing block. To move selected objects, choose Move Selection in the Edit or context menu. The displayed Move Selection dialog is similar to the Duplicate Selection dialog described above.

Successful Move preserves all labels and spacing values. Mesh is preserved in the blocks that are not reshaped.

QuickField always removes the mesh from the reshaped blocks before checking that the topology remains unchanged. So, if you try a move that changes the model topology QuickField will block it displaying the corresponding message, and in result of the operation you might find that some of the blocks are no longer meshed.

If you do not like the results of your operation, use Undo to restore the previous state of the model.

Geometric transformations available with move and copy operations are:

- **Displacement** — parallel displacement is applied to selected objects for specified displacement vector. With copy operation, several copies can be asked for, it means that copying operation will be...
performed several times, each time being applied to the previous result. Parameters needed are displacement vector components.

- **Rotation** — selected objects are rotated around the specified point for the specified angle. With copy operation, several copies can be asked for, it means that copying operation will be performed several times, each time being applied to the previous result. Parameters needed are center of rotation coordinates and angle measured in degrees.

- **Symmetry** — selected objects are mirrored; symmetry line is specified by coordinates of any point on it and the angle between the horizontal axis and the symmetry line. Positive value of an angle means counter-clockwise direction. This transformation is available for copy operation only.

- **Scaling** — selected objects are dilated (constricted) by means of homothetic transformation. Parameters needed are center of homothety and scaling factor. This transformation is available for move operation only.

There is also a more simple method of copying and moving of the geometric objects – mouse dragging. Drag-and drop is possible within the same or different model editor windows.

**Deleting Objects**

To delete geometric objects:

1. Select the objects you want to delete.
2. In the **Edit** or context menu, click **Delete Selection**.

If the selection contains the vertex (vertices) adjacent to exactly two remaining edges that could be merged together, QuickField, having deleted the separating vertex, automatically performs the merge.

Otherwise, when one of vertices being deleted is adjacent to one or several of remaining edges, QuickField adds the adjacent edges to the list of objects to be deleted and requests the user to confirm the action.

This feature is frequently used for "clipping" of the obsolete parts of model edges.

**Example:** Consider the model shown in Pic.1 below with the semicircles having the radiuses of 2 and 3 and the common center at \((0, 0)\). Suppose that you need to create several horizontal edges inside the block with the distance between consecutive edges equal to 0.5.
The fastest way to create them would be the following:

- Set focus to the model window clicking inside it.
- Choose **Grid Settings** from **View** menu and set **Spacing** to 0.5.
- Press INS to enter the Insert Mode.
- Drag mouse from (0, 3) to (4, 3) to create the new edge connecting these points.
- Press INS to leave the Insert Mode. You will get the model shown in Pic.2.

```
Pic.1
```

```
Pic.2
```

- Select the new edge dragging the left mouse button from (-0.25, 3.25) to (4.25, 2.75).
- Choose **Duplicate Selection** from the **Edit** menu, set displacement ordinate to -0.5, set **Copies** to 12, and click **OK**. You will get the model shown in Pic.3.
- Select the right ends of horizontal edges dragging the left mouse button from (3.75, 3.25) to (4.25, -3.25).
- Choose **Delete Selection** from the **Edit** menu and click **Yes** to confirm deletion.
- Select the left ends of the edges dragging the left mouse button from (-0.25, 1.75) to (0.25, -1.75) and delete them similarly. You will get the required model (see Pic.4).
Keyboard shortcuts:

Delete DEL

Drag and Drop and Clipboard Editing

What Can Be Done with Drag and Drop?

You can move or copy any group of model objects - vertices, edges, and blocks - to another place on the model plane, or to another model opened by this or another session of QuickField.

How to Start Dragging?

First of all, find out which objects you want to drag and select them.

Place the mouse pointer over one of selected objects and press any mouse button. The shape of the cursor and the color of the selected objects will change.

Note. Placing the pointer over selection might be difficult when the selected set of objects does not contain blocks and snap-to-grid option is on. In such case we suggest you to place the pointer over one of the vertices you are going to drag.

Keep in mind that if you press a mouse button with the pointer outside of selection, QuickField, instead of dragging, initiates a rubberband
selection. In such case the shape of the cursor and the color of selected objects do not change when you press the mouse button down.

**Defining the Exact Drop Position**

When you press a mouse button with pointer over the selection QuickField displays the bright red dot close to the current pointer position. This dot indicates the so-called anchor point that helps to set the exact position of the copied or moved objects after drop.

In the beginning the exact position of the dot depends on:

- the distance between the pointer and the nearest model vertex; and
- the distance between the pointer and the nearest background grid node, unless the *snap-to-grid* option is off

In particular, when you press the mouse button with the mouse pointer over a model vertex QuickField always positions the anchor at the same point.

When you drag the objects the anchor point is also dragged. QuickField keeps displaying it as a bright red dot. The dragged anchor always coincides with one of the model vertices or, unless the snap to grid option is off, with one of the background grid nodes. You can see the coordinates of the dragged anchor point in the status bar.

After the drop QuickField calculates the difference between initial and final anchor positions and shifts all dragged objects exactly for the length of that vector.

Example: Suppose that you want to move a group of model objects containing the point with coordinates \((a, b)\). After the move the new coordinates of the point should be \((c, d)\). Here is the sequence of required actions:

- If there is no vertex at \((a, b)\), add it choosing *Add Nodes* from the **Edit** menu and entering the coordinates in the dialog.
- If there is no vertex at \((c, d)\), add it in the same way.
- Select the objects to move including the vertex at \((a, b)\).
- Place mouse pointer over this vertex and press the left button. You will see the anchor at \((a, b)\).
- Drag the objects until the anchor coincides with the vertex at \((c, d)\) and release the mouse. The first vertex will be moved exactly to \((c, d)\).
• Delete one or both of the created vertices (in most cases, the first vertex will not exist after move) if you no longer need them.

**Visual Drag Effects**

To help you drag and drop objects correctly QuickField provides visual feedback consisting of:

• the dragged anchor position indicated by the bright red dot and its coordinates in the status bar;

• the shape of the cursor;

• the rubberband representation of the dragged edges;

• the status message telling how to change the drag mode.

Using of the anchor is described in *Defining the Exact Drop Position*

A shape of the cursor reflects your choice between moving and copying of the objects. The Copy cursor displayed by QuickField shows the plus sign ('+') while the Move cursor does not. As usual, the cursor displayed over the places where drop is not allowed looks like the "No Parking" sign.

The rubberband always contains all the edges those will be moved or copied to another position upon Drop. When you move connected objects the rubberband also contains the connecting edges.

**Note:** the rubberband does not contain any of selected isolated vertices. This does not mean that these vertices will not be moved or copied. When isolated vertices constitute the whole selection, the only things that move during drag are the cursor and the anchor.

When you change the drag mode the rubberband feedback and the shape of the cursor are changed appropriately.

**Drag Modes and Drop Effects**

Dragging of model objects can be performed in different modes. The drag mode used immediately before the drop defines the actions performed by QuickField.

Drag mode is defined by:

• the mouse button you keep pressed while dragging; and

• the state of CTRL and ALT keyboard keys before the drop.
There is no way to change the mouse button in the middle of the drag - you press it at the beginning and release to perform the drop. On the other hand, you can change the state of CTRL and ALT keyboard keys at any moment.

*Note.* If you drag with right mouse button make sure that the ALT key is released before the drop. If you release the right mouse button with the ALT key pressed QuickField will do nothing.

To get the specific drop effect choose the drag mode according to the following rules:

- To choose the required action from the displayed context menu drag with right mouse button and keep control keys released before the drop.
- To move the objects inside the same model preserving connections between the moved and the stationary parts drag with left mouse button and keep control keys released before the drop.
- To move the objects inside the same model breaking connections between the moved and the stationary parts drag with left mouse button and press ALT before the drop.
- To copy the objects inside the same model drag with left mouse button and press CTRL before the drop.
- To copy the objects to another model drag with left mouse button and keep CTRL key released before the drop.
- To move the objects to another model drag with left mouse button and press ALT keeping CTRL released before the drop. QuickField cannot preserve connections between different models.

**Canceling Drop**

To cancel drop either press the ESC key on the keyboard or click the alternate mouse button before drop. Besides that, drag will not be started if you release the pressed button without moving the mouse. In the latter case QuickField proceeds as if you performed the corresponding mouse click.
**Actions Performed on Drop**

Depending on the drag mode used at the drop moment QuickField chooses the action from the following list:

- Moving the dragged objects preserving their connections with the rest of the model;

  Or,

- Moving the dragged objects breaking their connections with the rest of the model;

  Or,

- Copying the dragged objects.

If you drag with the right mouse button, QuickField displays the context menu with available drop actions and waits for your choice. Besides the actions listed above this menu contains the **Cancel** option. If you close the menu without choosing any item, QuickField does nothing.

If you dragged with the left mouse button, QuickField defines the required action depending on the last drag mode used before the drop. The correspondence between the drag modes and the actions performed after drop is described in Drag Modes and Drop Effects.

The effects of drag-copying are the same as if you invoked the Duplicate command for the selected objects shifting the copies together with the anchor point.

The effects of drag-moving are sometimes different from the similar **Move** operation. Here are the main differences:

- The Move operation never moves objects from one model to another. Drag-moving can move objects to another model breaking the connections with the stationary part of the source model.

- The Move operation does not allow changing the model topology - it does not allow moving vertices to other blocks, or creation of intersections. Drag-moving inside the same model does not have any limitations.

- The Move operation always preserves the labels of the related objects. Drag-moving might cause labels to change.
Undo after Drag and Drop

QuickField Model Editor performs Undo/Redo operations on per-model basis. It maintains separate stack of model states for every model and, when you request Undo or Redo, restores the state of the model before or after the corresponding operation.

If several model windows are opened simultaneously, Model Editor performs Undo/Redo for the model displayed in the active window. To make another window active, click anywhere inside it. Click scrollbar if you do not want to change the current selection set of the model.

Unlike other Model Editor operations, Drag and Drop might affect two different models at once. When you drag a group of items moving them from one model to another, QuickField changes both the source and the target models. In case you want to Undo the effects of the whole operation you need to do it for each of these models separately. If you decide to Undo the effects only on one of the models, you should be careful and prior to performing Undo make sure that proper model window is active at the moment.

Dragging to Another View

In some cases moving model objects could be quite inconvenient. For example, this would be the case when you need to move or copy relatively small objects across relatively large spaces. Inconvenience would be caused by the fact that it is impossible simultaneously select the small source objects and fit the target place inside the window.

This inconvenience could be easily eliminated with Drag and Drop between different views of the same model. Try the following:

- Open the second window for the same model choosing New Window from Window menu.
- Arrange the windows so that both are visible.
- Zoom in the first window on the source objects. Select those objects you want to move or copy.
- Zoom in the second window on the target place.
- Drag the selected objects from the first to the second window.
Dragg ing to Another Model

There are several things that make dragging to another model slightly different from that where the source and the target models are one. Here is the short list of the differences:

- You cannot move objects to another model preserving connections between the moved and the stationary parts of the source model.
- **Move** is the default operation (the operation performed on drop with released control keys) when you drag inside the same model; **Copy** is the default when you drag to another model.
- To undo the effects of Move to another model you would have to perform Undo twice - once for each of the involved models.
- Both Move and Copy to another model might cause the target problem to become incompletely defined. This is caused by the fact that Model Editor automatically adds all missing labels associated with the moved/copied objects to the target model, but fails to copy the corresponding label definitions from the source to the target data file.
- Both Move and Copy to another model might make the target coordinates of an object different from its source coordinates. This is the case when the source and the target models use different length units. Copying/moving objects to another model Model Editor preserves the real-world sizes, for example, the source length of 1 m becomes 100 cm when the source model uses meters and the target model uses centimeters as their length units.

Using Clipboard

You can copy selected model objects to the Clipboard and then Paste them to another place of the same model, or transfer to another model. Doing this you can either preserve the original objects, or Cut them from the source model.

To invoke Copy, Cut, or Paste choose the corresponding command from the Edit or context menu, or click the corresponding toolbar button, or press one of the keyboard shortcuts listed below.

The Copy/Cut commands are disabled when none of the model objects are selected. The Paste command is disabled when the Clipboard does not contain geometric objects copied with the copy/cut operations.

When you paste one or several objects into a model, positioning of the pasted objects relative to each other remains the same as in the source
model. If the target model is empty QuickField preserves the original coordinates of the pasted objects. Otherwise, to separate the pasted objects from the rest of the target model QuickField places them behind the right bound of the target model. This makes possible dragging of the objects to another position and preserves original object properties - labels and mesh spacing values.

The pasted objects remain selected after the operation. All other objects in the target model become unselected.

**Keyboard shortcuts:**

Copy  CTRL+C
Cut CTRL+X
Paste CTRL+V

**Undo/Redo Operations**

To undo the latest operation, make sure that the active window shows the geometric model you are editing and choose *Undo <your last operation>* from the *Edit* menu. To redo the last operation undone, make sure that the active window shows the geometric model you are editing and choose *Redo <last operation undone>* from the *Edit* menu. QuickField modifies the corresponding menu items to show you which operations would be undone and redone.

By default QuickField allows you to undo 25 latest operations for every model. You cannot increase the number of undoable operations above 100 but you can make it any number between 0 and 100 at any time.

**Keyboard shortcuts:**

Undo  CTRL+Z
Redo  CTRL+Y

**Undo Settings**

To be able to undo and redo your editing operations QuickField maintains internal stack of increments to geometrical model database associated with these operations. The topmost increment on stack corresponds to the latest editing operation performed. QuickField also keeps track of its current stack position that steps in top-to-bottom direction with every Undo action and steps in the opposite direction with every Redo action.
The depth of this internal stack defines maximum number of operations you can undo. When the total number of editing operations on the model exceeds the stack depth, the database increments corresponding to the eldest operations are destroyed to free stack positions for new increments. When you start QuickField the stack depth has its default value of 25 that allows to undo last 25 editing operations done on the model.

Maintaining geometrical model database increments impacts QuickField memory requirements. To make you able to influence this impact QuickField provides the possibility to reduce the depth of internal undo stack. You can do it at any time setting the depth value to any integer between 0 and 100 (both limits included). Ultimately, setting the stack depth to 0 switches off storage of database increments and effectively disables Undo/Redo feature until you make stack depth positive.

To change undo stack depth for a model do the following:

- Make sure that active window shows the model that you want to change depth for;
- Choose **Undo Settings...** from the **Edit** menu
- After **Undo Settings** dialog appears on screen, change undo stack depth to desired value and click **OK**.

If the new depth value exceeds the old one, only the depth of the stack is affected. Stack contents remains unchanged allowing you to undo and redo the operations performed before this change. The same is true if the new depth value is less than the old one but still exceeds the number of accumulated stack positions.

Suppose, for example, that you started QuickField, performed 10 editing operations and invoked Undo 5 times. At this moment the stack accumulates 10 stack positions. If you decide to reduce stack depth to 10 no database increments will be lost. If, however, you decide to perform one more editing operation before reducing the depth, you lose the possibility to redo anything and the number of accumulated positions becomes equal to 6. After that you can set the depth to 6 and lose nothing.

The only case you lose some of accumulated data changing undo stack depth is when you reduce the depth to the value that is less than the number of accumulated stack positions. In such case, QuickField performs the following actions:

- if the new depth value exceeds the number of positions below current stack position, QuickField discards several topmost database
increments to make the number of remaining increments equal to new stack depth;
- if the new depth value is less than the number of positions below current stack position, QuickField retains only the database increments at the current stack position and immediately below it making the number of retained database increments equal to new stack depth.

Suppose once again that you started QuickField, performed 10 editing operations and invoked Undo 5 times. If at this moment you set depth to 7, only 3 topmost positions will be discarded. You will still be allowed both to undo 5 operations with database increments below current stack position and to redo 2 operations with increments retained above current stack position. On the other hand, if you decide to set depth to 2 you will only be able to undo 2 operations with database increments retained immediately below current position.

**Undoable Operations**

You can undo the following types of geometric operations (we use menu item labels whenever appropriate):

- Add Edge
- Add Vertices
- Build Mesh
- Cut
- Delete Edges
- Delete Vertices
- Delete Selection
- Drag
- Drop
- Duplicate
- Import DXF
- Move Selection
- Paste
- Properties
- Refine Mesh
- Remove Mesh
- Select
- Select All
- Unselect All
Definition of Properties, Field Sources and Boundary Conditions

Labels establish the correspondence between geometrical objects and their physical properties, such as material properties, boundary conditions, or field sources.

Assigning Labels to Objects

To assign labels to objects:

- Select the required objects
- Choose Properties from the Edit or context menu.
- Type the label and click OK.

You can simultaneously set different labels to different kinds of objects - blocks, edges, or vertices - defining these labels on different pages of the Selection Properties dialog.

Meshing Technology

Having described a reasonable part of the model geometry you can start building the finite element mesh. It is important to remember that the mesh you build even for a highly complex geometry can be rather non-uniform. Namely, you can set the size of mesh elements in some of the model blocks to be much less than in the other blocks. In such cases the meshing technology we call geometric decomposition will automatically produce smooth transition from large to small elements of the mesh. As
Chapter 4 Model Geometry Definition

a rule, the places where the mesh has to be the finest are those with the highest field gradient and those where you need higher precision.

In case of simple model geometry we suggest to leave calculation of element sizes to QuickField. The same applies to the case of preliminary design analysis when draft precision should perfectly suit your needs. Click the Build Mesh toolbar button and QuickField will automatically generate suitable mesh.

It might happen, however, that the quality of the automatically generated mesh would not satisfy you. For such cases, QuickField provides you with the way to set the mesh density manually. You control the mesh density defining mesh spacing values for particular model vertices. The mesh spacing value defined for a vertex specifies the approximate distance between adjacent mesh nodes in the neighborhood of the vertex.

You never need to define the spacing for all model vertices. To obtain a uniform mesh it would be enough to set the spacing for a single vertex. If you need non-uniform mesh start with defining the spacing values only for the vertices where you need the finest and the roughest mesh. The spacing values will be automatically interpolated to other model vertices smoothing the mesh density distribution across the meshed blocks. Use selection mechanism to simplify assigning the same mesh spacing value to several vertices at once.

With spacing values in place you are ready to build the mesh and eventually solve your problem.

In some cases the obtained solution results might show that you need more precise results in some places of the model. This is the good reason to change the density of your mesh. Doing that, do not forget the following:

- When you change the spacing value for a vertex, QuickField automatically removes the mesh from all blocks adjacent to this vertex.
- The spacing values defined along the boundaries of the blocks retaining their mesh will be frozen as if they were defined manually.

To set mesh spacing:

- Select vertices, edges or blocks, in neighborhood of which you need to specify the same spacing value.
- Choose **Properties** from the **Edit** or context menu.
- Type the spacing value and click **OK**.

If you specify mesh spacing for selected blocks or edges the spacing value is assigned to the vertices on the ends of the edges and/or on block boundaries.

If the spacing visibility switch is on (**Spacing** in **View** menu), the explicitly set spacing values are shown as small circles around the vertices.

To build mesh do one of the following:

- Choose the appropriate option of **Build Mesh** submenu in the **Edit** or context menu. QuickField will build mesh in the blocks specified by the chosen option.
- Click **Build Mesh** toolbar button. QuickField will build mesh in:
  - Selected blocks, if any exist
  - Otherwise, in labeled blocks, if any exist
  - Otherwise, in all model blocks.

QuickField can mesh any subset of model blocks at a time. However, when you start to solve the problem all blocks included in field calculation must be covered with mesh.

You can watch the mesh building process in real time if **Mesh** or **Domains** toggle in **View** menu is on.

To remove the mesh do one of the following:

- Choose the appropriate option from the **Remove Mesh** submenu of the **Edit** or context menu. The blocks described by the chosen option will be unmeshed.
- Click the **Remove Mesh** toolbar button. All selected blocks will be unmeshed. If none of the blocks are selected, mesh will be removed from all model blocks.

**Geometry Model Properties Window**

The Properties window can be opened using the **Properties** command in the **View** menu. This window is docked to the task windows (as shown in the figure) by default or can switched to floating.

The Properties window dynamically displays the current model's properties.
The figure shows the statistics related to the geometry model as well as the properties of the selected geometric objects (blocks, edges, and nodes). Some properties like the object label or the discretization step may be changed by typing it in or selecting the new value from the drop-down list.

The label value is set separately for every type of geometric object.

To set the step of discretization, switch the mode to Manual and enter the new Spacing value or select one from the list.

**Tuning the View of the Model**

QuickField provides the following ways to control the contents of the model window:

- **Zooming the Model** - gives you the ability to see more or less of your model to deal with small or large objects.
- Setting **Model Discretization Visibility** - makes the picture more suitable to specific tasks of model creation process.
- Changing **Background Grid Settings** - simplifies creation of model vertices and edges.

Consider also opening several windows for the same model and tuning them differently. To do so, choose **New Window** from the **Window** menu.
Zooming

To match window size with the size of the model:

- Click **Zoom to Fit** toolbar button.

To magnify the picture:

- Click **Zoom In** toolbar button.
- With left button pressed drag the mouse diagonally drawing a rubberband rectangle around that part of the model you want to fill the window, and release the button.

Or

- Click inside the window. QuickField will use magnification factor 2 relative to the clicked point.

  **Shortcut:** CTRL +   emulates click at the central point of the window.

To see more of the model:

- Click **Zoom Out** toolbar button.

  **Shortcut:** CTRL -

Model Discretization Visibility

There are four switches in the **View** menu that control the discretization visibility level: **Mesh**, **Domains**, **Breaking**, and **Spacing**. These are accessible in the **View** menu. When all these switches are off, QuickField displays blocks without discretization. This mode is the most convenient when you describe the geometry and assign labels to objects. When the **Spacing** switch is on, QuickField draws the circles with corresponding radiuses around the vertices where the spacing values have been set manually.

When the **Breaking** switch is on, the ends of the elements are indicated with tic marks along the edges. It is convenient to switch both **Spacing** and **Breaking** on while setting the mesh spacing values. Turn the **Mesh** switch on to view the mesh building process. In the end you will see the complete triangular mesh. If the **Domains** switch is on and the **Mesh** switch is off, QuickField displays the subdomains prepared for triangulation by the geometric decomposition process.
Chapter 4  Model Geometry Definition

Background Grid

Grid makes creation of model vertices and edges easier and helps to check correctness of the model. To change the grid, choose **Grid Settings** in the Edit or context menu and change the dialog fields described below according to your needs.

The **Show Grid** option allows to switch grid visibility on and off.

The **Snap to Grid** option allows to switch grid attraction on and off. When attraction is on new vertices can appear either at intersection points of model edges or at grid nodes. This makes model description faster and results in more consistent models.

The **Grid Spacing** field defines the sizes of the grid cell. To define different horizontal and vertical sizes, first check the **Anisotropic** box.

The **Anisotropic** option allows to define the grid cell with different horizontal and vertical sizes.

The **Scale with Zoom** option allows to switch between different policies related to changing grid cell sizes with zoom.

When the option is on (default) the grid cell sizes retain approximately the same values in screen coordinates.

When the option is off the grid cell sizes retain the same values in length units defined for the model.

The **Grid Origin** field defines the coordinates of one of grid nodes. This allows to create vertices at even distances from the point with such coordinates.
Exchanging Model Fragments with Other Programs

Importing Model Fragments from DXF Files

You can import model geometry or its fragments from a DXF file produced by any of major CAD systems. To do so, click Import DXF in the File menu and enter the required file name in the dialog. If needed, the window will be automatically zoomed after the import to fit the entire model.

When importing the 2D geometry from CAD systems it is often required to fix the imported model errors. In particular, some nodes closely positioned to other nodes or edges in fact should be merged into the single node. This algorithm is controlled by the relative accuracy parameter (as a fraction of the model size), which may be adjusted in the model property window. Dimensionless parameter Settings/DXF import/ Tolerance defines the geometry tolerance as a ratio from the maximal model size.

Ignore extents? is a flag for ignoring the size of the model fragment recorded in the DXF file. In some cases this information is incorrect and may prevent the successful model import.

We provide the special add-in to QuickField that allows you to import sketches from running SolidWorks® application to QuickField models. Choose Import from SolidWorks... command from the Edit menu to invoke this add-in.

For more details refer to online help library.
Exporting Model Fragments to DXF Files

You can export model geometry or its fragments to files in DXF format which is readable by QuickField and by all major CAD system. To do so, choose Export DXF from the File menu and specify the name of the output file in the dialog. If some of the model objects are selected, choose whether to export the selected objects or the entire model.

It is also possible to export the model mesh to an ASCII text file. This feature allows to interact with other finite element analysis programs. In particular, you can use QuickField as a mesh generator for your own FEM solver.

The detailed description of the resulting file format can be found in the QuickField Help. In brief – the file contains the data defining the model geometry, the finite element mesh and the labels assigned to model objects. We provide the utility allowing to import files in this format to MATLAB® in the form compatible with Partial Differential Equations Toolbox (PDE Toolbox).

Copying Model Picture to Windows Clipboard

You can copy the model picture, as you see it in the window, to clipboard for subsequent including it to your paper or report in any word-processing or desktop publishing utility.

- To copy the picture, click Copy Visible Picture in the Edit or context menu.

The picture is copied to the clipboard in both vector (WMF and EMF) and raster (device independent bitmap) representation.

Exporting Model Picture

The model picture may be saved to a file in either vector or raster representation. Vector formats include Windows Metafile format (WMF) or Extended Windows Metafile (EMF).

The list of supported raster formats includes BMP, GIF, TIFF, JPEG and PNG. Select BMP for maximum picture quality, (without compression), GIF if you prefer the minimum size, JPEG or PNG as a compromise between size and quality, and TIFF for best compatibility with prepress or publishing software.
For raster formats QuickField allows to define the height and width of the resulting picture in pixels. Their default value is agreed with the actual size of the copied window. Increasing of the raster picture size requires more disk space, but provides higher quality pictures for publishing.

To save the picture into the file:

- Select “Export Picture” in the File menu of the window with the picture displayed. File name and format selection dialogue will be shown.
- Select needed File Type from the list, and set the name and location of the file in the File Name field.
- Click on OK button.
- The Picture Properties dialog box will be displayed if one of the raster formats is chosen. Here you may accept the default picture size, or redefine it by setting other height and width.

Printing the Model

You can directly print the model picture to your local or network printer, just as you see the model in the window, with the same zooming and discretization visibility.

- To print the picture, choose Print from the File menu. You will be able to choose the printer and set up such picture settings as paper size and orientation, before the printing process begins.
- To preview the output before printing, choose Print Preview from the File menu.
- To see how the picture looks on the printer of your choice, choose Print Setup.
Before solving the problem you have to describe properties of materials and define field sources and boundary conditions. QuickField associates groups of related parameters with labels storing these labeled groups in property description files. When you edit the geometric model you label some of its elements thereby linking these elements with properties associated with the labels. Labeling blocks, edges and vertices is described in Chapter 4 "Model Geometry Definition".

Property description labels can be divided into groups:

With 2D-analysis:
- block labels describing material properties and loads for sub-regions of the model;
- edge labels assigning specific boundary conditions to model boundaries;
- vertex labels describing singular sources or constraints applied to points of the model.

With 3D-analysis:
- body labels describing material properties and loads for three-dimensional solids of the model;
- face labels assigning specific boundary conditions to model boundary faces;
- edge labels assigning specific boundary conditions to model boundary edges;
- vertex labels describing singular sources or constraints applied to points of the model.

Property descriptions differ between different problem types. QuickField opens property descriptions for different problem types in different windows and stores them in a different files with different file extensions:
Editing properties of materials and boundary conditions

<table>
<thead>
<tr>
<th>Problem type</th>
<th>File extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC and Transient magnetics</td>
<td>.dms</td>
</tr>
<tr>
<td>AC (time-harmonic) magnetics</td>
<td>.dhe</td>
</tr>
<tr>
<td>Electrostatics</td>
<td>.des</td>
</tr>
<tr>
<td>DC conduction</td>
<td>.dcf</td>
</tr>
<tr>
<td>AC conduction</td>
<td>.dec</td>
</tr>
<tr>
<td>Transient electric analysis</td>
<td>.dtv</td>
</tr>
<tr>
<td>Steady state and Transient heat transfer</td>
<td>.dht</td>
</tr>
<tr>
<td>Stress analysis</td>
<td>.dsa</td>
</tr>
</tbody>
</table>

- To create empty property description, open File menu, click New, and select appropriate document type from the list.
- To load property descriptions from the existing file, open File menu and click Open, or drag the file from Windows Explorer into QuickField window, or open the corresponding QuickField problem and double-click the name of the file in problem description window.

Editing properties of materials and boundary conditions

Having opened the property description file, you will see a new window displaying property labels as a tree. The tree contains three branches representing, top to bottom, labels assigned to blocks, edges and vertices. To provide visual assistance to users, QuickField accompanies all labels with meaningful icons.

Icons displayed by the labels mean:

<table>
<thead>
<tr>
<th>2D Analysis</th>
<th>3D Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Block icon] Block label specifying material properties</td>
<td>![Body icon] Body label specifying material properties</td>
</tr>
<tr>
<td>![Edge icon] Edge label specifying boundary condition</td>
<td>![Face icon] Face label specifying boundary condition</td>
</tr>
<tr>
<td>![Vertex icon] Vertex label specifying boundary condition or source</td>
<td>![Edge icon] Edge label specifying boundary condition</td>
</tr>
<tr>
<td>![None icon] None</td>
<td>![Vertex icon] Vertex label specifying boundary condition or source</td>
</tr>
</tbody>
</table>
Creating a New Label

To create a new label:

1. Open Insert menu and click Block Label, Edge Label or Vertex Label (Body Label, Face Label, Edge Label or Vertex Label in a case of 3D analysis), or click New Label in the context (right mouse button) menu of the corresponding branch of labels in the tree.
2. A new label appears in the list prompting you to specify the label’s name.
3. Type the name and press enter.
4. After you define the data, new label appears in the list of existing labels. If data editing was canceled, new label is not created.

Editing Label Data

To edit the data associated with a label:

- double-click the label in the list, or
- select the label and click Properties in Edit menu, or
- right-click the label and choose Properties from context menu.

You will see a dialog box dependent on the types of the problem and the geometric object linked to the label.

To close the dialog accepting all changes, click OK. To close the dialog discarding changes, click Cancel.
Block labels in magnetostatic problems can be associated with data containing two components of magnetic permeability tensor, the total current or the current density, and the magnitude and the direction of permanent magnet’s coercive force.

To specify linear or circular magnetization, select **Cartesian** or **Polar** coordinates respectively. In case of Cartesian coordinates the angle is measured from the horizontal axis. In case of Polar coordinates the angle is measured from the radius vector.

Both magnitude and direction of coercive force could be a function of coordinates and time.
For nonlinear materials, magnetic permeability is replaced with magnetization curve. To define a new curve, check **Nonlinear**. It will get you into B-H curve editor. If B-H curve is already defined, the dialog box contains the **B-H Curve** button allowing you to open the curve editor. Editing the magnetization curve is discussed in "Editing Curves" section later in this chapter.

When you associate data with a new label, the text boxes for magnetic permeability components contain **None**. The word **None** in these boxes or absence of the values mean blocks with the label will be excluded from calculations. To define the material’s properties (thereby including the blocks into calculation), type in the required value of magnetic permeability.

As long as **Anisotropic** is unchecked, QuickField changes the components of magnetic permeability tensor synchronously. To specify different components, check **Anisotropic** before entering the required values. The dialog labels besides tensor components reflect the coordinate system (Cartesian or Polar) selected for the property.

For transient problems, QuickField allows specifying non-zero electric conductivity in any block. In such case, it calculates the distribution of eddy currents in this block. The electrical conductivity of the material can be a function of coordinates and time or may depend on temperature. Dependency is given in tabular form and automatically be approximated
by a spline. To specify the electrical conductivity, which depends on temperature, check the **Function of Temperature** check box to get into the curve editor.

Enter a number or a formula into the **Temperature** field. The formula describes the temperature dependency on time and coordinates. Please note that all coordinates in a formula are given in meters with no regards to the length units you have chosen for the problem.

---

**Note.** The temperature value could be given either in Celsius or Kelvin degrees, but you have to use the same units in the **Temperature** field and in the curve.

---

The ways you define field sources for transient and non-transient problems are slightly different. Also transient problems allow using two types of conductors, stranded and solid. QuickField distinguishes between these types by the specified electric conductivity. Zero electric conductivity value implies stranded conductor and no eddy currents in the block. Non-zero value implies solid conductor and forces QuickField to calculate eddy current distribution for the block.

For non-transient problems, as well as for zero electric conductivity blocks in transient problems, you can define the field source either by current density value or by the total number of ampere-turns (total current). For total current, QuickField will, depending on your choice, either consider the blocks labeled with the label as single conductor or as several conductors connected in series. Serially connected conductors always carry the same current with calculated current densities inversely proportional to their squares.

Providing total number of ampere-turns for axisymmetric problems, you can additionally specify that current density in your coil varies inversely to radius rather than being distributed uniformly. It might be closer to reality if your block represents massive spiral coil with considerably different internal and external diameters.

The specified current density can depend on coordinates. Besides that, for transient problems, both the current density and the total current can be time-dependent. To specify time- or coordinate-dependent physical property, type the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.
For transient problems, QuickField allows specifying non-zero electric conductivity in any block. In such case, it calculates the distribution of eddy currents in this block. For non-zero electric conductivity blocks in transient problems, you define the field source as applied voltage or total current. QuickField considers the voltage as applied to whole conductor. The voltage, therefore, cannot depend on coordinates but can be time-dependent.

If the field analysis is performed with the electric circuit connected, then applied voltage or the full current for the solid conductor (with non-zero conductivity) cannot be defined in the label properties window. Instead of it, include all the conductive blocks into electric circuit with voltage or current sources attached to them. Only the parallel or serial connection of the separate conductors with the same label assigned should be defined in the label properties window.

Edge labels can be associated with boundary conditions. Select condition type and enter appropriate values.

Dirichlet (known magnetic potential) and Neumann (a density of surface current) boundary conditions can depend on coordinates. For transient problems, they can also be time-dependent. To specify time- or coordinate-dependent boundary condition, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.
Vertex labels in magnetostatic problem can be associated with known magnetic potential or concentrated current values. Check one of the options and enter appropriate value.

In transient magnetic problem magnetic potential or linear current can be time dependent. To specify time dependent boundary condition enter the required formula in place of numerical value. Formula syntax and other details are discussed in detail in "Using Formulas" section later in this chapter.

Magnetic potential and concentrated current can depend on coordinates. In such case, QuickField calculates individual boundary condition values for all vertices linked to the label.
Block labels in problems of AC magnetics can be associated with data containing the values of two components of magnetic permeability tensor, the value of electric conductivity and one of three values defining the field source: source current density, voltage, or total current.

When you associate data with a new label, the text boxes for magnetic permeability components contain None. The word None in these boxes or absence of the values mean that blocks with this label will be excluded from calculations. To define the material’s properties (thereby including the blocks into calculation), type in the required value of magnetic permeability.

As long as Anisotropic is unchecked, QuickField changes the components of magnetic permeability tensor synchronously. To specify different components, check Anisotropic before entering the required values. The dialog labels besides tensor components reflect the coordinate system (Cartesian or Polar) selected for the property.

When dealing with nonlinear materials, instead of magnetic permeability you need to define the magnetization curve. To do so, check the
Nonlinear box and QuickField will display the **Edit B-H Curve** dialog that allows to define the curve. To reopen the Edit Curve dialog later, click the **Edit B-H Curve** button.

---

**Note.** In AC Harmonic Magnetics the magnetic flux density value at every field point depends on time. So, the magnetic permeability values do the same. To calculate the field values QuickField defines such equivalent time-independent magnetic permeability that the average magnetic field energy, \((B \cdot H)/2\), for the period remains unchanged.

---

Defining a magnetization curve with the Curve Editor you specify the DC-based \(B(H)\) dependency and QuickField automatically recalculates the curve for the problem-defined frequency. The graph shows the original DC-based curve in green color while the curve recalculated for the problem-defined frequency is dashed red.

Enter the value of electrical conductivity to the **Conductivity** field or leave zero for non-conductive material. The electrical conductivity of the material may depend on temperature. Dependency is given in tabular form and automatically be approximated by a spline. To specify the electrical conductivity, which depends on temperature, check the **Function of Temperature** check box, to get into the curve editor.

Enter a number or a formula into the **Temperature** field. The formula describes the temperature dependency on coordinates. Please note that all coordinates in a formula are given in meters no regards to length units you have choose for the problem.

You can import the temperature field from a coupled heat transfer problem. To do that create and solve a heat transfer problem based on the same geometry model, and link it to the problem. When the imported temperature field and temperature given by a constant or a formula are both available, the imported temperature will be used.

---

**Note.** The temperature value could be given either in Celsius or Kelvin degrees, but you have to use the same units in the Temperature field and in the curve.

---

If the field analysis is performed with the electric circuit connected, then applied voltage or the full current for the solid conductor (with non-zero...
conductivity) cannot be defined in the label properties window. Instead of it, include all the conductive blocks into electric circuit with voltage or current sources attached to them. Only the parallel or serial connection of the separate conductors with the same label assigned should be defined in the label properties window.

The ways you define field sources are different for conductors and non-conductive blocks. For solid conductors, you specify either applied voltage or total current. For non-conductive blocks and stranded conductors you always specify zero conductivity value and the field source can only be specified by total current or current density values.

You can specify coordinate-dependent current density phase and magnitude. To do it, enter the required formula in place of numerical value. Formula syntax and other details are discussed in detail in "Using Formulas" section later in this chapter.

For total current and applied voltage, QuickField will, depending on your choice, either consider the blocks labeled with the label as single conductor or as several conductors connected in series. Serially connected conductors always carry the same current, whereas current densities will be calculated when QuickField finishes solution of the problem.

Note. Unless the conductors are connected in series, the value of total current associated with a block label specifies the gross current in all blocks labeled with that label.

With time-harmonic problems, you always specify amplitude (peak) values for all alternating quantities.

The tab “Core loss” allows entering properties for the soft magnetic material, which are required to calculate the core losses in it. These parameters are optional. If no data entered, then with default zero values the core losses will not be calculated in the corresponding blocks. Entered parameters are considered to be in W/m³ units.
There are two main causes for the magnetic material losses: ohmic losses generated by eddy currents, and losses caused by the cyclic reversal of the magnetization and proportional to the area of the hysteresis loop. If the non-zero conductivity is specified, then for this material eddy current losses are calculated automatically and there is no need to specify the loss coefficients separately.

Situation is different for the laminated cores, which are made of thin isolated sheets. In the laminated cores the electrical conductivity should be set as 0, otherwise the eddy currents simulated with QuickField will be too large. However, even the small eddy currents generate the losses. They are usually taken into account using some empirical formula.

QuickField uses the empirical Bertotti formula for core loss calculation:

\[ p = k_h f B^2 + k_c f^2 B^2 + k_e (fB)^{1.5} \]

Here \( B \) – magnitude of the module of the flux density vector per period, \( f \) – problem frequency, \( k_h, k_c, k_e \) – volume power loss coefficients for specific magnetic material. Default zero values of the loss coefficient will exclude the corresponding loss component from the calculations.

First term of the formula above corresponds to the hysteresis losses, second- to the Eddy current losses, and third approximates the additional magnetic losses, not covered by first two loss types.

Specific loss coefficients for the given material are calculated outside QuickField by data fitting using the known or measured tables of the volume losses per flux density and frequency \( p_{cm} = f(B, f) \).

More details about the loss coefficient calculations may be found at 
[www.quickfield.com/glossary/core_loss_coefficients.htm](http://www.quickfield.com/glossary/core_loss_coefficients.htm)
Edge labels can be associated with boundary conditions. Select condition type and enter appropriate values.

Dirichlet (known magnetic potential) and Neumann (a density of surface current) boundary conditions can depend on coordinates. To specify coordinate-dependent boundary condition, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

For details about the periodic boundary condition, please see section "Periodic Boundary Conditions" later in this chapter.
A vertex label in AC magnetics can be associated with known potential or concentrated current values. Check one of the options and enter appropriate value.

Magnetic potential and concentrated current can depend on coordinates. In such case, QuickField calculates individual boundary condition values for all vertices linked to the label.

**Editing Data in Electrostatics**

Block labels in electrostatics problem can be associated with data containing two components of electric permittivity tensor and electric charge density.

When you associate data with a new label, the text boxes for electric permittivity components contain **None**. The word **None** in these boxes or absence of the values means blocks with the label will be excluded from calculations. To define the material’s properties (thereby including the blocks into calculation), type in the required value of electric permittivity.

As long as **Anisotropic** is unchecked, QuickField changes the components of electric permittivity tensor synchronously. To specify different components, check **Anisotropic** before entering the required values. The dialog labels besides tensor components reflect the coordinate system (Cartesian or Polar) selected for the property.

You can specify coordinate-dependent electric charge density. To do it, enter the required formula in place of numerical value. Formula syntax and other details are discussed in detail in "Using Formulas" section later in this chapter.
When working with 3D electrostatic analysis, the permittivity and a given charge density are given in a body label. You edit the body label almost in the same way as a 2D block label, except that anisotropy is not supported here so far.

Edge labels can be associated with boundary conditions. Select condition type and enter appropriate values.

Dirichlet (known voltage) and Neumann (known normal component of electric induction) boundary conditions can depend on coordinates. To specify coordinate-dependent boundary condition, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

For details about the periodic boundary condition, please see section "Periodic Boundary Conditions" later in this chapter.
A vertex label in electrostatics can be associated with known potential or concentrated charge values. Check one of the options and enter appropriate value.

The values of known potential and concentrated charge can depend on coordinates. In such case, QuickField calculates individual boundary condition values for all vertices linked to the label.

**Editing Data in DC Conduction Problems**

Block labels in DC conduction problem can be associated with data containing two components of electric conductivity tensor.

When you associate data with a new label, the text boxes for electric conductivity components contain None. The word None in these boxes or absence of the values means blocks with the label will be excluded from calculations. To define the material’s properties (thereby including the blocks into calculation), type in the required value of electric conductivity.

As long as Anisotropic is unchecked, QuickField changes the components of electric conductivity tensor synchronously. To specify different components, check Anisotropic before entering the required values. The dialog labels besides tensor components reflect the coordinate system (Cartesian or Polar) selected for the property.

The electrical conductivity of the material may depend on temperature. Dependency is given in tabular form and automatically be approximated by a spline. To specify the electrical conductivity, which depends on temperature, check the Function of Temperature check box to get into the curve editor.
Enter a number or a formula into the Temperature field. The formula describes the temperature dependency on coordinates. Please note that all coordinates in a formula are given in meters no regards to length units you have choose for the problem.

Edge labels can be associated with boundary conditions. Select condition type and enter appropriate values.

Dirichlet (known voltage) and Neumann (known normal DC conduction density) boundary conditions can depend on coordinates. To specify coordinate-dependent boundary condition, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

For details about the periodic boundary condition, please see section "Periodic Boundary Conditions" later in this chapter.
A vertex label in DC conduction problem can be associated with known potential or external current values. Check one of the options and enter appropriate value.

The values of known potential and external current can depend on coordinates. In such case, QuickField calculates individual boundary condition values for all vertices linked to the label.

**Editing Data in AC Conduction Problems**

Block labels in AC conduction problems can be associated with data containing the values of two components of electric permittivity tensor and two components of electric conductivity.

When you associate data with a new label, the text boxes for electric permittivity components contain **None**. The word **None** in these boxes or absence of the values means blocks with the label will be excluded from calculations. To define the material’s properties (thereby including the blocks into calculation), type in the required value of electric permittivity.

As long as **Anisotropic** is unchecked, QuickField changes the tensor components synchronously. To specify different component values, check **Anisotropic** before entering the required values. The dialog labels besides tensor components reflect the coordinate system (Cartesian or Polar) selected for the property.

With time-harmonic problems, you always specify amplitude, or peak, values for all alternating quantities.
Edge labels can be associated with boundary conditions. Select condition type and enter appropriate values.

Dirichlet (known voltage) and Neumann (normal component of the current density) boundary conditions can depend on coordinates. To specify coordinate-dependent boundary condition, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

For discussion on periodic boundary condition, please see section "Periodic Boundary Conditions" later in this chapter.
A vertex label in AC conduction problem can be associated with known potential or external current values. Check one of the options and enter appropriate value.

The values of known potential and external current can depend on coordinates. In such case, QuickField calculates individual boundary condition values for all vertices linked to the label.

**Editing Data in Transient Electric Analysis**

Block labels in transient electric problem are similar to AC Conduction, except both permittivity and conductivity can be nonlinear.

When you associate data with a new label, the text boxes for electric permittivity components contain None. The word None in these boxes or absence of the values means that the blocks with this label will be excluded from calculations. To define the material’s properties (thereby including the block into calculation), type in the required value of electric permittivity.

To define the field dependent permittivity or conductivity, check the corresponding Nonlinear box, the curve editor will appear allowing to enter or edit the dependency curve.

As long as Anisotropic is unchecked, QuickField changes the tensor components synchronously. To specify different component values, check Anisotropic before entering the required values. The dialog labels
Chapter 5  Problem Parameters Description

Besides tensor components reflect the coordinate system (Cartesian or Polar) selected for the property.

Edge labels can be associated with boundary conditions. Select condition type and enter appropriate values.

Dirichlet (known voltage) and Neumann (normal component of the current density) boundary conditions can depend on coordinates and on time. To specify coordinate and time dependent boundary condition, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

For details about the periodic boundary condition, please see section "Periodic Boundary Conditions" later in this chapter.

A vertex label can be associated with known potential or external current. Check one of the options and enter appropriate value.
These values can be time or coordinate dependent. In this case QuickField calculates individual boundary condition values for all vertices linked to the label.

**Editing Data in Heat Transfer Problems**

Block labels in heat transfer problem can be associated with data containing two components of thermal conductivity tensor and heat source volume power. For transient problems the data should also contain specific heat and volume density values.

When you associate data with a new label, the text boxes for thermal conductivity components contain **None**. The word **None** in these boxes or absence of the values means that blocks with the label will be excluded from calculations. To define the material’s properties (thereby including the blocks into calculation), type in the required value of thermal conductivity.

As long as **Anisotropic** is unchecked, QuickField changes the components of thermal conductivity tensor synchronously. To specify different components, check **Anisotropic** before entering the required values. The dialog labels besides tensor components reflect the coordinate system (Cartesian or Polar) selected for the property.
To define thermal conductivity as a function of temperature, check **Nonlinear** in Thermal Conductivity field group. It will get you into temperature curve editor for defining $\lambda = \lambda(T)$. Curve editing is discussed in detail in "Editing Curves" section later in this chapter.

To define heat source volume power as a function of temperature, check **Function of Temperature**. It will get you into temperature curve editor for defining $q = q(T)$. Curve editing is described in detail in "Editing Curves".

Heat source volume power can be dependent on coordinates or, in transient problems, on time. To define coordinate- or time-dependent heat source volume power, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

To define specific heat as a function of temperature, check **Nonlinear** in For Time-Domain Only field group. It will get you into temperature curve editor for defining $C = C(T)$. Curve editing is described in detail in "Editing Curves".

![Edge Label Properties - New Label](image-url)
Edge labels can be associated with boundary conditions. Heat flux, convection, and radiation can be combined together implying that the heat flow through the surface will consist of several components. Check appropriate condition types and enter the required values.

Dirichlet (known temperature), Neumann (heat flux), convection and radiation boundary conditions can be coordinate- and, in transient problems, time-dependent. To specify coordinate- or time-dependent boundary condition, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

For details about the periodic boundary condition, please see section "Periodic Boundary Conditions" later in this chapter.

A vertex label in heat transfer problem can be associated with known temperature or linear heat source. Check one of the options and enter appropriate value.

The values of known temperature and heat source capacity can be coordinate- and, in transient problems, time-dependent. QuickField calculate individual coordinate-dependent boundary condition values for all vertices linked to the label. To specify coordinate- or time-dependent boundary condition, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

**Editing Data in Stress Analysis**

Block labels in stress analysis problem can be associated with three groups of data values, Elasticity, Loads, and Allowable Stresses. You
specify the data contained in these groups on related dialog pages. All text box labels on these pages always reflect the coordinate system (Cartesian or Polar) selected for the property.

1. Elasticity

When you associate data with a new label, the text boxes for Young’s moduli contain None. The word None in these boxes or absence of the values means that blocks with the label will be excluded from calculations. To define the material’s properties (thereby including the blocks into calculation), type in the required values of Young’s moduli.

As long as Anisotropic is unchecked, only two of the values entered on this dialog page remain independent. As you type in a new value, QuickField automatically updates the rest of them. To describe orthotropic materials with seven independent values, check Anisotropic before entering the required values.

2. Loads
Body Force vector components can depend on coordinates. To specify coordinate-dependent loads, enter the required formula in place of numerical value. Formulas are discussed in detail in "Using Formulas" section later in this chapter.

The ways you define data for thermal loading are different for coupled thermo-structural problems and non-coupled problems:

- For uncoupled problems, you specify the difference in temperature between strained and strainless states. This difference is assumed to be the same for all blocks labeled with this label.
- For coupled thermo-structural problems, you specify the strainless state temperature of the blocks subjected to thermal loading. This temperature is assumed to be the same for all blocks labeled with this label. Solving the problem, QuickField defines individual strained state temperature for each of these blocks.

3. Allowable Stresses

The values of allowable stresses do not affect problem solution. They are used only in postprocessing to calculate the Mohr-Coulomb, Drucker-Prager, and Hill criteria. You don't need to define allowable stresses, if these criteria are of no interest to you.
Edge labels can be associated with prescribed displacement along one or both of coordinate axes combined with prescribed surface forces. You either define the latter as normal pressure or specify required Cartesian or polar coordinate values. To apply fixed displacement along an axis, check the appropriate box and enter the required displacement value.

A vertex label in stress analysis can be associated with rigid or elastic support along one or both of coordinate axes, or with concentrated external force. To describe rigid constraint along an axis, check the appropriate box and enter the required displacement value.
Periodic Boundary Conditions

A special type of boundary conditions is implemented in QuickField to reduce the model size when simulating periodic structures, like poles in electric machines, – periodic boundary conditions. These conditions apply to two opposite sides of a model and force the fields on both boundaries to be either the same (even periodicity) or opposite (odd periodicity). The periodic condition is more generic than Dirichlet or Neumann condition, since it does not imply that the field is symmetric (no normal component) or antisymmetric (no tangential field) on the given boundary. Both components may exist, but they are forced to be the same or opposite.

Unlike other finite element packages, QuickField does not require that the mesh be equal on both boundaries, and is capable of merging potential values on edges with mismatching edge mesh.

To apply this type of condition, simply check the correspondent box (Even or Odd Periodical) for the label assigned to edges on the two boundaries – QuickField will analyze the geometry and detect the periodicity automatically.
Note. If you expect symmetric or antisymmetric field behavior, even though the structure is periodic, it is still more efficient to apply Dirichlet or Neumann boundary condition.

Editing Curves

Curves in QuickField represent dependencies between two physical properties, e.g., magnetic field intensity and flux density or temperature and thermal conductivity. To define a curve in QuickField, you open this curve’s editor and enter coordinates of several points on its graph. QuickField accumulates the points in a table and provides you with graphical representation of the curve interpolating between the table points with cubic splines. QuickField solver always uses the interpolated values displayed on screen during the edit session.

To add a new point to the curve, do the following:

1. Either click the leftmost cell of the last row that is marked New, or press \( \bigwedge \) on the toolbar.
2. Enter the argument value and press ENTER. The cursor will move to the next cell.
3. Enter the function value and press ENTER again.

To correct a table value, simply type the new value in the table cell.
To copy table rows to the Clipboard, either select these rows in the table or select the corresponding points on the graph and press (CTRL+C). The copied rows could be later pasted into the table.

To remove the point, select it in the table or on the graph and click Delete button or press the DEL key.

You may control the scaling of the graph with use of zoom buttons. To make the whole graph visible, click Zoom to fit button.

Dragging a dialog window boundary allows to resize the window. QuickField remembers the resulting window size and position for future use.

The graph image could be copied to the Clipboard and/or saved to a file. To do that, invoke the corresponding commands in the context (right-click) menu of the graph.

To finish editing, click Close or press esc. Note that subsequent canceling of label data editing with esc or Cancel will discard all changes including those made during curve editing.

**Temperature Units**

In QuickField Options it is possible to choose the temperature units (Kelvins, Celsius or Fahrenheit degrees) which then will be used everywhere in QuickField for this user for all QuickField problems. These units will be used for display of numerical data or plots, but they do not affect the saved data and results, which are always stored in Kelvins.

If it is necessary to enter the numerical value or formula in units other than set in the Options panel, it can be done by addition the suffix ",K" for Kelvins, ",C" for Celsius degrees or ",F" for Fahrenheit degrees to the right of the value.
In this example the formula gives the temperature in Kelvins, and \( x \) variable is the horizontal axis coordinate. Symbols of the temperature units to the right of the entry field are automatically changed in case of the suffix use.

Comma separates the value and temperature unit. Unit letter may be lowercase or uppercase. Suffix with temperature units is shown in the string only if the value is defined by formula and temperature units in it are different from the default units.

When the temperature units are changed, or the QuickField problem is transferred to the computer with different temperature units, numerical values will be automatically recalculated into new units. Formulas will gain suffixes with the temperature units they were originally created with. This will assure correct results of the problem, but the field pictures, tables and maps will be displayed in the currently set temperature units.

**Using Formulas**

Solving a problem you might need to specify a boundary condition or a field source as a function of time or coordinates. To do that, QuickField allows entering formula-defined field values instead of constant numerical values. The fields accepting formula-defined values are specified above in this chapter. Besides that, the fields accepting formula-
defined values can be distinguished by adjacent button and by the appropriate tooltip text.

Formula in QuickField is a mathematical expression constructed of numbers, arithmetical operators, parentheses, built-in constants and functions and predefined variables. Formula syntax is typical for most algorithmic languages and standard mathematical notation.

When you specify a formula-defined value QuickField checks the formula syntax and reports syntax errors to you. If the syntax is correct, calculator tries to calculate the result using current values of predefined variables. This calculation might also result in error if, for example, the value of a function argument does not belong to the function’s domain of definition. As with syntax errors, QuickField reports such errors to you.

**Physical properties allowing definitions with formulas**

The following properties can be defines with formulas ($f(x,y)$ denotes function of coordinates, $f(t)$ denotes function of time).

<table>
<thead>
<tr>
<th>Magnetostatics</th>
<th>$f(x,y)$</th>
<th>$f(t)$</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Block labels</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current density</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Total current</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Coercive force</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td><strong>Edge labels</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magnetic potential</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Tangential field (surface current density)</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td><strong>Vertex labels</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magnetic potential</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Linear (concentrated) current</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transient magnetics</th>
<th>$f(x,y)$</th>
<th>$f(t)$</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Block labels</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current density in stranded conductors</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Total current</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Voltage applied to solid conductors</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Coercive force</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Conductivity</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>
### Transient magnetics

<table>
<thead>
<tr>
<th>Block labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edge labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnetic potential</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Tangential field (surface current density)</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vertex labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnetic potential</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Linear (concentrated) current</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>

### AC magnetics (phase and magnitude)

<table>
<thead>
<tr>
<th>Block labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current density in stranded conductors</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Total current in solid conductors</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Voltage applied to solid conductors</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Conductivity (magnitude only)</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edge labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnetic potential</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Tangential field (surface current density)</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vertex labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnetic potential</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Linear (concentrated) current</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

### Electrostatics

<table>
<thead>
<tr>
<th>Block labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electric charge density</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edge labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Surface charge (normal component of electric induction)</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vertex labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Concentrated (linear) charge</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>
### DC Conduction

<table>
<thead>
<tr>
<th>Block labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edge labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Normal current density</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vertex labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Concentrated current</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

### AC Conduction (phase and magnitude)

<table>
<thead>
<tr>
<th>Block labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not applicable</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edge labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Normal current density</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vertex labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>External current</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

### Transient Electric

<table>
<thead>
<tr>
<th>Block labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not applicable</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edge labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Normal current density</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vertex labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>External current</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

### Heat Transfer

<table>
<thead>
<tr>
<th>Block labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat source volume power</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edge labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Heat flux</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Film coefficient and temperature of contacting fluid medium</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Emissivity coefficient and ambient radiation temperature</td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>
Chapter 5  Problem Parameters Description

**Heat Transfer**

<table>
<thead>
<tr>
<th>Vertex labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Heat source</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>

* Time-dependent values are used only in transient heat transfer problems

**Stress Analysis**

<table>
<thead>
<tr>
<th>Block labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Components of body force density</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Temperature difference between strained and strainless states</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edge labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prescribed displacement allows only linear dependency on coordinates</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Normal pressure</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Components of surface force density</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vertex labels</th>
<th>f(x,y)</th>
<th>f(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>External force</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Elastic support</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

**Syntax**

QuickField formula is an expression composed of the following elements:

- **Numerical constants**
  - Integral (Example: 123)
  - Fixed-point (Examples: 123.45 123.0123)
  - Floating-point (Examples: 1e12 5.39e+8 0.1E-12 .2E+2)

- **Arithmetic operators**
  - + addition (Ex: 2+2)
  - - subtraction (Ex: 3-5)
  - * multiplication (Ex: 1.23*0.12)
  - / division (Ex: 1E5/0.01)
  - ^ raising to a power (Ex: 3.14^2)

- **Unary operators**
  - + sign retaining (Ex: +180)
  - - sign change (Ex: -180)

- **Embedded functions**
  - abs - absolute value
  - sign - sign
max - maximum
min - minimum
step - step-function by 1
impulse - impulse segment
sin - sine
cos - cosine
tan - tangent
asin - arc sine
acos - arc cosine
atan - arc tangent
atan2 - angle of the vector defined by two arguments
exp - exponent
log - natural logarithm
sqrt - square root
pow - raising to a power
saw - saw-tooth periodic function

• Embedded constants
  pi - pi
e - e

• Predefined variables
  t - current time
  x - Cartesian coordinate x
  y - Cartesian coordinate y
  r - polar coordinate r
  phi - polar coordinate φ (in degrees).

• Parentheses (change the order of operations)
• Space and tabulation characters
Notes:
1. Numerical values should not contain group separators. Use dots (\'\.') as decimal separators regardless of regional settings.
2. QuickField allows using both e and E to separate mantissa and magnitude in floating point values.
3. The names of embedded functions, constants and predefined variables are case insensitive.
4. QuickField allows enclosing of names in double quotes. For example, \textit{sin (t)} is equivalent to "sin"(t).
5. Operation precedence (highest to lowest): ^, then * and /, then + and -. Use parentheses, if you need to change this order.
6. QuickField allows to insert any number of spaces inside a formula without impact, provided the inserted spaces are not inside names.
7. Place function arguments inside parentheses after the name of the function and separate them with commas (',').

| Constants and Predefined Variables |
|-----------------|-------------------------------------------------|
| \textbf{pi}    | 3.141592653589793238462643 \text{- The constant equal to the ratio of the length of any circle to its diameter.} |
| \textbf{e}     | 2.718281828459045235360287 \text{- The constant equal to the base of natural logarithms.} |
| \textbf{t}     | \text{Predefined variable denoting the current time value. Used with transient problems.} |
| \textbf{x}     | 0 \text{- Predefined variable denoting the x-coordinate.} |
| \textbf{y}     | 0 \text{- Predefined variable denoting the y-coordinate.} |
# Functions

<table>
<thead>
<tr>
<th>Name</th>
<th>Formula</th>
<th>Comments</th>
</tr>
</thead>
</table>
| abs  | \( \text{abs}(v) = |v| \)  
\[ = \begin{cases} 
v, & \text{if } v \geq 0 \\
-v, & \text{if } v < 0 \end{cases} \] | The function value is equal to absolute value of the argument. |
| sign | \( \text{sign}(v) = \frac{v}{|v|} \)  
\[ = \begin{cases} 
1, & \text{if } v > 0 \\
0, & \text{if } v = 0 \\
-1, & \text{if } v < 0 \end{cases} \] | The function value is equal to the sign of the argument. |
| max  | \( \text{max}(v_1, \ldots) \) | The function value is equal to the maximum of all arguments. You must specify 2 or more arguments. |
| min  | \( \text{min}(v_1, \ldots) \) | The function value is equal to the minimum of all arguments. You must specify 2 or more arguments. |
| step | \( \text{step}(v) = \begin{cases} 
1, & \text{if } v \geq 0 \\
0, & \text{if } v < 0 \end{cases} \) | The function value is equal to 0 for negative arguments and to 1 for non-negative arguments. The function has a step discontinuity when its argument value is 0. |
| impulse | \( \text{impulse}(v, l, r) = \begin{cases} 
0, & \text{if } v < l \\
1, & \text{if } l \leq v \leq r \\
0, & \text{if } v > r \end{cases} \) | The function represents impulse restricted to \([l, r]\) segment. If \( l > r \), an error occurs. The function value is equal to 1 when \( v \) is between \( l \) and \( r \), both ends included; otherwise, its value is 0. |
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \sin(v) )</td>
<td>The function value is equal to sine of the argument. The argument is defined in degrees.</td>
</tr>
<tr>
<td>( \cos(v) )</td>
<td>The function value is equal to cosine of the argument. The argument is defined in degrees.</td>
</tr>
<tr>
<td>( \tan(v) )</td>
<td>The function value is equal to tangent of the argument. The argument is defined in degrees. If argument value is an odd multiple of 90° an error occurs.</td>
</tr>
<tr>
<td>( \text{asin}(v) = \arcsin(v) )</td>
<td>The function value is equal to arc sine of the argument in degrees. The argument value ( v ) must conform to inequality (-1 \leq v \leq 1), otherwise an error occurs.</td>
</tr>
<tr>
<td>( \text{acos}(v) = \arccos(v) )</td>
<td>The function value is equal to arc cosine of the argument in degrees. The argument value ( v ) must conform to inequality (-1 \leq v \leq 1), otherwise an error occurs.</td>
</tr>
<tr>
<td>( \text{atan}(v) = \arctan(v) )</td>
<td>The function value is equal to arc tangent of the argument. The value is given in degrees.</td>
</tr>
<tr>
<td>( \text{atan2}(v_1, v_2) = \arctan(v_1/v_2) )</td>
<td>The function value is equal to the angle between the ( x )-axis and the direction from coordinate origin to the point with ordinate ( v_1 ) and abscissa ( v_2 ). The value is given in degrees and is always between 0 and 360. If both arguments are zero, the value is also zero. Otherwise, if ( v_2 ) is zero, the value is 90, for positive ( v_1 ), or 270, for negative ( v_1 ).</td>
</tr>
<tr>
<td>Function</td>
<td>Definition</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
</tr>
<tr>
<td>exp</td>
<td>$exp(v) = e^v$</td>
</tr>
<tr>
<td>log</td>
<td>$log(v) = \ln(v)$</td>
</tr>
<tr>
<td>sqrt</td>
<td>$sqrt(v) = \sqrt{v}$</td>
</tr>
<tr>
<td>pow</td>
<td>$pow(v, p) = v^p$</td>
</tr>
</tbody>
</table>

\[
saw(v, p) = \begin{cases} 
  v/p, & \text{if } 0 \leq v < p \\
  saw(v + p), & \text{if } v < 0 \\
  saw(v - p), & \text{if } v \geq p 
\end{cases}
\]

\[
saw(v, p, p0) = \begin{cases} 
  v/p, & \text{if } 0 \leq v < p \\
  0, & \text{if } p \leq v < p + p0 \\
  saw(v + (p + p0)), & \text{if } v < 0 \\
  saw(v - (p + p0)), & \text{if } v \geq p + p0 
\end{cases}
\]
Relative to its first argument this function is periodic. In case of two arguments the period is equal to the second argument value. In case of three arguments the period is the sum of the last two argument values. The function value is always 0 for \( v = 0 \), always 1 for \( v = p \) and in between the function is linear relative to \( v \). In case of three arguments the function value is always 0 for other values of \( v \). The last two argument values must be non-negative. The period must be positive. Otherwise an error occurs.

*Note.* To expand the function \( f(t) \) defined on the interval \((0, p)\) use the expression \( f(t) \cdot (\text{saw}(t, p)) \).

**Examples**

The table below contains examples you can use to learn writing your own QuickField formulas. The left column contains mathematical formulas with the corresponding QuickField expressions contained in its right counterpart.

You can evaluate expressions and view a plot using our online utility [www.quickfield.com/qf_formula_plotter.htm](http://www.quickfield.com/qf_formula_plotter.htm)

<table>
<thead>
<tr>
<th>Mathematical notation</th>
<th>Formula syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>( t \cdot (1-t) \cdot (2-t) )</td>
<td>( t^* (1-t)^* (2-t) )</td>
</tr>
<tr>
<td>( 2t^2 - t - 3 )</td>
<td>( 2^* t^2 - t - 3 )</td>
</tr>
<tr>
<td>( e^{-t^2/2} )</td>
<td>( \exp(-t^2 / 2) )</td>
</tr>
<tr>
<td>( \log_2 t )</td>
<td>( \log(t) / \log(2) )</td>
</tr>
<tr>
<td>( 200 \cdot \sin(18000 \cdot t + 240) )</td>
<td>( 200^* \sin(18000^* t + 240) )</td>
</tr>
<tr>
<td>( 2^t )</td>
<td>( 2^t )</td>
</tr>
<tr>
<td>( \arcsin \sqrt{2} )</td>
<td>( \text{asin}(\sqrt{2}) )</td>
</tr>
<tr>
<td>( \frac{t}{2.4 \times 10^{-8}} )</td>
<td>( \tan(t / 2.4e-8) )</td>
</tr>
</tbody>
</table>
Copying, Renaming and Deleting Labels

| $|2\pi t|$ | abs($2\pi t$) |
|---|---|
| \[
\begin{cases}
  t, & \text{if } t < 0.5 \\
  1 - t, & \text{if } t \geq 0.5
\end{cases}
\] | $t\text{step}(0.5-t) + (1-t)\text{step}(t-0.5)$ |
| \[
\begin{cases}
  0, & \text{if } t < 0 \\
  t, & \text{if } 0 \leq t < 0.5 \\
  1 - t, & \text{if } 0.5 \leq t < 1 \\
  0, & \text{if } t \geq 1
\end{cases}
\] | $t\text{impulse}(t,0,0.5) + (1-t)\text{impulse}(t,0.5,1)$ |
| \[
\begin{cases}
  \sin t, & \text{if } \sin t > \cos t \\
  \cos t, & \text{if } \sin t \leq \cos t
\end{cases}
\] | $\max(\sin(t), \cos(t))$ |
| \[
\begin{cases}
  \frac{t}{2}, & \text{if } 0 \leq t < 2 \\
  \text{periodic with period } 2
\end{cases}
\] | $\text{saw}(t, 2)$ |
| \[
\begin{cases}
  10 \cdot e^{5t}, & \text{if } 0 \leq t < 2 \\
  10, & \text{if } 2 \leq t < 3 \\
  \text{periodic with period } 3
\end{cases}
\] | $10 \exp(5 \cdot \text{saw}(t,2,1))$ |
| \[
\begin{cases}
  10 \cdot e^{5t}, & \text{if } 0 \leq t < 2 \\
  0, & \text{if } 2 \leq t < 3 \\
  \text{periodic with period } 3
\end{cases}
\] | $10 \exp(5 \cdot \text{saw}(t,3)) \cdot \text{impulse} \left(\text{saw}(t,3), 0, \frac{2}{3}\right)$ |
| \[
\begin{cases}
  e^{t-1}, & \text{if } 0 \leq t < 1 \\
  e^{1-t}, & \text{if } 1 \leq t < 2 \\
  \text{periodic with period } 2
\end{cases}
\] | $\exp(\text{saw}(t,1,1)-1) + \exp(\text{saw}(2-t,1,1)-1) - \exp(-1)$ |

Labels can be copied within single property description document or between documents of the same type.

To copy a label:

1. In the list of labels, choose **Copy** from the label’s context menu.
2. Switch to destination window and click **Paste** in the **Edit** menu or context menu.

Or,

1. Drag the label to destination position with left mouse button.

To delete a label:

- In the list of labels, choose **Delete** from the label’s context menu, or
- Select the label and click **Delete** in the **Edit** menu.
To move (cut and paste) a label:

1. In the list of labels, choose **Cut** from the label’s context menu.
2. Switch to destination window and click **Paste** in the **Edit** menu or context menu.

Or,

1. Holding **SHIFT** pressed, drag the label to destination position with left mouse button.
This chapter describes the electric circuit schema description with QuickField Circuit Editor.

QuickField supports simultaneous finite element analysis of the time harmonic magnetic and transient magnetic problems with simulation of the currents and voltages in the connected electric circuit.

Electric circuit schemas in QuickField are stored in files with extensions .qcr. You may include corresponding circuit schema file into the problem database along with other files comprising QuickField problem (geometry model file *.mod, data and library files, results file *.res) by editing problem properties.

What is a Circuit?

Electric circuit consists of circuit components connected with wires. Circuit components in QuickField can be of two kinds:

1. First group includes usual electric circuitry components, such as:
   - resistors,
   - capacitors,
   - inductors,
   - voltage sources,
   - current sources.

2. Second group is specific for QuickField and represents blocks of the geometric model. These elements are used to provide interaction between circuit and other parts of QuickField problem.
Chapter 6 Electric Circuit Definition

**Note.** If the problem supports the external electric circuit co-simulation then every solid conductor block (i.e. a block with non-zero conductivity) from the geometric model should be included into the circuit only once.

# How to Create a Circuit

To describe an electric circuit, you typically should do the following:

- Insert electric circuit components (resistors, capacitors, inductors, sources);
- Specify their properties;
- Add conductive blocks from the geometric model;
- Connect circuit elements with wires.

Circuit may be then edited by changing element properties and their connection topology. You can edit, move, rotate and delete circuit elements. You can select several elements and perform operations with all selected elements at once.

## Adding Electric Components to the Circuit

To add new components to the circuit:

1. In the **Insert** menu, click **Resistor**, **Capacitor**, **Inductor**, **Voltage Source** or **Current Source**, depending on component you want to add. Alternatively you can press corresponding toolbar button.
2. Place cursor to the point where you want new component to appear and click left mouse button.

**Notes:**
- The point where you click the mouse button will be the left pin of the new device.
- Circuit components are always aligned to a nearest grid point. It means that component will be placed so that its pins are at grid points.
- To insert component in the middle of some wire you can just click on this wire. Wire segment will be split in two and component will be inserted between them.

## Specifying Properties for Circuit Components

To set properties for circuit component:
• double click the component in the schema, or
• select the component and click Properties in the Edit menu, or
• right click the component and choose Properties from context menu.

Specifying Properties for Electric Components

For electric components, you can set the following properties:

**Label.** You can change the label for the component. It is not necessary to change this property, because you can use the default label names. But meaningful label names improve the model clarity and therefore recommended. Label names should be unique within the circuit.

**Value.** Depending on component type, you should specify its numeric value: resistance $R$, capacity $C$, inductance $L$, current $I$ or voltage $V$.

For current and voltage sources you can specify formula as a value. For transient problems, you can specify formula containing $t$ (time).

$\phi$ (phase). For AC problems, for voltage sources and current sources, you should specify phase value here.

Properties for components representing model blocks

For components representing model blocks, you can set the following property:

**Block.** You may change the name of the QuickField block in this field. Combo box provides the list of all blocks that should be added to the circuit, that is, the list of all solid conductors of the model. Each block can be specified only once.
Adding Components Representing Model Blocks to the Circuit

To add component representing model block to the circuit:

1. Click the button `Insert Block from Model` or choose `Block from Model` in the `Insert` menu.
2. Place cursor to the point where you want new component to appear and click left mouse button.

Or, you may use drag and drop from the problem tree:

1. Click label of some block in the Problem Editor tree.
2. Drag it to the circuit editor window keeping the mouse button pressed.
3. Place cursor to the point where you want new block to appear and release the mouse button then.

Connecting Circuit Components with Wires

To add a wire to the circuit:

1. Click the toolbar button `Insert Wire` or choose `Wire` in the `Insert` menu.
2. Click on the start point of the wire and drag cursor to the end point of the wire. Then release the mouse button. The wire connecting start point and end point will be added.

Notes:
- This way you may add either the vertical wire segment, or horizontal wire segment, or two wire segments, vertical and horizontal, making the right angle. To create wire of more complex shape you should repeat this operation several times.
- Wires are always aligned to a nearest grid node. It means that the wire will be placed so that its end points are at grid nodes.

Adding Junction Points

To add a junction point, you should just place a wire so that one of end points belongs to some existing wire. Junction point will be added in this point automatically.
Placing a wire so that it intersects another wire in a middle point for both wires is different. In this case the junction point will not be added, and the wires will be considered as not connected.

Editing Circuit

Moving, Copying and Resizing Circuit Elements

To move circuit element to another place:

1. Place cursor over element you want to move. Cursor should have the shape of four-pointed arrow.
2. Click left mouse button and drag the selected element keeping the button pressed.

To resize a wire:

1. Place cursor over the wire end point. Cursor should have the shape of two-pointed arrow.
2. Click mouse button and drag the end point to a new location.

You can not only resize the wire, but also move it sideway during this operation.

To move several elements at once:

1. Select circuit elements you want to move.
2. Place cursor over one of selected elements.
3. Click mouse button and drag the selected elements.

Dragging with Attached Elements

When you drag the circuit elements, another element attached to them could be dragged or resized to preserve connections between elements and wires. For example, when you drag some electric component the wires attached to it could be also moved or resized.

Dragging without Attached Elements

Sometimes it is more convenient to drag circuit elements so that attached wires and elements are not dragged. For example, you may want to change the circuit topology by placing the electric component to another
position. For this, press alt and keep it pressed until you release the mouse button.

**Copying Elements**

Instead of moving elements, you can make a copy of selected elements. For this, press ctrl and keep it pressed until you release the mouse button.

**Rotating Circuit Components**

To rotate circuit components for 90°, 180° or 270° counterclockwise:

1. Select the components you want to rotate.
2. In the **Edit** menu click **Rotate**, and then choose the angle value: **For 90°**, **For 180°** or **For 270°**.

You can also use toolbar button **Rotate for 90°**. Press this button several times to rotate components for desired angle.

**Deleting Circuit Elements**

To delete circuit elements:

1. Select the elements you want to delete.
2. In the **Edit** menu or context menu, click **Delete**.
This chapter describes how to solve the prepared problem, and methods QuickField uses to solve.

Several conditions have to be met to solve a problem. The problem type, plane, required precision and other parameters have to be specified in the problem description file. The model geometry file must contain complete model with mesh and labels. Each label referred by the model file is to be defined in the problem's private or library data file.

To obtain the problem solution, click **Solve Problem** in the **Problem** menu or context (right mouse button) menu of the Problem editor. You may skip this action and directly proceed to the analysis results by clicking **Analyze Results** in the **Problem** or context menu. If the problem has not been solved yet, or its results are out of date, the solver will be invoked automatically.

Each solver runs in its separate thread, so you can solve several problems at once or edit or analyze other problems while the problem is being solved. There is of course no sinice in editing any document related to the problem being solved.

Special bar indicator lets you see the progress of the solution process. To interrupt it, click **Cancel** on the indicator's panel. When solving a transient problem, you have an option to keep the results for already stored time steps.

Linear problems are solved by using a powerful preconditioned conjugate gradient method. The preconditioning based on the geometric decomposition technique guarantees a very high speed and close to linear dependence between number of nodes and the resulting solution time. Nonlinear problems are solved using the Newton-Raphson method. The
Jacobian matrix arising at each step of the Newton-Raphson method is inverted the same way as it is done for linear problems.

We use the Euler’s method (constant time step size) for solving transient problems, with initial value set to zero or taken from another field calculation. This method is extremely fast and stable, however we recommend having at least 15-20 time steps for the whole transitional process to achieve accurate and smooth results.

Achieving Maximum Performance

The algorithm used in QuickField solver does not require the whole data of the problem to fit into memory of your computer. The solver can effectively handle linear algebraic systems with matrices several times bigger than the amount of available physical memory. Data that don’t fit into memory are stored on the hard disk. The size of the problem you can solve on your computer is only limited by the amount of free disk space. Memory consumption is very low compared to other FEA packages, only about 2.7 MB per 10'000 degrees of freedom.

Although size of the problem is not limited by the amount of available memory, having additional memory may improve performance. It is obvious that the performance is the best when all the data can be stored in memory and relatively slow disk access is not used during solution.

Adaptive Mesh Refinement

QuickField is capable of adaptive refinement the mesh basing on results of previously solved problem (process also known as H-refinement). This capability practically eliminates the need for manual mesh control, allowing automatic mesh density adjustment in regions of highly inhomogeneous field.

Adjusted mesh spacing is calculated in every mesh node basing on the variation of the energy density in the node's vicinity, which is proven to be the most reliable estimation of error distribution. Although it is not possible to guarantee the precision, the refined mesh reaches its optimum providing the best precision for overall given number of mesh nodes.
Smooth mesh is generated with adjusted spacing distribution, but manually set mesh controls are also honored as top limits, guaranteeing that the mesh spacing will never exceed the user-specified values.

Even with fully automatic initial mesh, one h-refinement iteration is sufficient for most of the problems. The adaptive mesh refinement is available for all simulation types supported by QuickField, including non-linear and transient problems.
Chapter 8

Analyzing Solution

This chapter explains the procedures for detailed examination of the results using the QuickField postprocessor. Here we describe working with the solution of a two-dimensional problem. Analyzing of a three-dimensional solution is described in the Chapter 9.

To analyze the problem solution, choose View Results in the Edit or context menu of the problem window, or click the Analyze Results toolbar button. QuickField will open the Field Picture window displaying the solution results in the most appropriate way for the problem type. You can change the presentation mode and adjust other window settings choosing the View->Field Picture menu item.

There are several ways in QuickField to picture a field: as field lines (isolines), as a vector map, and as a color map with colors corresponding to intensities of the selected physical quantity. For stress analysis problems QuickField can also display the strain and stress tensor map, and picture the deformed boundary and shape.

For time-harmonic and transient problems QuickField allows one to animate the field picture viewing its changes in time.

QuickField also provides the following ways to analyze the solution results:

- Examining local field values — values of physical quantities at the specified points.
- Integrating over the line or surface defined by the specified contour, or over the volume or surface bounded by the contour.
- Building plots and tables that show the distribution of local field values along the selected contour.
- Building tables and plots showing local and integral values in transient problems versus time.
• Calculating conductor and coil parameters such as inductance, capacitance, and impedance with specialized wizards.
• Exporting various tables or pictures or the whole finite-element solution to other software programs.
• Building tables and plots showing voltages and currents at various elements of the associated electric circuit.
• Displaying the trajectories of a charged particle beam in the electrical field.

Any picture or numerical value displayed by the postprocessor can be copied to Windows clipboard for use with any word-processing or desktop publishing utility or subsequent use with spreadsheets or user-written programs.

Building the Field Picture on the Screen

Interpreted Quantities

The set of the physical quantities, which can be displayed by the Postprocessor, depends on the problem type.

For the DC and transient magnetic problems:
• Vector magnetic potential $A$ in plane-parallel problem or flux function $\Phi = 2\pi rA$ in axisymmetric case;
• Vector of magnetic flux density $B = \text{curl } A$;
• Vector of magnetic field intensity $H = B / \mu$;
• Magnetic permeability $\mu$ (its largest component in anisotropic media);
• Magnetic field energy density:

\[
w = \frac{(B \cdot H)}{2} \quad \text{— in linear media,}
\]
\[
\int H \cdot dB \quad \text{— in ferromagnetic media.}
\]

With transient magnetic problem following additional field quantities are available:
• Total electric current density $j = j_0 + j_{\text{eddy}}$,
• Source current density $j_0$,
• Eddy current density
\[ j_{\text{eddy}} = -\sigma \frac{\partial A}{\partial t}. \]

- Joule heat density

\[ Q = \frac{1}{\sigma} j^2. \]

**For the AC magnetic problem:**

- Complex amplitude of vector magnetic potential \( A \) (flux function \( rA \) in axisymmetric case);
- Complex amplitude of voltage \( U \) applied to the conductor;
- Complex amplitude of total current density \( j = j_0 + j_{\text{eddy}} \), source current density \( j_0 \) and eddy current density \( j_{\text{eddy}} = -i \omega \sigma A \).

All these complex quantities may be shown in form of momentary, root mean square (RMS) or peak value in time dimension. E.g., complex quantity \( z = z_0 e^{i(\omega t + \varphi)} \) can be shown as:

- momentary value at a given phase \( \varphi_0 = -\omega t_0 \)
- \( z_{\varphi_0} = \text{Re}[z_0 e^{i(\varphi_2 - \varphi_0)}] = z_0 \cos(\varphi_2 - \varphi_0) \)
- peak value \( z_0 \);
- RMS value \( z_{\text{RMS}} = z_0 / \sqrt{2} \).

**Note.** To display the momentary values, the phase is specified in degrees. This value of the phase is applied to all the displayed quantities. When you need the momentary values at a given moment of time \( t \), e.g., for comparison with the transient solution, you can obtain the corresponding phase value using the formula

\[ \varphi_0 = -\omega t_0 = -360^\circ f t_0 \]

where \( f \) is the magnetic field frequency in Hz, time \( t \) is in seconds. The minus sign in this formula may appear odd and non-intuitive; nonetheless it is necessary to provide the commonality in the definition of the term “phase” when defining the sources and boundary conditions on one hand, and when post processing the momentary values on the other. Let us assume that the voltage is specified in the Data Editor to have a phase of \( 30^\circ \). According to the complex presentation \( U = U_0 \cos(\omega t + \varphi) \), this means that the momentary value reaches its maximum at the moment of time \( \omega t = -30^\circ \). This implies that the momentary value in the postprocessor must also be at the maximum when \( \omega t = -30^\circ \), or at phase equal to \( +30^\circ \), QED.

- Complex vector of the magnetic flux density \( B = \text{curl} \ A \);
• Complex vector of magnetic field intensity

\[ \mathbf{H} = \frac{1}{\mu} \mathbf{B}, \]

where \( \mu \) is the magnetic permeability tensor.

Complex vectors may be shown in form of momentary, RMS or peak magnitude.

• Time average and peak Joule heat density

\[ Q = \frac{1}{\sigma} j^2 + k_h \cdot f \cdot B^2 + k_c \cdot f^2 \cdot B^2 + k_e \cdot (f \cdot B)^3 \]

• Time average and peak magnetic field energy density \( w = (\mathbf{B} \cdot \mathbf{H})/2; \)

• Time average Poynting vector (local power flow) \( \mathbf{S} = [\mathbf{ExH}] ; \)

• Time average Lorentz force density vector \( \mathbf{F} = [j\mathbf{xB}] ; \)

• Magnetic permeability \( \mu \) (its largest component in anisotropic media);

• Electric conductivity \( \sigma \).

Besides that, if the solved problem is coupled with the electric circuit, then the following parameters can be displayed in the circuit window:

• Effective \( I \), amplitude \( I_{abs} \), momentary (for the chosen phase) and complex \( (I_{re}, I_{im}) \) values of the current in the circuit branches;

• Effective \( U \), amplitude \( U_{abs} \), momentary (for the chosen phase) and complex \( (U_{re}, U_{im}) \) values of the voltage drop across the circuit component;

• Defined parameter value (resistance \( R \), inductance \( L \), capacitance \( C \)) for the passive circuit components.

**For the electrostatic problem:**

• Scalar electric potential (voltage) \( U ; \)

• Vector of electric field intensity \( \mathbf{E} = -\text{grad} \ U ; \)

• Tensor of gradient of electric field \( \mathbf{G} = \text{grad} \ \mathbf{E} ; \)

• Vector of electrostatic induction \( \mathbf{D} = \varepsilon \mathbf{E} ; \)

• Electric permittivity \( \varepsilon \) (or its largest component in anisotropic media);

• Electric field energy density \( w = (\mathbf{E} \cdot \mathbf{D})/2. \)

**For the DC conduction problem:**

• Scalar electric potential \( U ; \)

• Vector of electric field intensity \( \mathbf{E} = -\text{grad} U ; \)

• Vector of current density \( \mathbf{j} = \sigma \mathbf{E} ; \)
- Electric conductivity $\sigma$ (its largest component in anisotropic media);
- Ohmic losses per volume unit $w = (j \cdot E)/2$.

For the AC conduction problem:
- Complex amplitude of electric potential $U$;
- Complex vector of electric field intensity $E = -\nabla U$;
- Complex vector of electrostatic induction $D = \varepsilon E$;
- Complex vector of active $j_a = \sigma E$, reactive $j_{\text{re}} = \omega \varepsilon E$, and apparent $j_{\text{app}} = j_a + j_{\text{re}}$ current density;

All these complex quantities may be shown in form of momentary, root mean square (RMS) or peak value in time dimension. E.g., complex quantity $z = z_0 e^{i(\omega t + \phi)}$ may be shown as:
- momentary value at a given phase $\phi_0 = -\omega t_0$
- peak value $z_0$;
- RMS value $z_{\text{RMS}} = z_0 / \sqrt{2}$.

Note. To display the momentary values, the phase is specified in degrees. This value of the phase is applied to all the displayed quantities. When you need the momentary values at a given moment of time $t$, e.g., for comparison with the transient solution, you can obtain the corresponding phase value using the formula $\phi_0 = -\omega t_0 = -360^\circ f t$ where $f$ is the magnetic field frequency in Hz, time $t$ is in seconds.

- Time average and peak active $Q_a = j_a \cdot E$, reactive $Q_{\text{re}} = j_{\text{re}} \cdot E$, and apparent $Q_{\text{app}} = j_{\text{app}} \cdot E$ power density;
- Electric permittivity $\varepsilon$ (or its largest component in anisotropic media);
- Electric conductivity $\sigma$ (or its largest component in anisotropic media).

For transient electric field:
- Electric potential $U$;
- Electric field intensity $E = -\nabla U$;
- Vector of active $j_{\text{active}} = \sigma E$, reactive $j_{\text{reactive}} = \frac{\partial}{\partial t} \varepsilon E$ and apparent $j_{\text{apparent}} = j_{\text{active}} + j_{\text{reactive}}$ current density;
- Active power (losses) density $Q_{\text{active}} = j_{\text{active}} \cdot E$, reactive $Q_{\text{reactive}} = j_{\text{reactive}} \cdot E$, and apparent $Q_{\text{apparent}} = j_{\text{apparent}} \cdot E$ power density;
- Tensor of gradient of electric field $G = \nabla E$. 

For the AC conduction problem:
- Complex amplitude of electric potential $U$;
- Complex vector of electric field intensity $E = -\nabla U$;
- Complex vector of electrostatic induction $D = \varepsilon E$;
- Complex vector of active $j_a = \sigma E$, reactive $j_{\text{re}} = \omega \varepsilon E$, and apparent $j_{\text{app}} = j_a + j_{\text{re}}$ current density;

All these complex quantities may be shown in form of momentary, root mean square (RMS) or peak value in time dimension. E.g., complex quantity $z = z_0 e^{i(\omega t + \phi)}$ may be shown as:
- momentary value at a given phase $\phi_0 = -\omega t_0$
- peak value $z_0$;
- RMS value $z_{\text{RMS}} = z_0 / \sqrt{2}$.

Note. To display the momentary values, the phase is specified in degrees. This value of the phase is applied to all the displayed quantities. When you need the momentary values at a given moment of time $t$, e.g., for comparison with the transient solution, you can obtain the corresponding phase value using the formula $\phi_0 = -\omega t_0 = -360^\circ f t$ where $f$ is the magnetic field frequency in Hz, time $t$ is in seconds.

- Time average and peak active $Q_a = j_a \cdot E$, reactive $Q_{\text{re}} = j_{\text{re}} \cdot E$, and apparent $Q_{\text{app}} = j_{\text{app}} \cdot E$ power density;
- Electric permittivity $\varepsilon$ (or its largest component in anisotropic media);
- Electric conductivity $\sigma$ (or its largest component in anisotropic media).
- Vector of electrostatic induction (displacement) \( \mathbf{D} = \varepsilon \mathbf{E} \);
- Electric permittivity \( \varepsilon(E) \);
- Electric conductivity \( \sigma(E) \).

**For heat transfer problem:**
- Temperature \( T \);
- Vector of heat flow \( \mathbf{F} = -\lambda \text{grad}(T) \);
- Thermal conductivity \( \lambda \) (its largest component in anisotropic media).

**For stress analysis problem:**
- Displacement vector \( \delta \);
- Strain tensor \( \varepsilon \) and its principal values;
- Stress tensor \( \sigma \) and its principal values;
- Von Mises stress (stored energy of deformation criterion):
  \[
  \sigma_v = \sqrt{\frac{1}{2} \left[ (\sigma_1 - \sigma_2)^2 + (\sigma_2 - \sigma_3)^2 + (\sigma_3 - \sigma_1)^2 \right]}
  \]
  where \( \sigma_1, \sigma_2 \) and \( \sigma_3 \) denote the principal stresses in descending order.
- Tresca criterion (maximum shear): \( \sigma_v = \sigma_1 - \sigma_3 \);
- Mohr-Coulomb criterion: \( \sigma_v = \sigma_1 - \chi \cdot \sigma_3 \),
  where \( \chi = [\sigma^+]/[\sigma^-] \), and \([\sigma^+]\) and \([\sigma^-]\) denote tensile and compressive allowable stress.
- Drucker-Prager criterion:
  \[
  \sigma_v = \left( 1 + \sqrt{\chi} \right) \sigma_i - \frac{\sqrt{\chi} - \chi}{1 + \sqrt{\chi}} \bar{\sigma} + \frac{1}{[\sigma^-]} \left( \frac{1 - \sqrt{\chi}}{1 + \sqrt{\chi}} \cdot \bar{\sigma} \right)^2
  \]
  where
  \[
  \sigma_i = \sqrt{\frac{1}{2} \left[ (\sigma_1 - \sigma_2)^2 + (\sigma_2 - \sigma_3)^2 + (\sigma_3 - \sigma_1)^2 \right]}; \quad \bar{\sigma} = \frac{\sigma_1 + \sigma_2 + \sigma_3}{3}
  \]
- Tsai-Hill failure index for orthotropic materials:
  \[
  C_{th} = \frac{\sigma_1^2}{X_1^2} - \frac{\sigma_1 \sigma_2}{X_1^2 X_2^2} + \frac{\sigma_2^2}{X_2^2} + \frac{\tau_{12}^2}{S_{12}^2}
  \]
  where \( \sigma_1, \sigma_2 \) and \( \tau_{12} \) are computed stresses in the material directions and,
  \[
  X_1 = X_1^T \text{ if } \sigma_1 > 0; \quad X_1 = X_1^C \text{ if } \sigma_1 < 0
  \]
\[ X_2 = X_2^T \text{ if } \sigma_2 > 0; \]
\[ X_2 = X_2^C \text{ if } \sigma_2 < 0 \]
\[ S_{12} = S_{12}^+ \text{ if } \tau_{12} > 0; \]
\[ S_{12} = S_{12}^- \text{ if } \tau_{12} < 0, \]

where \( X_1^T, X_2^T, X_1^C, X_2^C, S_{12}^+ \) and \( S_{12}^- \) are tensile, compressive and shear allowable stresses.

The Tsai-Hill failure index is calculated only for those materials, where allowable stresses were defined (while editing the block data, see “Problem Parameters Description”). If any pair of allowable stresses is not given, the corresponding term is dropped while calculating the Tsai-Hill Index.

**Field Presentation Methods**

Several methods are available for displaying the field picture:

Color map for distribution of a chosen scalar quantity. The color map is accompanied by the legend showing the correspondence between colors and numerical values.

You can adjust the color scale by changing the range limits for the chosen quantity. Color map may be shown in gray scale mode if you want to optimize it for monochrome printing.

Field lines. Those are isotherms for temperature fields, lines of equal potential in electrostatics and flux lines for magnetostatic problems.

You can manipulate the picture by changing the distance between neighboring lines. This distance is measured in units of chosen quantity.
Vectors—family of line segments showing magnitude and direction of the vector quantity. Vectors are drawn in the nodes of the regular rectangular grid.

You can change the grid cell size and the scaling factor for a desired vector quantity.

The following methods are specifically for stress analysis problems:

Deformed boundary and shape indicated by means of deformed and original rectangular grid.

Stress tensor display as a pair of eigenvectors reflecting the direction of principal axes, magnitudes and signs of principal stresses (blue color denotes tension, red color—compression).

With these methods, you can change the grid cell size and the scaling factors in order to manipulate the appearance.

It is possible to combine several visualization methods in the same picture to obtain the most expressive result.

QuickField can display several different field pictures for the same problem. To open a new window, click **New Window** in the **Window** menu.

**Field Picture Constructing**

When entering the Postprocessor, the default form of the field picture appears on the screen. You may use **Field Picture** in the **View** menu or context menu to select other display methods or quantities.
Shown dialog box corresponds to the problem of magnetostatic.

To choose desired visualization method, select corresponding check box. You can select any combination of methods at once. If none of the methods is selected, only the model's geometry is shown.

This dialog box also allows changing scaling parameters for selected methods of presentation and the number of color grades used with the color map. When you select some edit box, you can choose Suggest button to obtain suggested value of corresponding parameter. Note that suggested values for Minimum and Maximum fields are calculated for the currently visible part of the model.

In case of AC magnetic problem, equilines and vectors are drawn at specified phase. The Field View dialog box allows setting phase value. For more expressive field picture, you can order the second family of equilines or vectors, shifted with regard to the first by 90°.
The **Field View** dialog box for the stress analysis problem additionally allows to select tensor quantity visualization.
Sizes of the vector symbols for all vector quantities except the displacement vector are determined by the corresponding physical value multiplied by the scaling factor and by the cell size. Similar method is used for stress tensor components. Unlike other vector quantities, the size of the displacement vector on the screen does not depend on the cell size. It is determined by the dimensionless scaling factor, the unit value of which means that the displacement is shown in its natural scale.

Color map of temperature difference in stress analysis problem visualizes temperature distribution as it is defined by user or imported from linked heat transfer problem. In the last case, temperature is shown only in those blocks, where it is really taken into account.

The **Failure Index** option is available when the model contains at least one block with correctly defined allowable stresses.

Choosing the **OK** button causes redrawing the field picture on the screen. **Cancel** closes the dialog box without redrawing the picture and preserves preceding values of all the parameters.

To save the field window settings and the associated contour for future, use **File / Save Status**. To restore the saved settings, use **File / Restore Status**.

**Zooming**

Zooming in postprocessor view is very similar to Model Editor.

To magnify the picture:

1. Click **Zoom In** on the toolbar
2. Select (click and drag diagonally) the rectangular part of the picture to fill the whole window with.

To see more of the model:

- Click **Zoom Out** on the toolbar; or
- Click **Zoom to Fit** to see the whole model.

**Selecting a Time Layer**

For transient problems the displayed field picture always corresponds to the selected time moment displayed in the **Time** combobox on the
postprocessor toolbar. Initially, QuickField displays the last time moment. To change it, specify another value in the combobox. QuickField will automatically display the field view corresponding to the specified time moment.

When you change the time value QuickField adjusts both the field pictures, XY-Plots and tables. The scaling factors will remain unchanged.

For time-harmonic problems the displayed field picture corresponds to the selected phase. QuickField uses the same combobox to display the selected phase value in degrees. To change it, specify another value in the combobox. QuickField will automatically display the field view corresponding to the specified phase.

Animation

When the analysis results depend on time (transient and time-harmonic problems), QuickField can present animated field pictures. To start animation, choose **View / Animation** or click the corresponding toolbar button.

During the animation, two speed control buttons appear on the toolbar allowing you to change the animation speed. The moment of time or the phase on the toolbar changes synchronously with the picture.

During the first loop, QuickField accumulates the animation frames in memory. Depending on the size of the problem, this can take considerable time, and the speed control has no effect.

Animation stops automatically upon any user action that changes the contents or the scaling of the field picture.

*Note.* Even though the problem results can be stored with varying time steps, the animation shows the frames in equal time intervals.
Calculator Window

Calculator Window is a window normally docked to the left side of the field view.

To open the calculator window, choose Calculator Window command in the View menu or corresponded button on the postprocessor toolbar. The calculator window also opens when choosing Local Values, Integral Values or one of the Wizard commands in View menu.

The calculator window is organized in several trees, which root items correspond to several kinds of numerical data. These are:

- **Local Values** shows several field quantities at a point of interest;
- **Integral calculator** lists available quantities calculated by integration over given line, surface or volume;
- **Inductance Wizard** opens wizard, which helps you calculate self or mutual inductance of the coils and conductors;
- **Capacitance Wizard** opens wizard guiding you through steps needed to calculate self or mutual capacitance of your conductors in electrostatics problems;
- **Impedance Wizard** opens wizard, which helps you calculate the impedance of the conductors in AC magnetic problems.

To open the set of values, double-click the corresponding item, or select it and press ENTER.

The calculator window is initially docked to the left side of the field view. To change its width, point to the gray splitter strip between windows and drag it to the left or to the right. You can dock the window to the right side of the field view or make it floating as ordinary popup window. Point at the window caption and drag it to the desired position.

You can select one or several items in the tree and copy them to the clipboard or drag to any application that supports drag-and-drop copy/paste operation (almost any word processor or spreadsheet). To select more than one item, click on it holding the SHIFT key (block selection) or the CTRL key (random selection). Context (right mouse button) menu also works in the calculator window. It provides you with the subset of commands for manipulating the field picture in the active view.
With a transient problem all the values in the calculator window correspond to the chosen time layer. See “Selecting a Time Layer” section above for more details.

**Examining Local Field Data**

To obtain local field data, click **Local Values** in the **View** menu or context (right mouse button) menu in field picture window. Otherwise if the calculator window is already open, double-click the **Local Values** item in the tree. The message appears prompting you to click the point. Then you can click points where you need to know the values of the field quantities.

To enter coordinates of the point of interest from keyboard, select any of coordinates with mouse and then click it again (after a period, to avoid the double-click effect) or choose **Edit Point** command from context menu. You can edit either Cartesian or polar coordinates.

To leave this mode, close local values window, or choose **Local Values** in the menu again or click corresponding button on the toolbar.

The local values of physical quantities obtained in the **Local Values** mode can be copied to clipboard for printing numerical results, or to pass them to other application program, e.g., a spreadsheet program to produce a report. Click the **Copy** button in the **Local Values** window. To see or copy exactly those field quantities you need, you can expand or collapse branches in the tree.

**Analysis of Connected Electric Circuit**

If the field problem with the connected electric circuit is solved, the data about the currents and voltages in all branches is available for viewing and analysis.

To open the electric circuit calculation results window use the **Coupled Circuit** command in the **View** menu, or correspondent button in the toolbar.

As a result the split window will be displayed. Right pane shows the electric circuit schema, left pane lists the circuit components.
Components list pane may be hidden or shown by the **Circuit Components** command of the **View** menu.

Effective value of the current in the circuit component and voltage drop along it is shown in the tool tip window displayed with small delay after the mouse cursor points to the circuit component. More details about the circuit component are available in the component list pane.

Every list item is presented by its definition (shown in semi-bold font) and two or three groups of data. Electric current and voltage drop are displayed for every item; the nominal value is also shown for passive components and sources.

Components selection in the list and schema is synchronized automatically.

Every circuit component corresponds to several lines in the list. By default all lines but the first one are hidden. To expand them you should click on the small + (plus) sign to the left from the component.

In the time-harmonic problems for the current and voltage drop in every circuit branch component effective value, instantaneous value for the selected phase, and complex value components in the algebraic and trigonometric forms are shown.

It is possible to select any number of lines in the circuit components list and put them into the clipboard (**Copy** command in the **Edit** menu). Selected lines may also be dragged into other application, for example text editor or spreadsheet.
Current and Voltage Time Plots for the Circuit Elements

When the transient problem with connected electric circuit is analyzed, the window displaying the results for a transient magnetic problem with attached circuit might contain up to 4 kinds of different panes:

- Electric circuit itself;
- The time dependency graphs for the currents in the selected circuit elements;
- The time dependency graphs for the voltages in the selected circuit elements;
- The table of currents and voltages in all circuit elements.
You can resize the panes. You can also hide panes if there is not enough of window space for all of them. Twin boundary frames indicate the existence of hidden panes in between.

The plots are displayed curves are plotted for each selected circuit component. The correspondence between the curves and circuit elements is shown by using the same color of a curve and related line in the circuit element list. Curves are redrawn when the circuit elements are selected or deselected in the list or in the electric schema drawing.

The scale of XY-plot could be adjusted by corresponding toolbar buttons: 

Pressing the zoom-in button (with plus sign) changes the cursor shape to a cross, after that you can drag over the rectangle of interest.

The graph image could be printed, copied to the Clipboard, and/or saved to a file in any of the supported raster or vector formats. To do that, invoke the corresponding commands in the context (right-click) menu of the graph.

The table of circuit currents and voltages could be printed, copied to the Clipboard, and/or saved to a text file. To do that, invoke the corresponding commands in the context (right-click) menu of the table.

### Parameter Calculation Wizards

The most common design parameters in QuickField are calculated through wizards. These calculations still could be done by using the ordinary integral quantities available in the postprocessor, but wizards allow you to get the results quicker and in most cases you can avoid manual building of the contour of integration and manipulating with complex values.

These three wizards are available in QuickField:

- Inductance Wizard calculates self or mutual inductance of the coil or conductor in AC or DC magnetic problems;
- Capacitance Wizard calculates self or mutual capacitance of the conductors in electrostatics problems;
- Impedance Wizard calculates impedance of the conductor in AC magnetic problems.

To start the wizard, choose **Wizard** in **View** menu, or double-click the corresponding item in the calculator window.
open while you start the wizard, all the parameters calculated by the wizard are shown in that view. You can start wizard again from not only its start page but also from any other page by double-clicking the corresponding value in the Values tree.

Some of the wizards provide several alternative ways to calculate the desired quantity. Each way is represented in the calculator window as a separate tree.

**Inductance Wizard**

Inductance wizard helps you to calculate self and mutual inductance of your coils in the problem of DC or AC magnetics.

When your model contains several coils that carry different currents, the flux linkage with one of them can be calculated as

$$\phi_k = L_{kk} \cdot i_k + \sum M_{nk} \cdot i_n$$

where \( L_{kk} \) is the self inductance of the coil \( k \), \( M_{nk} \) is the mutual inductance between the coils \( n \) and \( k \), \( i_k \) is the current in the coil \( k \).

On the other hand, stored magnetic energy also derives from current and inductance:

$$W = \frac{1}{2} \left( \sum_{k} L_{kk} \cdot i_k^2 + \sum_{n \neq k} M_{nk} \cdot i_k \cdot i_n \right)$$

Before using the inductance wizard, you have to formulate your problem in such a way that all the currents (space, surface or linearly distributed) but one are set to zero. There must be no permanent magnets in your model. In that case equation above becomes extremely simple and you can get inductance value as:

$$L = \frac{\phi}{i},$$

where \( \phi \) is the flux linkage with the coil excited by current \( i \), or

$$L = \frac{2W}{i^2},$$

where \( W \) is stored magnetic energy and \( i \) is the only current.

The first approach gives the self-inductance, if you get the flux linkage and the current in the same coil and mutual inductance if the coils are different. The second approach gives only the self-inductance.
Initial page of the inductance wizards invites you to choose between two approaches described above. After choosing one of them click the Next button.

The second page of inductance wizard allows you to define, which blocks represent the cross section of your coil. In general, two blocks represent each coil in the model plane: forward and return wires. If there is only one side of the coil in your model, the second one is assumed as being symmetrical to the first one or as being infinitely distant of the model and not affecting the field distribution.

To define each side of your coil, simply point the corresponding item in the Block Labels list and drag it to one of the side list. You can also use the Add buttons. No matter, which side of your coil you call Right Side and which Left Side. If only one side of the coil is represented in the model, drag item Symmetry to the opposite list if return wire of the coil is symmetrical to the direct one, or leave the list empty if return wire does not affect the electromagnetic state of your model.

You can select and drag more than one item at once if the cross section of your coil is split to several blocks.

Enter the Number of Turns for your coil if it is more than one.
As result of any action on the lists or number of turns the Flux Linkage value will change automatically being calculated as

\[ \phi = N \cdot \left( \frac{\int_{L} A \, ds}{\int_{L} ds} - \frac{\int_{R} A \, ds}{\int_{R} ds} \right) \]

— for planar case;

\[ \phi = 2\pi N \cdot \left( \frac{\int_{R} rA \, ds}{\int_{R} ds} - \frac{\int_{L} rA \, ds}{\int_{L} ds} \right) \]

— for axisymmetric case;

where \( A \) is the vector magnetic potential; \( R \) and \( L \) denote the right and the left side of the coil accordingly, \( r \) is the radius of the point.

For planar problems flux linkage and the inductance are calculated per one meter of axial depth no matter what length unit you have chosen.

When you finish with flux linkage calculation, click on the Next button. In the Current page you can select the current exciting the field and provide a number of turns in your coil.
Capacitance Wizard

Capacitance wizard helps you to calculate self and mutual capacitance of your conductors.

When your model contains several conductors, the charge of one of them can be calculated as:

\[ q_k = C_{kk} \cdot U_k + \sum C_{nk} \cdot U_n \]

where \( C_{kk} \) is the self capacitance of the \( k \)th conductor, \( C_{nk} \) is the mutual capacitance between the conductors \( n \) and \( k \), \( U_k \) is the voltage drop on the conductor \( k \).

On the other hand stored energy also derives from charge and capacitance as:

\[ W = \frac{1}{2} \left( \sum \frac{q_k^2}{C_{kk}} + \sum \frac{q_n \cdot q_k}{C_{nk}} \right) \]

and from the voltage and capacitance as:

\[ W = \frac{1}{2} \left( \sum C_{kk} \cdot U_k^2 + \sum C_{nk} \cdot U_n \cdot U_k \right) \]

Before using the capacitance wizard, you have to formulate your problem in such a way that all field sources (space, surface or linear distributed charge or voltage) but one are set to zero. In that case equation above becomes extremely simple and you can get capacitance value if you know any two of these three quantities: charge, voltage, stored energy.

When formulating your problem, you can apply known voltage to the conductor and measure the charge it produce or vice versa. Measuring the charge is a bit more complex than the voltage. It requires you to build the closed contour surrounding your conductor (but not coinciding with its surface) before you start the capacitance wizard. The easiest way to formulate the problem for capacitance calculating is to put constant potential boundary condition on the conductor’s surface and specify an arbitrary non zero electric charge in one of the vertices on the surface of the conductor.

This page of capacitance wizard allows you to specify electrodes which capacitance you want to calculate. Electrodes listed on the right side of the page are organized in two subtrees: surface conductors and linear conductors (if any).
In case you are calculating the capacitance of the condenser consisting of two electrodes, select both of them. When choosing more than one electrode their voltage will be summed up (with their sign).

In the right side of the page electrodes are listed which charge you have specified. If you have put voltage boundary condition rather than charge
on your electrodes, the only way to calculate the charge is to build the contour surrounding it but not coincident with it boundary. If so, you have to do that before you start the capacitance wizard.

When selecting one or more items in the list, you get the resulting charge in the Charge box.

**Impedance Wizard**

Impedance wizard helps you to calculate the impedance of your conductors. It is simple and contains only one page. To get the impedance value and its real and imaginary parts (resistance and reactance accordingly) the impedance wizard simply divides complex values of voltage by current:

\[ Z = \frac{U}{I}, \quad R = \text{Re}[Z], \quad X_L = \text{Im}[Z], \quad L = \frac{X_L}{2\pi f}, \]

where \( Z \) is absolute value of the impedance and \( f \) is the frequency.

If you select more than one conductor at once, the impedance wizard considers it as being connected in parallel if the voltage applied to each of them is equal and as being connected in series otherwise.
Editing Contours

The contour is a directed curved line consisting of line segments and arcs (including the edges of the model). Some rules are applied to the contours:

- The contour may not intersect itself.
- Open and closed contours are discerned.
- Multiply connected contours have sense only for calculating integral quantities.

Contour is shown in the field picture window as a set of directed lines or color-filled interior (closed counter-clockwise-directed contours).

QuickField allows editing contours in field picture windows. The following operations change the current contour state:

- **Adding lines** – attaches a line segment or an arc to the contour. The arc is specified by its degree measure (zero means line segment) and two end points. Any arbitrary line may initiate the contour, but only adjacent lines are accepted later. The line cannot be added to the closed contour. There are two ways to add lines to contour: choose **Pick Elements** from **Contour** menu or context menu and then drag mouse with left button pressed. Or, choose **Add Lines** from **Contour** menu or context menu and enter end points coordinates from keyboard.

- **Adding edges** – appends the contour with an edge of the model. The contour may be initiated by any arbitrary edge, but only adjacent edges are accepted later. The edge cannot be added to the closed contour, or if the ending point of the contour does not currently coincide with model’s vertex. To add edges, choose **Pick Elements** from **Contour** menu or context menu and then pick series of adjacent edges with mouse.

- **Adding blocks** – considers the current closed contour as a border of the plane region and updates that region by adding (or subtracting) a block of the model in the sense of set theory. To add blocks, choose **Pick Elements** from **Contour** menu or context menu and then pick blocks with mouse.

- **Close contour** – closes an open contour by connecting its open ends with a straight line or an arc, depending on current degree measure in the postprocessing toolbar.

- **Change direction** – alters the contour direction.

- **Clear** – deletes the entire contour.
• **Delete last** – deletes the last element (line or edge) in the contour. Not applicable to multiply connected contours.

Depending on current state of the contour, some editing operations may be prohibited.

The direction of the contour is significant in the following cases:

• For volume integrals, the domain of integration lies to the left of the contour.
• For surface integrals, the positive normal vector points to the right relative to the contour direction.
• The starting point of the contour corresponds to zero point at the \(x\)-axis of the X-Y plot.
• If the plotted or the integrated function has different values to the left and to the right of the contour, the right-hand value is used.

### X-Y Plots

QuickField postprocessor can display field distribution along contours. To open new X-Y plot window, choose **X-Y plot** in **View** menu or context (right mouse button) menu in field picture window, in which the contour is already defined.

In X-Y plot view, you can:

• Select the set of shown quantities. Click **X-Y Plot Curves** in the **View** or context menu.
• Zoom the plot in or out.
• View the correspondence between quantities and curves (legend).
• Copy the picture to clipboard.
• Open new X-Y plot window for the same contour.
X-Y Plot Control

Few quantities having the same unit of measurement can be shown at the same X-Y plot. According to this, all quantities are combined into groups. Full list of quantities includes all those available for the color map representation (see “Interpreted Quantities”), and also normal and tangential components of vector and scalar quantities.

When you select the appropriate group of quantities, the Curves to Show list contains the quantities selected for display, and the Available Quantities list contains available but not selected quantities. You can use buttons located between the lists, or simply double-click in the lists, to move some quantity from one list to another.

In the dialog box, you can also modify the range of y coordinate. By default, it fits all the currently selected curves. You can get the suggested value of lower or upper limit by selecting the corresponding text box (Minimum or Maximum) and choosing Suggest button.

In time-harmonic analysis, you can also switch between momentary (at given phase), time average and peak values of time dependent quantities.

You can turn on or off the switches for displaying coordinate grid and markers on the curves. The last mode allows you to distinguish between the coinciding curves.
Calculating Integrals

QuickField calculates line, surface and volume integrals. In plane-parallel problem, a contour defines cylindrical (in generalized sense) surface of infinite depth, or volume of that cylinder for volume integral. Therefore, in plane-parallel formulation surface and volume integrals are calculated per unit depth. In axisymmetric problem, a contour defines toroidal surface, or toroid for volume integral.

Positive direction of a contour is counter-clockwise. The direction of the contour is accounted as follows:

- For volume integrals the domain of integration lies to the left of the contour.
- For surface integrals the positive normal vector points to the right relative to the contour direction.
- If the plotted or the integrated function has different values to the left and to the right of the contour, the right-hand value is used.

Force, torque and electric charge integrals represent real physical quantities only when the contour is closed. However, these integrals are calculated for the unclosed contours too.

To calculate integrals, click Integral Values in the View menu or context (right mouse button) menu. Or, if calculator window is already open, double-click on the Integral Calculator item in the tree. If the contour is already defined, a list of available integral quantities appears. The list varies depends on whether your contour is open or closed. If you have no contour defined in the active field view, a message appears prompting you to build the contour. You can get a value of an integral parameter by click on the small gray button left on its name or by double click on the name. Once opened the integral value will be recalculated automatically each time you change the contour.

Some integrals require closed counter-clockwise oriented contour, otherwise they have no physical sense. Once you created the contour, you can select an integral quantity from the list and choose Calculate button to get the value. Copy button allows you to copy the calculated result to clipboard.

When the electric or magnetic force, torque, electric charge, electric current or heat flux are to be calculated, the domain of integration may be chosen by many different ways. The only requirement for the surface of
integration is to contain all the necessary bodies, but to avoid any extra bodies or field sources. It is important to understand that the accuracy will be the best if you choose the integration surface as far as possible from the places with strong inhomogeneity of field, e.g. field sources or boundaries of conducting or ferromagnetic bodies.

When calculating the flux linkage the domain of integration must exactly fit the cross section of the coil.

The next sections describe the integral values QuickField can evaluate for different problem types. Besides the corresponding formulation, each description specifies the value enumeration constant for the appropriate invocation of QuickField.Result.GetIntegral (the detailed description of the ActiveField technology that provides the programmatic interface to QuickField can be found in QuickField Help).

The formulations share the following geometric notations:

- **n** the vector of the outward unit normal;
- **t** the unit tangent vector;
- **r** the position vector of the point.

The notations for the domain of integration vary in the following way:

- **L** for integration along the contour;
- **S** for integration across the surface swept by the movement of the contour;
- **S_C** for integration across the planar surface defined by the interior of the closed contour;
- **V** for integration across the interior of the closed surface swept by the movement of the closed contour.

**Note.** In plane-parallel formulations the contour sweeps the surface moving along the \( z \)-axis for the axial length of the problem (1m, by default).

In axisymmetric formulations the contour does so rotating around the \( x \) axis for 360 degrees.

**For DC and transient magnetic problems:**

Generally the integral quantities of interest in magnetic analysis are: mechanical force and torque, magnetic flux and flux linkage, magnetomotive force (MMF), magnetic field energy.
The following notations are used in formulas:

- \( \mathbf{B} \) – magnetic flux density vector;
- \( \mathbf{H} \) – vector of magnetic field strength;
- \( A \) – \( z \)-component of magnetic vector potential;
- \( B(H) \) magnetization curve of a ferromagnetic, that assumed to be isotropic.

<table>
<thead>
<tr>
<th>Name, Active Field constant</th>
<th>Formula and Description</th>
</tr>
</thead>
</table>
| Mechanical force \( qfInt\_MaxwellForce \) | \[
F = \frac{1}{2} \oint_S \left( \mathbf{H}(\mathbf{n} \cdot \mathbf{B}) + \mathbf{B}(\mathbf{n} \cdot \mathbf{H}) - \mathbf{n}(\mathbf{H} \cdot \mathbf{B}) \right) ds,
\]

Total magnetic force acting on bodies contained in a particular volume, where integral is evaluated over the boundary of the volume.

| Mechanical torque \( qfInt\_MaxwellTorque \) | \[
T = \frac{1}{2} \oint_S \left( [\mathbf{r} \times \mathbf{H}](\mathbf{n} \cdot \mathbf{B}) + [\mathbf{r} \times \mathbf{B}](\mathbf{n} \cdot \mathbf{H}) - [\mathbf{r} \times \mathbf{n}](\mathbf{H} \cdot \mathbf{B}) \right) ds
\]

Total torque of magnetic forces acting on bodies contained in a particular volume.

where \( \mathbf{r} \) is a radius vector of the point of integration.

The torque vector is parallel to \( z \) axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \( [\mathbf{F} \times \mathbf{r}_0] \), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_0 \) is the radius vector of the point.

| Flux linkage per one turn \( qfInt\_FluxLinkage \) | \[
\Psi = \frac{\oint_S \phi \, Ads}{S_c}
\] — for planar case;

\[
\Psi = \frac{2\pi \oint_S \phi(rA)ds}{S_c}
\] — for axisymmetric case.

The integral has to be evaluated over a cross section of the coil, and \( S_c \) is the area of the cross section.
<table>
<thead>
<tr>
<th><strong>Magnetomotive force</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_KGrad_t_dl</td>
</tr>
<tr>
<td><em>F</em> = ( \int_{L} (\mathbf{H} \cdot \mathbf{t}) dl )</td>
</tr>
<tr>
<td>Magnetomotive force is a line integral around the contour of magnetic field strength. According Ampere’s law the magnetomotive force around a closed line is equal to total current through the contour.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Magnetic flux</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_Grad_n_ds</td>
</tr>
<tr>
<td>( \Phi = \int_{S} (\mathbf{B} \cdot \mathbf{n}) ds )</td>
</tr>
<tr>
<td>Magnetic flux over the surface defined by the contour.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Magnetic field energy</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_MagneticEnergy</td>
</tr>
<tr>
<td>( W = \frac{1}{2} \int (\mathbf{H} \cdot \mathbf{B}) dv ) — linear case;</td>
</tr>
<tr>
<td>( W = \int \left( \int_{0}^{B} H(B') dB' \right) dv ) — nonlinear case.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Magnetic field co-energy</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_MagneticCoEnergy</td>
</tr>
<tr>
<td>( W_{co} = \int_{V} \left( \int_{0}^{H} B(H') dH' \right) dv ) nonlinear case.</td>
</tr>
<tr>
<td>For linear problem the co-energy is equal to the magnetic energy.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Linearized field energy</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_ElectrostaticEnergy</td>
</tr>
<tr>
<td>( W_{lin} = \frac{1}{2} \int (\mathbf{B} \cdot \mathbf{H}) dv )</td>
</tr>
<tr>
<td>For linear case the linearized energy is equal to the ordinary magnetic energy.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Surface energy</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_GradKGrad_n_ds</td>
</tr>
<tr>
<td>( W_{s} = \frac{1}{2} \int_{S} (\mathbf{B} \cdot \mathbf{H}) ds )</td>
</tr>
<tr>
<td>The ( (\mathbf{B} \cdot \mathbf{H}) ) product is integrated is over a surface defined by the contour.</td>
</tr>
<tr>
<td>Average surface potential</td>
</tr>
<tr>
<td>---------------------------</td>
</tr>
<tr>
<td>Average volume potential</td>
</tr>
<tr>
<td>Average volume flux density</td>
</tr>
<tr>
<td>Average volume strength</td>
</tr>
<tr>
<td>Mean square flux density</td>
</tr>
<tr>
<td>Mean square strength</td>
</tr>
<tr>
<td>Line integral of flux density</td>
</tr>
<tr>
<td>Surface integral of strength</td>
</tr>
</tbody>
</table>

**With transient problems only:**

<table>
<thead>
<tr>
<th>Total current</th>
<th>[ I = \int_{S_c} j , ds ]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electric current through a particular surface. The integral is evaluated over a cross section of the coil, and ( S_c ) is the area of the cross section</td>
<td></td>
</tr>
<tr>
<td>( j ) – is a total current density in z-direction.</td>
<td></td>
</tr>
<tr>
<td>External current</td>
<td>[ I_{ext} = \int_{S_c} j_{ext} , ds ]</td>
</tr>
<tr>
<td>Integral Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>External current</td>
<td>External current through a particular surface.</td>
</tr>
<tr>
<td>Eddy current</td>
<td>Eddy current through a particular surface.</td>
</tr>
<tr>
<td>Joule heat</td>
<td>Joule heat power in a volume.</td>
</tr>
</tbody>
</table>

For AC magnetic problems:

For the AC magnetic field analysis, the most interesting integral values are: the total, eddy and external current, the mechanical force and torque, the magnetic flux and flux linkage, the magnetomotive force, the field energy.

The following notations are used in formulas:

- **B** – complex vector magnetic flux density;
- **H** – complex vector magnetic field intensity (field strength);
- $j_{\text{total}}, j_{\text{eddy}}, j_{\text{ext}}$ – complex values of total, eddy and external current density;
- **A** – z-component of complex magnetic vector potential.

Since AC magnetic problems' formulations use complex values that represent the real world quantities sinusoidally changing with time, the integral values might appear in the following different ways:

- As a **Complex value**, with amplitude and phase (e.g. current, flux linkage, magnetomotive force).
- As a **Complex vector**, with the endpoint sweeping an ellipse in any complete time period (e.g. induction, magnetic field strength). The characteristics of complex vectors are: the amplitude (per coordinate), the phase, and the polarization coefficient.
- As a **Quadratic value** (e.g. ohmic loss power, field energy, etc.) pulsing around its mean value with double frequency. The
characteristics of quadratic values are: the mean value, the phase, and
the pulsation amplitude.

- As a **Quadratic vector** (e.g. mechanical forces) with magnitude and
direction varying around its mean value with double frequency. The
characteristics of quadratic vectors are: the mean value (length, slant
and coordinates), and the variation amplitude (used, for example, to
estimate the mechanical force limit for a period).

<table>
<thead>
<tr>
<th>Name, Active Field constant</th>
<th>Formula and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total current qfInt_Jtotal</td>
<td>( I_{total} = \int_{S_c} j_{total} ds )</td>
</tr>
<tr>
<td></td>
<td>Complex value. Electric current through a particular surface.</td>
</tr>
<tr>
<td>External current qfInt_Jextern</td>
<td>( I_{ext} = \int_{S_c} j_{ext} ds )</td>
</tr>
<tr>
<td></td>
<td>Complex value. External current through a particular surface.</td>
</tr>
<tr>
<td>Eddy current qfInt_Jeddies</td>
<td>( I_{eddy} = \int_{S_c} j_{eddy} ds )</td>
</tr>
<tr>
<td></td>
<td>Complex value. Eddy current through a particular surface.</td>
</tr>
<tr>
<td>Joule heat qfInt_Power</td>
<td>( P = \int_V \frac{1}{\sigma} \cdot j_{total}^2 dv )</td>
</tr>
<tr>
<td></td>
<td>Quadratic value. Joule heat power in a particular volume. (\sigma) – electric conductivity of the media.</td>
</tr>
<tr>
<td>Core loss qfInt_Steinmetz</td>
<td>( P = \int_V \left[ k_h \cdot f \cdot B^2 + k_c \cdot f^2 \cdot B^2 + k_e \cdot (f \cdot B)^3 \right] dv )</td>
</tr>
<tr>
<td></td>
<td>where ( B ) is the magnetic flux density peak value, and ( k_h, k_c, k_e ) are user defined coefficients.</td>
</tr>
</tbody>
</table>
### Power flow

**P** = \( \int_S (\mathbf{S} \cdot \mathbf{n}) ds \)

Quadratic value.
Power flow through the given surface (Poynting vector flow)
Here \( \mathbf{S} \) – is a Pointing vector \( \mathbf{S} = [\mathbf{E} \times \mathbf{H}] \).

### Maxwell force

**F** = \( \frac{1}{2} \oint_S \left( \mathbf{H}(\mathbf{n} \cdot \mathbf{B}) + \mathbf{B}(\mathbf{n} \cdot \mathbf{H}) - \mathbf{n}(\mathbf{H} \cdot \mathbf{B}) \right) ds \),

Quadratic vector.
Maxwell force acting on bodies contained in a particular volume.
The integral is evaluated over the boundary of the volume, and \( \mathbf{n} \) denotes the vector of the outward unit normal.

### Maxwell torque

**T** = \( \frac{1}{2} \oint_S \left( \left[ \mathbf{r} \times \mathbf{H} \right](\mathbf{n} \cdot \mathbf{B}) + \left[ \mathbf{r} \times \mathbf{B} \right](\mathbf{n} \cdot \mathbf{H}) - \left[ \mathbf{r} \times \mathbf{n} \right](\mathbf{H} \cdot \mathbf{B}) \right) ds \),

Quadratic value.
Maxwell force torque acting on bodies contained in a particular volume, where \( \mathbf{r} \) is a radius vector of the point of integration.
The torque vector is parallel to \( z \) axis in the planar case, and is identically equal to zero in the axisymmetric one.
The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \( [\mathbf{F} \times \mathbf{r}_0] \), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_0 \) is the radius vector of the point.

### Lorentz force

**F** = \( \int_V [\mathbf{j} \times \mathbf{B}] dv \).

Quadratic vector.
The Lorentz force acting on conductors contained in a particular volume.
<table>
<thead>
<tr>
<th><strong>Lorentz torque</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_LorentzTorque</td>
</tr>
<tr>
<td>$\mathbf{T} = \int_v [\mathbf{r} \times [\mathbf{j} \times \mathbf{B}]]dv$.</td>
</tr>
<tr>
<td>Quadratic value.</td>
</tr>
<tr>
<td>The Lorentz force torque acting on bodies contained in a particular volume. The torque is considered relative to the origin of the coordinate system.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Magnetic field energy</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_MagneticEnergy</td>
</tr>
<tr>
<td>$W = \frac{1}{2} \int_v (\mathbf{H} \cdot \mathbf{B})dv$</td>
</tr>
<tr>
<td>Quadratic value.</td>
</tr>
<tr>
<td>This formula is used for both linear and nonlinear cases.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Flux linkage per one turn</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_FluxLinkage</td>
</tr>
<tr>
<td>$\psi = \frac{\oint A ds}{S_C}$ — for planar case;</td>
</tr>
<tr>
<td>$\psi = \frac{2\pi \oint (rA) ds}{S_C}$ — for axisymmetric case.</td>
</tr>
<tr>
<td>Complex value.</td>
</tr>
<tr>
<td>The integral has to be evaluated over a cross section of the coil, and $S_C$ is the area of the cross section.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Magnetomotive force</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_KGrad_t_dl</td>
</tr>
<tr>
<td>$\mathbf{F} = \int_L (\mathbf{H} \cdot \mathbf{t})dl$</td>
</tr>
<tr>
<td>Complex value.</td>
</tr>
<tr>
<td>Magnetomotive force.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Magnetic flux</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_Grad_n_ds</td>
</tr>
<tr>
<td>$\Phi = \int_S (\mathbf{B} \cdot \mathbf{n})ds$</td>
</tr>
<tr>
<td>Complex value.</td>
</tr>
<tr>
<td>Magnetic flux through a particular surface.</td>
</tr>
<tr>
<td>Surface energy</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Quadratic value.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Average surface potential</th>
<th>$A_s = \frac{1}{S} \int_s A , ds$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complex value.</td>
<td>Integrated over a particular volume</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Average volume potential</th>
<th>$A_V = \frac{1}{V} \int_v A , dv$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complex value.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Average volume flux density</th>
<th>$B_a = \frac{1}{V} \int_v B , dv$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complex vector.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Average volume strength</th>
<th>$H_a = \frac{1}{V} \int_v H , dv$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complex vector.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mean square flux density</th>
<th>$B_a^2 = \frac{1}{V} \int_v B^2 , dv$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quadratic value.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mean square strength</th>
<th>$H_a^2 = \frac{1}{V} \int_v H^2 , dv$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quadratic value.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 8 Analyzing Solution

<table>
<thead>
<tr>
<th>Line integral of flux density</th>
<th>$x = \int_L (\mathbf{B} \cdot \mathbf{t}) dl$</th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_Grad_t_dl</td>
<td>Complex value.</td>
</tr>
<tr>
<td></td>
<td>The line integral over the contour of a magnetic flux density.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Surface integral of strength</th>
<th>$x = \int_S (\mathbf{H} \cdot \mathbf{n}) ds$</th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_KGrad_n_ds</td>
<td>Complex value.</td>
</tr>
</tbody>
</table>

**Note.** The Maxwell force incorporates both the force acting on ferromagnetic bodies and Lorentz force, which acts only on conductors. If the first component is negligible or is not considered, we recommend calculating the electromagnetic force as Lorentz force. Its precision is less sensitive to the contour path, and you can simply select conductors via block selection to calculate the force. With Maxwell force, this method leads to very rough results, and you are recommended to avoid coinciding of your contour parts and material boundaries, as described earlier in this chapter.

**For electrostatic problems:**

Generally the integral quantities of interest in electrostatic analysis are: electric charge, potential difference, mechanical force and torque, field energy.

The following notations are used in formulas:

- $\mathbf{E}$ — electric field strength;
- $\mathbf{D}$ — vector of electric flux density (electric displacement);
- $U$ — electric potential.

<table>
<thead>
<tr>
<th>Name, ActiveFied constant</th>
<th>Formula and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical charge</td>
<td>$q = \oint_S \mathbf{D} \cdot \mathbf{n} ds$</td>
</tr>
<tr>
<td>qfInt_KGrad_n_ds</td>
<td></td>
</tr>
</tbody>
</table>
According to the Gauss theorem, total electric charge in a particular volume can be calculated as a flux of electric displacement over its closed boundary.

**Mechanical force**  
\[ \mathbf{F} = \frac{1}{2} \oint_S \left( \mathbf{E}(\mathbf{n} \cdot \mathbf{D}) + \mathbf{D}(\mathbf{n} \cdot \mathbf{E}) - \mathbf{n}(\mathbf{E} \cdot \mathbf{D}) \right) ds \]

Total electric force acting on bodies contained in a particular volume. The integral is evaluated over the volume’s boundary.

**Mechanical torque**  
\[ \mathbf{T} = \frac{1}{2} \oint_S \left( \left[ \mathbf{r} \times \mathbf{E} \right](\mathbf{n} \cdot \mathbf{D}) + \left[ \mathbf{r} \times \mathbf{D} \right](\mathbf{n} \cdot \mathbf{E}) - \left[ \mathbf{r} \times \mathbf{n} \right](\mathbf{E} \cdot \mathbf{D}) \right) ds \]

Total torque of electric forces acting on bodies contained in a particular volume.

The torque vector is parallel to \( z \) axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \( [\mathbf{F} \times \mathbf{r}_0] \), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_0 \) is the radius vector of the point.

**Stored energy**  
\[ W = \frac{1}{2} \int_v (\mathbf{E} \cdot \mathbf{D}) dv \]

Electric field energy in a particular volume.

**Surface energy**  
\[ W_s = \int_s (\mathbf{E} \cdot \mathbf{D}) ds \]

**Potential difference**  
\[ \Delta U = \int_L (\mathbf{E} \cdot \mathbf{t}) dl \]

The potential difference between the ending and started points of a contour can be calculated as a line integral over the contour of electric field strength.
### Analyzing Solution

**Average surface potential**

\[
qfInt\_Potential\_ds \quad U_s = \frac{1}{S} \int_S U ds
\]

**Average volume potential**

\[
qfInt\_Potential\_dv \quad U_v = \frac{1}{V} \int_V U dv
\]

**Average volume strength**

\[
qfInt\_Grad\_dv \quad E_a = \frac{1}{V} \int_V E dv
\]

Average electric filed strength in a particular volume.

**Average volume displacement**

\[
qfInt\_KGrad\_dv \quad D_a = \frac{1}{V} \int_V D dv
\]

Average electric displacement vector in a particular volume.

**Mean square strength**

\[
qfInt\_Grad2\_dv \quad E_a^2 = \frac{1}{V} \int_V E^2 dv
\]

**Mean square displacement**

\[
qfInt\_KGrad2\_dv \quad D_a^2 = \frac{1}{V} \int_V D^2 dv
\]

**Line integral of displacement**

\[
qfInt\_KGrad\_t\_dl \quad x = \int_L (D \cdot t) dl
\]

**Surface integral of strength**

\[
qfInt\_Grad\_n\_ds \quad x = \int_S (E \cdot n) ds
\]

---

**For DC conduction problems:**

Generally the integral quantities of interest in DC conduction analysis are: electric current, Joule heat.

The following notations are used in formulas:

- **E** — electric field strength;
- **j** — vector of current density;
- $\mathbf{D}$ — vector of electric flux density (electric displacement);
- $U$ — scalar electric potential.

<table>
<thead>
<tr>
<th>Name, ActiveFied constant</th>
<th>Formula and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current through a surface qfInt_KGrad_n_ds</td>
<td>$I = \int_S (\mathbf{j} \cdot \mathbf{n})ds$</td>
</tr>
<tr>
<td>Joule heat in a volume qfInt_GradKGrad_dv</td>
<td>$W = \int_V (\mathbf{E} \cdot \mathbf{j})dv$</td>
</tr>
<tr>
<td>Potential difference qfInt_Grad_t_dl</td>
<td>$\Delta U = \int_L (\mathbf{E} \cdot \mathbf{t})dl$</td>
</tr>
<tr>
<td>Surface Joule heat qfInt_GradKGrad_n_ds</td>
<td>$W_S = \int_S (\mathbf{E} \cdot \mathbf{j})ds$</td>
</tr>
<tr>
<td>Average surface potential qfInt_Potential_ds</td>
<td>$U_S = \frac{1}{S} \int_S Uds$</td>
</tr>
<tr>
<td>Average volume potential qfInt_Potential_dv</td>
<td>$U_V = \frac{1}{V} \int_V Udv$</td>
</tr>
<tr>
<td>Average volume strength qfInt_Grad_dv</td>
<td>$\mathbf{E}_a = \frac{1}{V} \int_V \mathbf{E}dv$</td>
</tr>
<tr>
<td>Average volume current density qfInt_KGrad_dv</td>
<td>$\mathbf{j}_a = \frac{1}{V} \int_V \mathbf{j}dv$</td>
</tr>
</tbody>
</table>
Mean square strength
qfInt_Grad2_dv

\[ E_{a}^{2} = \frac{1}{V} \int_{V} E^{2} dV \]

Mean square current density
qfInt_KGrad2_dv

\[ j_{a}^{2} = \frac{1}{V} \int_{V} j^{2} dV \]

Surface integral of strength
qfInt_Grad_n_ds

\[ x = \int_{S} (E \cdot n) ds \]

Line integral of current density
qfInt_KGrad_t_dl

\[ x = \int_{L} (j \cdot t) dl \]

### For AC conduction problems:

For the AC conduction analysis, the most interesting integral values are: active, reactive and apparent current through particular surface, Joule heat, mechanical force and torque, field energy.

The following notations are used in formulas:

- **E** – complex vector of electric field strength;
- **D** – complex vector of electric displacement;
- **j_A** – complex vector of active current density;
- **j_RE** – complex vector of reactive current density;
- **j_APP** – complex vector of apparent current density;
- **U** – complex value of electric potential;

Since AC conduction problems' formulations use complex values that represent the real world quantities sinusoidally changing with time, the integral values might appear in the following different ways:

- As a **Complex value**, with amplitude and phase (e.g. current, potential).
- As a **Complex vector**, with the endpoint sweeping an ellipse in any complete time period (e.g. current density, field strength). The characteristics of complex vectors are: the amplitude (per coordinate), the phase, and the polarization coefficient.
- As a **Quadratic value** (e.g. ohmic loss power, field energy, etc.) pulsing around its mean value with double frequency. The
characteristics of quadratic values are: the mean value, the phase, and the pulsation amplitude.

- As a **Quadratic vector** (e.g. mechanical forces) with magnitude and direction varying around its mean value with double frequency. The characteristics of quadratic vectors are: the mean value (length, slant and coordinates), and the variation amplitude (used, for example, to estimate the mechanical force limit for a period).

<table>
<thead>
<tr>
<th>Name, Active Field constant</th>
<th>Formula and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active current through a given surface</td>
<td>$I_A = \int_S (j_A \cdot n)ds$</td>
</tr>
<tr>
<td>qfInt_Jactive</td>
<td>Complex value.</td>
</tr>
<tr>
<td></td>
<td>Active current through a particular surface.</td>
</tr>
<tr>
<td>Reactive current through a given surface</td>
<td>$I_{RE} = \int_S (j_{RE} \cdot n)ds$</td>
</tr>
<tr>
<td>qfInt_Jreactive</td>
<td>Complex value.</td>
</tr>
<tr>
<td></td>
<td>Reactive electric current through a particular surface.</td>
</tr>
<tr>
<td>Apparent current through a given surface</td>
<td>$I_{APP} = \int_S (j_{APP} \cdot n)ds$</td>
</tr>
<tr>
<td>qfInt_Japparent</td>
<td>Complex value.</td>
</tr>
<tr>
<td></td>
<td>Apparent electric current through a particular surface.</td>
</tr>
<tr>
<td>Active power produced in a volume</td>
<td>$P_A = \int_V (E \cdot j_A)dv$</td>
</tr>
<tr>
<td>qfInt_PowerActive</td>
<td>Quadratic value.</td>
</tr>
<tr>
<td></td>
<td>Joule heat power produced in a particular volume.</td>
</tr>
<tr>
<td>Reactive power produced in a volume</td>
<td>$P_{RE} = \int_V (E \cdot j_{RE})dv$</td>
</tr>
<tr>
<td>qfInt_PowerReactive</td>
<td>Quadratic value.</td>
</tr>
<tr>
<td></td>
<td>Reactive power produced in a particular volume.</td>
</tr>
<tr>
<td>Apparent power produced in a volume</td>
<td>$P_{APP} = \int_V (E \cdot j_{APP})dv$</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>qfInt_PowerApparent</td>
<td>Quadratic value. Apparent power produced in a particular volume.</td>
</tr>
<tr>
<td>Mechanical force</td>
<td>$F = \frac{1}{2} \oint_s \left(\vec{E}(\vec{n} \cdot \vec{D}) + \vec{D}(\vec{n} \cdot \vec{E}) - \vec{n}(\vec{E} \cdot \vec{D})\right)ds$</td>
</tr>
<tr>
<td>Mechanical torque</td>
<td>$T = \frac{1}{2} \oint_s \left([\vec{r} \times \vec{E}](\vec{n} \cdot \vec{D}) + [\vec{r} \times \vec{D}](\vec{n} \cdot \vec{E}) - [\vec{r} \times \vec{n}](\vec{E} \cdot \vec{D})\right) ds$</td>
</tr>
<tr>
<td>qfInt_MaxwellTorque</td>
<td>Quadratic value. Electric force torque acting on bodies contained in a particular volume, where $r$ is a radius vector of the point of integration. The torque vector is parallel to $z$ axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of $[\vec{F} \times \vec{r}_0]$, where $\vec{F}$ is the total force and $\vec{r}_0$ is the radius vector of the point.</td>
</tr>
<tr>
<td>Electric field energy</td>
<td>$W = \frac{1}{2} \int_V (\vec{E} \cdot \vec{D}) dv$</td>
</tr>
<tr>
<td>qfInt_ElectrostaticEnergy</td>
<td>Quadratic value. Electric field energy in a particular volume.</td>
</tr>
<tr>
<td>Surface energy</td>
<td>$W_S = \int_S (\vec{E} \cdot \vec{D}) ds$</td>
</tr>
<tr>
<td>qfInt_GradKGrad_n_ds</td>
<td>Quadratic value.</td>
</tr>
<tr>
<td>Potential difference</td>
<td>$\Delta U = \int_L (\vec{E} \cdot \vec{t}) dl$</td>
</tr>
<tr>
<td>qfInt_Grad_t_dl</td>
<td>Complex value. The potential difference between the ending and started</td>
</tr>
<tr>
<td>Points of a contour can be calculated as a line integral over the contour of electric field strength.</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Average surface potential</strong></td>
<td></td>
</tr>
<tr>
<td>qfInt_Potential_ds</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( U_S = \frac{1}{S} \int_S U ds )</td>
<td></td>
</tr>
<tr>
<td>Complex value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Average volume potential</strong></td>
<td></td>
</tr>
<tr>
<td>qfInt_Potential_dv</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( U_V = \frac{1}{V} \int_V U dv )</td>
<td></td>
</tr>
<tr>
<td>Complex value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Average volume strength</strong></td>
<td></td>
</tr>
<tr>
<td>qfInt_Grad_dv</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( E_a = \frac{1}{V} \int_V E dv )</td>
<td></td>
</tr>
<tr>
<td>Complex vector. Average electric field strength vector in a particular volume.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Average volume displacement</strong></td>
<td></td>
</tr>
<tr>
<td>qfInt_KGrad_dv</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( D_a = \frac{1}{V} \int_V D dv )</td>
<td></td>
</tr>
<tr>
<td>Complex vector. Average electric displacement vector in a particular volume.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mean square strength</strong></td>
<td></td>
</tr>
<tr>
<td>qfInt_Grad2_dv</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( E_a^2 = \frac{1}{V} \int_V E^2 dv )</td>
<td></td>
</tr>
<tr>
<td>Quadratic value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mean square displacement</strong></td>
<td></td>
</tr>
<tr>
<td>qfInt_KGrad2_dv</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( D_a^2 = \frac{1}{V} \int_V D^2 dv )</td>
<td></td>
</tr>
<tr>
<td>Quadratic value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Electric charge</strong></td>
<td></td>
</tr>
<tr>
<td>qfInt_KGrad_n_ds</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( Q_S = \int_S (\mathbf{D} \cdot \mathbf{n}) ds )</td>
<td></td>
</tr>
<tr>
<td>Complex value. The total electric charge in a particular volume can be calculated as a flux of electric displacement over the volume’s closed boundary.</td>
<td></td>
</tr>
</tbody>
</table>
Line integral of displacement \( qfInt\_KGrad\_t\_dl \) \[ x = \int_L (\mathbf{D} \cdot \mathbf{t})dl \]

Complex value.

**Transient electric field:**

The integral quantities in transient electric analysis are: electric charge, potential difference, active and reactive current, Joule heat, mechanical force and torque, field energy.

The following notations are used in formulas:

- \( \mathbf{E} \) – electric field strength;
- \( \mathbf{D} \) – vector of electric flux density (electric displacement);
- \( j_A \) – active current density;
- \( j_{RE} \) – reactive current density;
- \( U \) – electric potential.

<table>
<thead>
<tr>
<th>Name, Active Field constant</th>
<th>Formula and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical charge ( qfInt_KGrad_n_ds )</td>
<td>[ q = \oint \mathbf{D} \cdot \mathbf{n} ; ds ] According to the Gauss theorem, total electric charge in a particular volume can be calculated as a flux of electric displacement over its closed boundary.</td>
</tr>
<tr>
<td>Active current through a given surface ( qfInt_Jactive )</td>
<td>[ I_A = \int_S (j_A \cdot \mathbf{n})ds ] Active electric current through a particular surface.</td>
</tr>
<tr>
<td>Reactive current through a given surface ( qfInt_Jreactive )</td>
<td>[ I_{RE} = \int_S (j_{RE} \cdot \mathbf{n})ds ] Reactive electric current through a particular surface.</td>
</tr>
<tr>
<td>Active power produced in a volume ( qfInt_PowerActive )</td>
<td>[ P_A = \int_V (\mathbf{E} \cdot j_A)dv ] Joule heat power produced in a particular volume.</td>
</tr>
<tr>
<td>Calculation</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Mechanical force**<br>qfInt_MaxwellForce | \[ F = \frac{1}{2} \oint_s (\mathbf{E}(\mathbf{n} \cdot \mathbf{D}) + \mathbf{D}(\mathbf{n} \cdot \mathbf{E}) - \mathbf{n}(\mathbf{E} \cdot \mathbf{D}))ds \]  
Total electric force acting on bodies contained in a particular volume. The integral is evaluated over the volume’s boundary. |
| **Mechanical torque**<br>qfInt_MaxwellTorque | \[ T = \frac{1}{2} \oint_s \left( [\mathbf{r} \times \mathbf{E}](\mathbf{n} \cdot \mathbf{D}) + [\mathbf{r} \times \mathbf{D}](\mathbf{n} \cdot \mathbf{E}) - [\mathbf{r} \times \mathbf{n}](\mathbf{E} \cdot \mathbf{D}) \right) ds \]  
Total torque of electric forces acting on bodies contained in a particular volume.  
The torque vector is parallel to \( z \) axis in the planar case, and is identically equal to zero in the axisymmetric one.  
The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \([\mathbf{F} \times \mathbf{r}_0]\), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_0 \) is the radius vector of the point. |
| **Stored energy**<br>qfInt_ElectrostaticEnergy | \[ W = \frac{1}{2} \int_v (\mathbf{E} \cdot \mathbf{D})dv \]  
Electric field energy in a particular volume. |
| **Surface energy**<br>qfInt_GradKGrad_n_ds | \[ W_S = \int_S (\mathbf{E} \cdot \mathbf{D})ds \] |
| **Potential difference**<br>qfInt_Grad_t_dl | \[ \Delta U = \int_L (\mathbf{E} \cdot \mathbf{t})dl \]  
The potential difference between the ending and started points of a contour can be calculated as a line integral over the contour of electric field strength. |
| **Average surface potential**<br>qfInt_Potential_ds | \[ U_S = \frac{1}{S} \int_S Uds \] |
| **Average volume potential** | \[ U_V = \frac{1}{V} \int_V Udv \] |
### Chapter 8 Analyzing Solution

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>qfInt_Potential_dv</td>
<td>Average volume strength</td>
</tr>
<tr>
<td>Average volume strength</td>
<td>( E_a = \frac{1}{V} \int_V E , dv )</td>
</tr>
<tr>
<td>qfInt_Grad_dv</td>
<td>Average electric filed strength in a particular volume.</td>
</tr>
<tr>
<td>Average volume displacement</td>
<td>( D_a = \frac{1}{V} \int_V D , dv )</td>
</tr>
<tr>
<td>qfInt_KGrad_dv</td>
<td>Average electric displacement vector in a particular volume.</td>
</tr>
<tr>
<td>Mean square strength</td>
<td>( E_a^2 = \frac{1}{V} \int_V E^2 , dv )</td>
</tr>
<tr>
<td>Mean square displacement</td>
<td>( D_a^2 = \frac{1}{V} \int_V D^2 , dv )</td>
</tr>
<tr>
<td>Line integral of displacement</td>
<td>( x = \int_L (D \cdot t) , dl )</td>
</tr>
<tr>
<td>Surface integral of strength</td>
<td>( x = \int_S (E \cdot n) , ds )</td>
</tr>
</tbody>
</table>

**For heat transfer problems:**

For the heat transfer analysis, the most interesting integral values are: the heat flux, mean volume temperature.

The following notations are used in formulas:

- **G** – vector of temperature gradient;
- **F** – vector of heat flux density;
- **T** – temperature.
<table>
<thead>
<tr>
<th>Name, ActiveFied constant</th>
<th>Formula and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat flux</td>
<td>$\Phi = \int_s (F \cdot n) ds$</td>
</tr>
<tr>
<td>qfInt_KGrad_n_ds</td>
<td>Heat flux through a particular surface.</td>
</tr>
<tr>
<td>Temperature difference</td>
<td>$\Delta T = \int_L (G \cdot t) dl$</td>
</tr>
<tr>
<td>qfInt_Grad_t_dl</td>
<td>The temperature difference between starting and ending points of a contour can be calculated as an integral over the contour of the temperature gradient.</td>
</tr>
<tr>
<td>Average surface temperature</td>
<td>$T_s = \frac{1}{S} \int_S T ds$</td>
</tr>
<tr>
<td>qfInt_Potential_ds</td>
<td></td>
</tr>
<tr>
<td>Average volume temperature</td>
<td>$T_v = \frac{1}{V} \int_V T dv$</td>
</tr>
<tr>
<td>qfInt_Potential_dv</td>
<td></td>
</tr>
<tr>
<td>Average volume temperature gradient</td>
<td>$G_a = \frac{1}{V} \int_V G dv$</td>
</tr>
<tr>
<td>qfInt_Grad_dv</td>
<td>Mean vector of temperature gradient in a volume.</td>
</tr>
<tr>
<td>Average volume heat flux density</td>
<td>$F_a = \frac{1}{V} \int_V F dv$</td>
</tr>
<tr>
<td>qfInt_KGrad_dv</td>
<td>Mean vector of heat flux density in a volume.</td>
</tr>
<tr>
<td>Average volume temperature gradient</td>
<td>$G_a^2 = \frac{1}{V} \int_V G^2 dv$</td>
</tr>
<tr>
<td>qfInt_Grad2_dv</td>
<td></td>
</tr>
<tr>
<td>Mean square heat flux density</td>
<td>$F_a^2 = \frac{1}{V} \int_V F^2 dv$</td>
</tr>
<tr>
<td>qfInt_KGrad_dv</td>
<td></td>
</tr>
</tbody>
</table>
### Line integral of heat flux density

\[ x = \int_L (\mathbf{F} \cdot \mathbf{t}) \, dl \]

### Surface integral of \( \text{grad}(T) \)

\[ x = \int_S (\mathbf{G} \cdot \mathbf{n}) \, ds \]

---

### For problems of stress analysis:

For the stress analysis problems, the most interesting integral values are: force, torque and lengthen.

The following notations are used in formulas:
- \( \sigma \) – the stress tensor.

<table>
<thead>
<tr>
<th>Name, ActiveField constant</th>
<th>Formula and Description</th>
</tr>
</thead>
</table>
| Force
qfInt_Force               | \[ \mathbf{F} = \oint_S (\sigma \cdot \mathbf{n}) \, ds \]  
Total force acting on a particular volume.  
The integral is evaluated over the boundary of the volume, and \( \mathbf{n} \) denotes the vector of the outward unit normal. |
| Torque
qfInt_Torque              | \[ \mathbf{T} = \frac{1}{2} \oint_S [\mathbf{r} \times (\sigma \cdot \mathbf{n})] \, ds \]  
Total torque of the forces acting on a particular volume,  
where \( \mathbf{r} \) is a radius vector of the point of integration.  
The torque vector is parallel to \( z \) axis in the planar case,  
and is identically equal to zero in the axisymmetric one.  
The torque is considered relative to the origin of the coordinate system.  
The torque relative to any other arbitrary point can be obtained by adding extra term of \([\mathbf{F} \times \mathbf{r}_0]\), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_0 \) is the radius vector of the point. |
Lengthen
qfInt_lengthen

\[ \Delta L = \int_L (\sigma \cdot t) dl \]

Relative lengthen of the contour.

Data Tables

QuickField can display the field data at discrete points, distributed along the currently selected contour, in table view. To open new table window, choose Table in the View menu or context (right mouse button) menu in field picture window, in which the contour is already defined.

In table view, you can:

- Select the list of shown quantities (table columns). Choose Columns in View or context menu.
- Select how the points are distributed along the contour (table rows). Choose Rows in View or context menu.
- Insert additional rows at specified distance from the beginning of the contour. Choose Insert in Edit or context menu.
- Copy the set of rows or the whole table to Windows clipboard. In latter case (when all of the rows are selected), column headers are also copied. To copy the header only, click the right mouse button within the header and choose Copy Header from the context menu.

Table Columns

To change the set of visible table columns or the contents of their headers, choose Columns from the View menu or from context (right mouse button) menu in the Table window. The Table Columns dialog appears on the screen:
The left part of the dialog window contains the list of all known columns. You choose the set of visible columns marking or clearing the check boxes in the list. Clicking on Select All or Clear All button respectively marks and clears all check boxes in the list.

The state of the check boxes in **Header Contains** defines which column identification details should be included in its header. The **Adjust Columns Width** radio button state specifies whether the width of a column should be based on the width of its data or on the width of its header.

QuickField applies these settings to all columns at once. To change the width of a single column drag the right border of the column in the table header.

**Table Rows**

To fill the table with rows of values calculated at points on a contour, choose **Rows** from the **View** menu or from context (right mouse button) menu in the Table window. The **Table Rows** dialog appears on the screen:
The dialog provides two alternative ways to tabulate the contour. You either use a fixed step between contour points or fill the required number of rows.

To use fixed step enter the step length in **Tabulating Step**.

If you mark **Always Include Segment Ends**, QuickField adds ends of all contour segments to the table starting a new step at every segment end. When you enter a value in **Tabulating Step**, QuickField shows the total number of steps in **Rows to Fill**.

When you enter the number of rows in **Rows to Fill**, QuickField interprets this value as either the required number of rows in the whole table or the required number of rows for every contour segment depending on the state of the radio button (**Total / Per Segment**) below this field.

When QuickField tabulates the contour, it uses the data in the dialog items you fill last.

You can combine automatic contour tabulation with manual addition and removal of rows via the window’s context menu.

**Plots and Tables versus Time**

QuickField provides several ways to analyze time-dependent data. You can:

- Plot the field picture for any selected time moment.
- Plot various field quantities vs. time on the time plot.
- For any given point, display the table with its field quantities versus time.
- Display the table with any quantity integrated over the current contour versus time.
- Animate the field picture reflecting its changes vs. time according to a suitable time scale.
Time Plot

For transient problems QuickField provides the means to plot time-dependent field quantities versus time. You can display both the plots of local field values at the given points and the plots of the values integrated over the current contour.

Plots of local field values can simultaneously show the curves for several field points. At the same time, such plots can show the curves for several physical quantities with the same measurement units. In cases when the measurement units differ (as with temperature, its gradient, and the heat flux), QuickField separates physical quantities into groups with same measurement units and displays one group of quantities at a time.

The plots of integrated values, on the other hand, always display only one physical quantity, with graphs of vector quantities represented as several curves displaying the quantity's coordinate values and its absolute value.

To create a new time plot, choose Time Plot in the View or context menu. The field value QuickField plots corresponds to the last point you clicked. The clicks that count are those inside the field picture window and those inside the Calculator Window.

If the last click is in the Integral Calculator the time plot displays the clicked integrated quantity. Such plots display only one quantity at a time.

In other cases, the plot displays the local value at the clicked point against time. If you did not click any point, or if the last point you clicked cannot be associated with a field value, QuickField displays an empty time plot window.

To display the curves related to different points on the same time plot, click the points one by one invoking the Time Plot command after every click. Or, to specify the exact point coordinates, invoke the View / Time Plot Curves command available from the Time Plot window, enter the coordinates, and click Add.

Alternately, you can invoke the Time Plot command via the context menu of the Field Picture window and the Time Plot Curves command via the context menu of the Time Plot window. The context menu also provides the way to easily switch the displayed time plot between different groups of local values or move from local to integrated values and back.
With time plot view, you can:

- Define the set of curves displayed for various groups of physical values. To do it, choose Time Plot Curves from the View or context menu.
- Zoom the plot in or out with toolbar buttons.
- View the legend showing the correspondence between quantities and curves.
- Copy the picture to the clipboard with Edit / Copy Picture or save it to a file with File / Save As.

**Time Plot Curves**

A time plot window can display curves for several points. In turn, for each point can have several curves for different field quantities, combined into three families: temperature, temperature gradient, and heat flux.

To add a new point, click the very first row in the list, type coordinates in the boxes above and click the Add button. When choosing a point in the list you can change its coordinates and switch on and off associated curves.

The Choose Quantity Family drop-down list at the bottom allows you to switch the displayed curve family. Alternatively you can change the family via the context menu of the time plot or the legend window.

The time plot window immediately reflects all changes in the dialog.

To add a new point, click the very first row in the table, enter the coordinates in the boxes above, and click Add. To change the coordinates
of the existing point select it in the list and enter the new values. This way you can also switch the curves associated with points on and off.

**Time Dependencies Table**

For transient problems QuickField provides the means to display time-dependent field quantities in a table where the rows correspond to different moments of time, and the columns, depending on the current mode, either to local field values at the given points or to the values integrated over the current contour of the field window.

To open the time table window, choose **Time Table** in the **View** or context menu of the field window.

The drop-down listbox in the upper left corner of the table window allows one to toggle between local and integrated quantities. The default mode of the window depends on whether its contour is defined or not. If no contour exists, the window displays local quantities (**Local values** mode). Otherwise it displays the quantities integrated over the current contour (**Integrals** mode).

In **Local values** you can change the coordinates of the point. By default, both coordinates are 0. Having changed the coordinates click **OK** to apply the changes.

In **Time Table** window you can:

- Copy the entire table or the selected rows to Windows Clipboard. To do that, select the desired rows and choose **Copy** (CTRL+C) in the **Edit** or context menu.
- Drag the selected rows to another application, like Microsoft Excel.
- When all rows in a table are selected, the table header is also included into copying and drag-n-drop operations. To select all rows in the table choose **Select All** (CTRL+A) in the **Edit** or context menu.
• Save the entire table in a text file. Choose **File / Save As**.

## Controlling the Legend Display

The legend for the color map shows the correspondence between colors and numbers; for X-Y plot — between curves and quantities.

To switch the legend display on or off, click **Legend** in the **View** or context menu of the field picture or X-Y plot window.

## Trajectories of Charged Particles

### Theoretical Background

Working on electrostatic problems you can calculate and view trajectories of charged particles in electric field. To do it, choose **Particle Trajectory** from **View** menu.

Trajectory calculation uses the following data:

- Calculated electrostatic field;
- Particle attributes: charge, mass, initial velocity or energy; Initial velocity might point outside of the calculation plane;
- Emitter attributes: coordinates (starting point of all beam trajectories), limits for the angle between initial velocity and horizontal axes, and the total number of trajectories in the beam

Viewing calculation results, you see:

- Projections of beam trajectories on the calculation plane;
- Kinematical parameters in every trajectory point;
- Velocity;
- Acceleration;
- The path length and the time spent on the way to any trajectory point.

Calculating trajectories QuickField uses following assumptions:

- There are no relativistic effects;
- Electrostatic field inside any finite element is linear relative to coordinates.
- The beam space charge field can be ignored in the equations of motion (“infinitely small current” approximation).
Distinctive emitter physical features can be ignored, so that all beam particles have the same starting point and kinetic energy.

According to these assumptions, we can describe the trajectory \((x(t), y(t), z(t))\) of a charged particle in two-dimensional electrostatic field \(\vec{E}(x, y)\) with Newton’s system of differential equations:

\[
\begin{align*}
\frac{\partial^2 x}{\partial t^2} &= \frac{q}{m} \cdot E_x(x, y) \\
\frac{\partial^2 y}{\partial t^2} &= \frac{q}{m} \cdot E_y(x, y) \\
\frac{\partial^2 z}{\partial t^2} &= 0
\end{align*}
\]

We reorganize this system of three second degree equations into six first-degree equations and append the following additional equation:

\[
\frac{dl}{dt} = \sqrt{\left(\frac{dx}{dt}\right)^2 + \left(\frac{dy}{dt}\right)^2 + \left(\frac{dz}{dt}\right)^2},
\]

defining the length \(l(t)\) of the trajectory covered by the particle in time \(t\).

We integrate the resulting system using the Runge-Kutta-Merson method with automatically defined integration step. Numerical integration stops immediately before the finite element’s boundary, the step leading outside of the element being excluded. At the last point in the element, we extrapolate the trajectory with cubical segment of its Taylor series relative to time and solve the resulting equation using Tartaglia-Cardano formula and taking into account possible decrease of the equation’s degree in homogeneous or zero fields.

**Using Trajectories**

Choosing **Particle Trajectory** from **View** menu opens the modeless dialog window that allows changing beam properties and viewing the calculation results on screen.
The property values entered into the dialog fields come into effect when you click **Apply** button.

The **Particle** dialog page allows to choose particle type from the list or define its charge and mass manually. It also provides you with the possibility to define the initial absolute value of the particle's velocity or its initial kinetic energy.

Next tab **Emitter** to specify parameters of monochromatic point emitter.

The **Number of Trajectories** field defines the total number of trajectories in the beam. The more trajectories you ask for, the longer will QuickField take to perform the calculation.
The **Source position** fields define the coordinates of the point emitter. You can either enter the coordinates manually or click the required point inside the window showing the field.

The **Angle range** fields define the limits for the angle between initial velocity vector and the horizontal axis. QuickField assumes that the angle between initial velocity vector and the plane of the model is the same for all particles in the beam.

**Stop iteration when NNNN elements passed**: the value entered into this field limits the number of finite elements the particle enters during its flight. This limitation helps to avoid infinite loops for closed trajectories.

Whenever you click the **Apply** button or click anywhere in the window showing the field, QuickField recalculates the trajectories and updates the picture.

The **Kinematic Values** tab shows calculated kinematic properties of moving particles. It shows the values related to the trajectory highlighted on screen, the one closest to the current cursor position. You can freeze highlighting of a trajectory if you move the mouse cursor holding the **SHIFT** key pressed.

The page shows the trajectory length and the total flight time along with the particle’s velocity and acceleration at the current trajectory point (marked with cross on screen). The current point follows cursor position.
Export of Field Calculation Results

In addition to many possibilities of interactive analysis of the field calculation results within QuickField package it is also possible to perform their output for further analysis with other programs.

For results output you can:

- Print field pictures, plots, tables, circuit schema and plot legend;
- Copy to clipboard any window content;
- Drag by mouse selected lines from the table, field calculator and electric circuit component list into other application, e.g. word processor or spreadsheet;
- Save the table of the field distribution along the arbitrary contour to the text file, or print it (see the Tables of the physical parameter distribution along the contour);
- Export the field distribution in the whole model area into the binary or text file.

Printing the Postprocessor Pictures

You can directly print the field picture or X-Y plot to your local or network printer, just as you see the model in the window, with the same zooming and discretization visibility.

- To print the picture, click **Print** in the **File** menu. You will have an option to choose the printer and set up the picture, such as paper size and orientation, before printing will occur.
- To preview the output before printing, click **Print Preview** in the **File** menu. To see how the picture will appear on a printer of your choice, click **Print Setup** before.

Copying the Postprocessor Pictures

You can copy the field picture or X-Y plot, as you see it in the window, to clipboard, for subsequent including it to your paper or report in any word-processing or desktop publishing utility.

- To copy the picture, click **Copy Picture** in the **Edit** menu.
- Switch to the application where you want to paste the picture and click **Paste** in the **Edit** menu, or press `SHIFT+INS`. 
Most of QuickField graphical windows may be saved into file as a vector or raster picture. Scale and content of the image will be the same, as it is shown on screen. Both raster and vector formats of picture presentation have their advantages and drawbacks. Final choice between them depends on the application, which will be used for processing the pictures exported from QuickField.

Vector images may be saved to Windows Metafile format (WMF) or Extended Windows Metafile (EMF), which is newer and better compatible with the modern Windows applications.

The list of supported raster formats includes BMP, GIF, TIFF, JPEG and PNG. Select BMP for maximum picture quality (without compression), GIF if you prefer the minimum size, JPEG or PNG as a compromise between size and quality, and TIFF for best compatibility with prepress or publishing software.

For raster formats QuickField allows to define the height and width of the resulting picture in pixels. Their default value is agreed with the actual size of the copied window. Increasing of the raster picture size requires more disk space, but provides higher quality pictures for publishing.

To save the picture into the file:

1. Select Export Picture in the File menu of the window with the picture displayed. File name and format selection dialogue will be shown.

2. Select needed File Type from the list, and set the name and location of the file in the File Name field.

3. Click OK.

4. The Picture Properties dialogue will be displayed if one of the raster formats is chosen. Here you may accept the default picture size, or redefine it by setting other height and width.

Field Export into File

In rare cases when QuickField does not provide necessary means for the problem results analysis, or the calculation results should be used as entry data for other application you may export results into the file of text or
binary format. This option is controlled by the **Field Export** command of the **File** menu.

Field Export Wizard window will display two output methods to select one of them:

- Field parameters export in the nodes of the rectangular mesh covering the entire calculation area or a part of it;
- Finite element mesh export along with the field values in each node of triangular finite elements.

### Export in rectangular grid nodes

This method allows you to control format and size of the output file. The second page of the field export wizard sets the grid sizes and steps on both abscises and ordinate axes, and composes a list of physical parameters to be output in every node of this grid. Optional file header string defines the sizes of file parts. This simplifies reading this file from other applications. Separate control affects the export procedure behavior inside the holes in the calculation area.

Third page of the Export Wizard sets the output file options, name and location.

### Export in finite element mesh nodes

If the programs that interact with QuickField are able to take into account finite-element specifics then it is most effective to put field parameters into output file along with the finite element mesh. The output format is fixed.

Output file includes information about model geometry, finite element mesh and calculated results. Full description of the output file format generated by this method is available in the Help.

An example of utility for importing QuickField output files into MATLAB® is available from [www.quickfield.com](http://www.quickfield.com).

### Additional Analysis Opportunities

Some useful tools for calculation and results analysis are included in form of optional add-ins. More details about add-ins connection and usage you may find in *Add-ins*
Field Distribution Along the Contour Harmonic Analysis

Distribution of the physical parameters along the contour may be explored by use of Fourier series analysis. This assumes that the contour drawn in the results window corresponds to the full or half period of the space distribution.

Calculation results are amplitudes and phases of the space distribution harmonics for any of physical parameters available for specific QuickField problem type. Results may be displayed as a table, spectral diagram or plot showing initial curve and its approximation by selected number of first harmonics.

Harmonic analysis add-in should be called by **Harmonic Analysis** command from the **View** menu after the contour is build in the field view window.

Further information about the harmonic analysis add-in is available in the add-in help (activated by **Help** button).

Partial Capacitance Matrix Calculation for the System of Conductors

In case the system consists of more than two conductors then its mutual affect and behavior is described by the matrix of the partial self- and mutual capacitances.

Charge of each conductor may be expressed through its own potential and potentials of other conductors by the following equations:

\[
\begin{align*}
q_1 &= b_{11} \cdot U_1 + b_{12} \cdot U_2 + \ldots + b_{1n} \cdot U_n \\
q_2 &= b_{21} \cdot U_1 + b_{22} \cdot U_2 + \ldots + b_{2n} \cdot U_n \\
&\quad \ldots \ldots \\
q_n &= b_{n1} \cdot U_1 + b_{n2} \cdot U_2 + \ldots + b_{nn} \cdot U_n,
\end{align*}
\]

(1)

where

\[q_1, q_2, \ldots q_n\] – conductor charges,
\[U_1, U_2, \ldots U_n\] – conductor potentials,
Additional Analysis Opportunities

183

$b_{ij}$ – electrostatic induction coefficients, or partial capacitances relative to ground. They have dimension of capacitance.

It is often required in practice to replace the conductors system by their equivalent circuit, where each pair of conductors is presented by the capacitors with specially fitted capacitances. This form corresponds to the system of equations (2) where the conductor charges are expressed through the potential differences between the conductor and other conductors, including earth:

\[
q_1 = c_{11}(U_1 - 0) + c_{12}(U_1 - U_2) + \ldots + c_{1n}(U_1 - U_n)
\]

\[
q_2 = c_{21}(U_2 - U_1) + c_{22}(U_2 - 0) + \ldots + c_{2n}(U_2 - U_n)
\]

\[
\ldots\ldots
\]

\[
q_n = c_{n1}(U_n - U_1) + c_{n2}(U_n - U_2) + \ldots + c_{nn}(U_n - 0)
\]

This form (2) is convenient because $c_{ij}$ coefficients are always positive and allow natural interpretation as capacitances of the equivalent circuit. $c_{ii}$ coefficient corresponds to the contribution to the conductor charge caused by its own potential, that is self-capacitance. Coefficients $c_{ij}$ where $i$ and $j$ are different correspond to the part of the $i$-conductor charge caused by the potential difference between this and $j$-conductor, which is equivalent to the capacitance of the capacitor formed by electrodes $i$ and $j$. They are called partial capacitances.

Both matrices are symmetrical, i.e. $c_{ij} = c_{ji}$.

The method for calculation of the self- and mutual partial capacitances of the conductor system is based on the electrostatic field energy.

\[
W = \frac{1}{2} \cdot (q_1 \cdot U_1 + q_2 \cdot U_2 + \ldots + q_n \cdot U_n)
\]

(3)

Use equations (1) for exclusion of the conductor charges from (3) by expressing them via potentials:

\[
W = \frac{1}{2} \cdot (U_1 \cdot (b_{11} \cdot U_1 + b_{12} \cdot U_2 + \ldots + b_{1n} \cdot U_n) +
\]

\[
U_2 \cdot (b_{21} \cdot U_1 + b_{22} \cdot U_2 + \ldots + b_{2n} \cdot U_n) +
\]

\[
\ldots\ldots
\]

\[
U_n \cdot (b_{n1} \cdot U_1 + b_{n2} \cdot U_2 + \ldots + b_{nn} \cdot U_n)
\]

);}

Coefficients $b_{ji}$ may be found by following method. First of all let us solve the series of $n$ problems, where the test potential (100 V) is applied to
only one of conductors and the rest of them are grounded (zero potential applied). Electric field energy for these cases looks like:

\[ W_i = \frac{1}{2} \cdot b_{ii} \cdot U_i^2. \]

Thereby own coefficients of the electrostatic induction could be found.

Then for each pair of conductors \((i, j)\) we should solve the problem where the test potential is applied between them, and all other conductors are grounded. Energy equation is below:

\[ W_{ij} = b_{ij} \cdot U_i \cdot U_j \]

There will be \(n(n - 1)/2\) such problems total.

Thus, to find the matrix of electrostatic induction coefficients \(b_{ij}\) in the system of \(n\) conductors it is sufficient to solve \(n(n + 1)/2\) problems. Each solution needs total electric field energy calculation. Computation of partial capacitances \(c_{ij}\) from induction coefficients \(b_{ij}\) is a simple task.

Capacitance matrix calculation add-in could be started by the command **Capacitance Matrix** from the **Tools** menu. If the electrostatic problem were open in QuickField at the moment then capacitance calculator window would be displayed. Upper part of this window is shown here:

In the problem list on the left hand side choose the problem of interest. The conductor list (right) shows labels of edges and vertices that can be considered as electrodes. Icons close to each label show the geometrical nature of the electrode (an edge or a vertex).

You could set or remove grounding from any of the conductors by a mouse click in the Info column. Partial capacitances are not calculated for grounded conductors with zero potential.

Conductor may be excluded from the calculations by a mouse click over the symbol to the left from the corresponding label. Excluded conductors
are not involved in the capacitance matrix calculation, but unlike grounded conductors, zero potential is not assigned to them.

When the conductor list is ready, click the **Calculate** button and wait for results.

List of conductors shows the conductors with the numbers assigned in the results window.

The energy calculation results for particular problems are then displayed, first in single column, and then in the upper-diagonal matrix form.

The matrix of electrostatic induction coefficient is shown next, and then the matrix of Self and mutual partial capacitances. Use the list of conductors (above) to find the correspondence between the conductor number and its label.

Any text from the results window can be copied to the clipboard (CTRL+C or the **Copy** command from the context menu).
CHAPTER 9

Working with 3D Problem

Introduction

This section includes detailed information about three-dimensional analysis with QuickField. The workflow and technique of working with 3D problems mostly relies on knowledge of 2D analysis. If you feel yourself not quite familiar with such things as material properties, boundary conditions, field sources, geometric labels and spacing and so on, we recommend first browse through chapters 2, 3, 4 and 5 of this manual as well as videos, samples, papers and other teaching material available online at www.quickfield.com.

For more than 20 years QuickField is known as an efficient tool for 2D simulation of electromagnetic, heat transfer and stress analysis problems. Engineers and researchers use 2D analysis for fast evaluation and finding the critical points in the model. It is actual now and will be used in the foreseeable future. However, sometimes 3D analysis is essential even for very rough approximation of the field distribution and model parameters. QuickField 6.0 is a first milestone on the way to 3D FEA simulation, adding 3D extrusion to familiar process of 2D model creation, and featuring full-scale 3D field analysis. In QuickField 6.1 working with 3D geometry extended with importing geometry from most CAD program via STEP format. For the present these 3D features are available for electrostatic, DC conduction and steady state heat transfer analyses only.

Workflow for 3D model definition and analysis in general follows the same steps as in 2D. You should:
• Create the new QuickField problem, and assign the model type 3D Extrusion or 3D Import.
• For the problem with model class 3D Extrusion describe the geometry in familiar Model Editor – first in XY plane, and when add the heights to all planar objects, or
• For the problem with model class 3D Import – import the geometry information from the STEP file (ISO 10303), exported from almost any 3D CAD software.
• Build automatic or manually adjusted mesh of the tetrahedral finite elements.
• Assign the text labels to all geometrical objects – bodies, faces, edges and vertices.
• Define the physical properties, boundary conditions and field sources for all labeled objects.
• Start automatic solution procedure.
• When solution is completed, 3D Postprocessor allows selecting of the most impressive 3D field presentation, getting local results and calculating integral parameters.

3D model comprises bodies with various physical properties and surrounding space. Same as in 2D case, 3D model should always be spatially confined: for open problems (where no physical boundary exists) the artificial boundary should be created at sufficient distance from the model objects.

Creating 3D Model by Extrusion

3D model of the class 3D Extrusion is based on the 2D sketch in XY plane. This sketch is same as usual geometry model for plane-parallel QuickField problem. It may be created in QuickField Model Editor. Any existing 2D plane-parallel model may be used as a sketch for creation of 3D extruded model.

QuickField converts planar XY sketch into 3D model by extruding the planar objects along Z axis, using the attribute “level”. Extrusion of the planar vertex creates the vertical edge. Extrusion of the planar edge creates a flat or cylindrical surface, which is orthogonal to XY plane. Extrusion of the planar block creates 3D body shaped as a generalized cylinder with generatrix orthogonal to the XY plane.
Every object in 2D sketch – vertex, edge or block – may be extruded several times, up or down on different levels, thus creating a layered structure. Same as in 2D case, for each 3D object the label may be assigned. Labels are required for every 3D body. For 3D surfaces, edges and vertices labels are used only if the corresponding objects should have boundary conditions (e.g. known electric potential) or field sources (electric charges). The same label assigned to different objects make them logically uniting – thus the geometry model may become richer than simple layer-cake.

Creating 3D Model by Importing from CAD

In the problems with 3D Import model class 3D model is imported from the STEP format file (ISO 10303 - the Standard for the Exchange of Product Model Data), created by the appropriate CAD program. In such problem the geometry model has standard file name extension .m3d. In the very beginning the model is empty until a geometry is imported from a STEP file.

QuickField 3D geometry import has some limitations. Imported geometry model should include only one body. If the STEP file describes several bodies, only the first one will be imported.

3D model processing starts from the QuickField problem creation with geometry class 3D Import. As usual, the problem setup requires choosing the geometry file name, in this case with the extension .m3d. Double click over the file name in the problem tree will open the model editor window in its 3D view. The button Import STEP in the 3D model editor toolbar should be clicked next. The STEP file (usually with the extension .step or .stp) should be selected and the button Open clicked then.

If required, the imported geometric objects may be complemented by the background region. The background region is often used to restrict the calculation space, set up the boundary conditions etc. It is a rectangular box, oriented on the coordinate axes. The box dimensions are automatically chosen to include all the geometrical objects with predefined gaps around. The gap is defined by the user in percent from the maximal model size.
2D and 3D problems

The choice between plane-parallel, axisymmetric or 3D formulation is performed by selecting the proper model class in the QuickField problem properties.

2D problems

Majority of QuickField analysis types are formulated as 2D, i.e. plane-parallel or axisymmetric approximations.

Plane-parallel problems

Plane-parallel approximation means that the geometry, boundary conditions, field sources, material properties and thus the calculated field depend on $X$ and $Y$ coordinates, but do not depend on the coordinate $Z$.

![Plane-parallel approximation](image)

Axisymmetric problems

Axisymmetric approximation means that the geometry, boundary conditions, field sources, material properties and thus the calculated field depend of $Z$ and $R$, but do not depend on the angular coordinate $\theta$.

![Axisymmetric approximation](image)

It means that all the half cross-sections, which include the rotational axis $X$ and positioned on one side from it, are the same (i.e. independent from the angular coordinate $\theta$).

In the screen plane we work with upper half of the axial cross section of the model
3D problems

Starting from the version 6.0 QuickField is able to solve 3D problems. Right now it is applicable to the electrostatic, DC conduction and steady state heat transfer analyses only.

In 3D problems the model geometry, material properties, field sources and/or boundary conditions may depend upon all three spatial coordinates $X$, $Y$ and $Z$.

In QuickField the 3D geometry is built by one of two ways:

- By extrusion objects from the flat $XY$ geometry into $Z$ direction. Each planar object may be extruded for specified height several times, which allows making a complicated multi layered 3D body.

This approach expands the familiar simple methods of 2D model creation into 3D. However, this implies the limitations.

- By importing 3D geometry from STEP file created by virtually any CAD program. The imported geometry may be complemented by a surrounding background area – a rectangular box at given distance of the model bounding box.

Regardless of how the three-dimensional geometry has been created, the following steps will be assigning labels to geometric objects and generating a 3D mesh. The mesh density is controlled by assigning desired the spacing values to vertices.

Problem definition – adding 3D features

Choice between 2D and 3D analysis is performed by choosing the model class in the problem properties window. For three dimensional analysis the related classes are 3D Extrusion and 3D Import. If the class 3D Import is assigned to an existent problem with another model class, its geometry information will be lost.
In contrast, if the class *3D Extrusion* is assigned to an existing 2D problem, it will be automatically converted to 3D. In this case QuickField assigns to all blocks the same pair of levels in \( Z \) direction, which is chosen equal to zero and the problem axial length \( L_Z \).

In any case, the only action required for turning on 3D features is choosing the option *3D Extrusion* or *3D Import* in the **Model class** list of the problem properties window.

The *3D Extrusion* and *3D Import* options are only available for electrostatic, DC conduction and steady state heat transfer analyses.

**Geometry model in the 3D subsystem**

The QuickField **Model Editor** is used for defining the problem geometry and creation of the finite-element mesh. It is assumed that reader of this document has some experience in 2D QuickField model creation: knows how to add the vertices and edges, can assign the labels to geometrical objects, and able to control the finite-element mesh density using Spacing.
Creating 3D Model by Extrusion

Geometry model creation in QuickField 3D subsystem (hereafter referred as 3D model) starts from the same actions as in 2D, but comparing to 2D case, it is necessary to perform following additional actions before starting the solution process:

1. Model should be linked to corresponding 3D problem. It is sufficient to have open 3D problem which refers to this model. If there is no such a problem – next steps are impossible.
2. Extrusion parameters should be prepared for each extruded 2D object.
3. 3D model should be created by extrusion of the 2D problem along the Z axis.
4. Text labels should be assigned to those of created objects which need to have specific physical properties.

3D extrusion parameters for 2D model objects

During the vertical extrusion the 2D model object – a block, edge or vertex – converts to one or several objects of the 3D model. Blocks transform into bodies, edges become vertical faces, and vertices create vertical edges.

The 2D object which is subjected to extrusion we will call the source. All horizontal sections of the 3D objects, extruded from the same 2D source are the same, and their projections to the 2D source plane coincide with this source. In other words, 3D objects extruded from the same 2D source are stacked on each other, and the boundary between these objects is the same source shifted vertically. It is clear that only parameters of this extrusion are the heights of levels, where the horizontal boundaries between the 3D extruded objects are located. When this height is defined we will say that the corresponding height level is assigned to the extrusion source.

Number of the 3D objects, extruded from the source, is always less by 1 than number of levels assigned to this source, because there is no empty vertical space between neighboring 3D objects. Therefore at least 2 height levels should be assigned to 2D objects to perform its 3D extrusion.
Note: If some height level is assigned to 2D object of positive dimension (block or edge) it is automatically assigned to all 2D objects at its boundary. Dimension of these boundary objects is always less than the dimension of the original object. For example, if the height level 10 is assigned to the edge, then both vertices at its ends are also assigned the same height level 10. If the block has the height level 0, then all the boundary edges and nodes automatically have the height level 0 assigned.

Pic. 3D extrusion parameters assignment example.

Changing of the extrusion parameters of 2D model objects

To change the extrusion parameters the geometry model properties windows should be displayed on the screen. If it is hidden, to make it visible you need to click by the left mouse button at any place within the model window, and then select Properties in the View menu.

To change the extrusion parameters for one or more objects, you need to select them. In the model properties window the group Selection will be
displayed showing all the types of selected objects (vertices, edges and/or blocks), as shown at picture below. The group **Levels** will be added to the properties of the selected objects of maximum dimension. Group **Levels** includes heights of all levels, assigned to at least one of the selected objects, and additional element **Add New Level**. Levels are always arranged with the highest value on top.

![Pic. Selected block in the 2D model and 3D problem properties window.](image)

Three types of actions may be performed with the levels:

- **Adding of a new level** – new level height may be entered in the right part of the **Add New Level** line. New value may be selected from the list which includes all height levels presented in the model at the moment, or entered manually. As a result the new level is assigned to all selected objects which did not have this level before.

- **Change the existent level height** – the current level height may be replaced by a new value. New level may be selected from the pop out list with all levels presented in the model, or entered manually. As a result the level height will be changed for all selected objects where this level is already present. New level is **not** assigned to other objects. If the new value is already assigned to some of selected objects – the duplicate level will be removed from their properties. For example if some block has height levels 1, 2 and 3, then after
changing the level 2 to 3 the block properties will include levels 1 and 3.

Taking into account that the levels are also ranked from high to low, the changed level may be put into other place in the level list than the original level.

- **Existently level removal** – to remove the level the value field should be emptied. As a result this level will be assigned to none of selected objects.

**Note:** In some cases it is impossible to remove or change the level because it is protected. This happens if the level is assigned to the object of higher dimension. For example, if the level was automatically assigned to the vertex after being set for the edge or block which include this vertex, than it may be removed or changed for this vertex only together with the same action performed for the edge or block. This change is possible only for the object which has the maximum dimension between all the neighbors (dimension of the block is 2, edge is 1 and vertex is 0). In this case the change is automatically transferred to its entire boundary. For example, if the level was assigned to the edge and was automatically spread out to its end vertices, then it may be changed only for the edge, but this change will be automatically spread to its vertices.

### Switching to 3D View

After the height levels are set, the extrusion may be performed by choosing a command 3D in the **View** menu, or by pressing the button **(Toggle 2D/3D)** in the model editor toolbar.

For successful extrusion following conditions should be met:

a. At least one block of the 2D model should have the finite-element mesh and two or more height levels assigned.

b. None of 2D model meshed blocks should have one height level assigned.

If either of these conditions is not met, error message is displayed, and if it was caused by “b” then the blocks where the condition does not work are highlighted. In case of success the bodies extruded from the blocks which satisfy “a”, and lower dimension objects at their boundaries are displayed in 3D.
Creating 3D Model by Importing

In the problems with 3D Import model class the 3D model is imported from the STEP format file (ISO 10303 - the Standard for the Exchange of Product Model Data), created by the appropriate CAD program. QuickField 3D geometry import has some limitations. Imported geometry model should include only one body. If the STEP file contains several bodies, only the first one will be imported.

3D model processing starts from the QuickField problem creation with geometry class 3D Import. As usual, the problem setup requires choosing the geometry file name, in this case with the extension .m3d. Double click on the file name in the problem tree will open the model editor window in its 3D view. The button Import STEP in the 3D model editor toolbar should be clicked next. The STEP file (usually with the extension .step or .stp) should be selected and the button Open clicked then.

Background Region

If required, the imported geometry entities may be complemented by the background region.

The background region represents the rectangular box, oriented on the coordinate axes. The background region dimensions are automatically chosen to include all the geometrical objects with the predefined gaps around. The gap is defined by the user in percent from the maximal model size.
The Background region related controls are grouped in the corresponding section of the geometry model properties window. Background region may be turned on and off, and the gap may be defined as some percent of the model size. Default gap is 50%.

If the background region is turned on, it has all properties of the geometric object. Internal cavity of the background region may be assigned a label, e.g. “air”. The faces and edges may also be labelled for the following boundary condition assigning. The background region curtains other model objects, and it is reasonable to make it transparent or hidden using the context menu.

3D View of the Model Editor

With problems of the model class 3D Import the model editor always shows 3D view. With problems of the model class 3D extrusion one can freely switch between 2D and 3D views of the model editor by toggling the 3D command in the View menu or by pressing the button Toggle 2D/3D in the model editor toolbar.
The 3D view of the model editor allows seeing 3D geometry model, assigning labels to its entities: bodies, faces, edges and vertices, setting desired mesh spacing in vertices, generating and control the 3D finite element mesh.

**Manipulation with 3D view**

3D images are used in QuickField for the geometric model 3D view and for 3D problem results analysis. Same methods are used for image manipulation in both cases.

To get the full information about 3D model geometry it is possible to:

- Look at the model from any direction (rotation);
- Move the model along the screen surface (panning);
- Increase and decrease the model scale (zooming);
- Hide the parts of the model (hiding) to see the objects behind. Also some bodies may be displayed as transparent.
- Cut the model by a plane with interactive control of the position and visibility of the cutting plane.
- Select the model elements: bodies, faces, edges, vertices.
- Control of the density of 3D mesh, by assigning desired mesh spacing.

3D view window interacts with the label list in the problem properties window:
If the object (body, face, edge, vertex) label is selected in the problem properties window, then all the respectively labeled objects will be selected in the 3D view window. And vice versa – selection of the object in the 3D view window causes its highlighting in the problem properties window.

Majority of operations with 3D view is performed by the mouse cursor movement while left or right mouse button is pressed. For some actions one or more modifier keys should be pressed on the keyboard before the mouse is moved.

Making the random transformations of the image in 3D view may easily get you lost and lose control over the model view. But it is always easy to return to one of predefined views using the camera control buttons on the toolbar.
System of the coordinate axes shown at the bottom left corner of the model window rotates together with the model and helps to understand the current model orientation:

![Coordinate axes](image)

**Image rotation, panning and zooming**

Following actions provide the full information about 3D models:

- Looking at the model components from different sides;
- Increasing and decreasing the zoom level;
- Hiding some parts of the model to see the parts behind them.

Majority of these actions may be performed by moving the mouse cursor while left or right mouse button is pressed. For some actions one or more keyboard keys should be pressed before moving the mouse.

We will call the mouse move left or right according to what mouse button has been pressed during the move.

Table. 3D view window image control using the mouse gestures

<table>
<thead>
<tr>
<th>Button pressed during the move</th>
<th>Keyboard key pressed</th>
<th>Action</th>
<th>Cursor shape</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>None</td>
<td>Model rotation in the direction of the mouse cursor move. This allows to look at the model from different sides</td>
<td><img src="image" alt="Refresh" /></td>
</tr>
<tr>
<td>Left</td>
<td>SHIFT</td>
<td>Model panning with mouse cursor.</td>
<td><img src="image" alt="Add" /></td>
</tr>
<tr>
<td>Left</td>
<td>CTRL</td>
<td>Model rotation relatively to the axis orthogonal to the screen plane</td>
<td><img src="image" alt="Zoom" /></td>
</tr>
<tr>
<td>Left</td>
<td>SHIFT + CTRL</td>
<td>Model zoom level increases or decreases with mouse cursor going up or down.</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-------------------------------------------------------------------------</td>
<td></td>
</tr>
</tbody>
</table>
| Right | None        | Rectangular frame (“rubber rectangle”) is displayed on screen and its size changes with the mouse movement. When the mouse button is released, objects inside the rectangle are selected according to following rules:  
If the ending point is TO THE LEFT from the starting point then all objects crossed by the rectangle boundary are INCLUDED into this selection.  
If the ending point is TO THE RIGHT from the starting point when all the objects crossed by the rectangle boundary are EXCLUDED from this selection. |

Mouse movements listed above allow full control over the zoom level and camera position relating the model. Besides that, there are several fixed image settings which may be switched on using the toolbar buttons.

In conclusion here is the list of all methods of the image zoom control:

1. **Mouse wheel rotation** increases the zoom level in front direction or decreases the level with backward direction. Screen position of the model point under the mouse cursor stays intact.
2. After pressing the toolbar button **Zoom in** you may click by the mouse in the model to increase the zoom level twice, or by moving the mouse with left button pressed you may draw
the rectangle on the screen, which will be stretched to occupy the full window when the mouse button is released.

3. Pressing the button **Zoom out** undoes the last zoom increase. If there is nothing to undo the zoom level will be decreased twice.

4. Button **Zoom to fit** sets the zoom level necessary to fit the full model into the window.

5. **Mouse movement with the left button and keys** `SHIFT+CTRL` **pressed** increases the zoom level if directed up, or decreases it if directed down.

6. **Keyboard commands:**

   - `CTRL +` (keys Ctrl and plus) increases the zoom level twice;
   - `CTRL -` (keys Ctrl and minus) decreases the zoom level twice;
   - `CTRL 0` (keys Ctrl and zero) scales the window to fit the full model.

### Object selection

3D geometric objects: bodies, faces, edges, vertices are displayed in the 3D window. Each of objects may be in the normal or selected state. Object selection is needed to change its properties (assign the label etc.) or hide the object to see what is hidden behind it.
Object selection may be performed by:

- Clicking over the object by the left mouse button. Object is highlighted when the mouse cursor goes over it – this helps to understand what will be selected by the mouse click. First mouse click over the face selects this face. Second mouse click over the same face selects the body which contains this face. Next consecutive clicks over the face switch the mode between face and body selection. To select several objects the button CTRL should be pressed during the mouse clicks. This cause selection of the objects of the same dimension (faces or bodies respectively).

- Mouse click over the object label in the problem tree – this action selects all the objects of this dimension which are labeled by this label.

- Group selection using the rubber rectangle. This action requires the right mouse slide.
Hidden and Transparent Bodies

Sometimes it is necessary to hide some objects to see the objects behind. Command **Hide** from the View menu or context menu (opens by the right mouse button click) hides the selected object or group of objects. Commands **Hide all** and **Hide all but this** are located in the same menus and perform the actions according to their names. Commands **Unhide** and **Unhide all** from the View menu or context menu make the hidden objects visible again.

In 3D view the body obscuring other bodies can be not only made hidden but also rendered transparently. To do that use the **Transparent** command in context menu. To cancel transparency of selected bodies use the **Opaque** command in context menu.
Transparency does not provide an opportunity to select by mouse click the body located behind a transparent body. To do this, you need to hide the obscuring body or use a cutting plane, making it invisible.

**Cutting the Model by a Plane**

It is possible to cut the model by a plane to visualize the internal cavities of the model components, which are hidden behind over objects.

To turn the cutting plane on or off click on the button **Cut by Plane** in the model editor 3D view toolbar, or use the command **Cut by Plane** in the **View** menu.

It is possible to control the position of the cutting plane by the following methods:

- Dragging the cutting plane by the mouse along the plane normal;
- Dragging normal vector to the cutting plane by the mouse;
- Selecting one of the predefined plane normal orientations along the coordinate axes in the context menu;
• Inside out command of the context menu controls what part of the cut model should be shown on the screen.

If some object cannot be viewed or selected behind the cutting plane – the plane may be hidden temporarily using the command **Hide cutting plane** in the context menu or in the **View** menu.

**Text label assignment to the 3D model objects**

Text labels should be assigned to 3D objects after the 3D model is created by the vertical extrusion.

To assign the label to some object (body, face, edge or vertex) it should be selected in the 3D model window – group **Selected** will appear in the properties window with the current label of the selected object shown in the corresponding subgroup (**Bodies, Faces, Edges** or **Vertices**).

This label may be replaced by entering the new name or by selecting it from the pull down list which includes all label names defined in this problem for the same dimension of objects. Choosing the value **(none)** in the beginning of the list removes the label from the selected object. Properties of any defined label may be checked or edited by choosing this label in the problem tree.
To assign one label to several geometrical objects, they should be selected and the label name should be entered in the subgroup of the group Selection which is related to objects of this dimension.

**Control of the Density of 3D Mesh**

3D FEA mesh in QuickField is created automatically. Mesh quality, number of elements and mesh density affect the solution time, the accuracy and amount of memory required. To achieve the balance between the accuracy and complexity the trade-off is often involved. This may be controlled by mesh density settings.

Similarly to 2D problems, mesh density control is performed by assigning the desired mesh spacing to some of the model vertices. The automatic mesh step for all those vertices where the manual mesh spacing is not set will be calculated basing on the given manual spacing.

![3D mesh example](image)

To assign the manual mesh spacing it is required to select the vertices by a mouse click, or by a rubber rectangle (see 3D objects selection), then in the model properties pane select the value *Manual* in the field **Spacing** and enter in the field **Spacing value** the mesh spacing in the current length units.

**3D Finite Element Mesh**

Finite element analysis requires the whole model space to be discretized into the closed non intersecting simple shapes – finite elements.
QuickField uses tetrahedrons of the first order as finite elements for 3D analysis.

Dividing the model region into the finite elements, or triangulation, is performed automatically. However, advanced users may define the mesh spacing and visually control the results. Importance of the mesh control is based on the fact that the accuracy of the differential equations solution by the finite element method, and cost of the solution in terms of time and memory requirements are heavily dependent on the mesh quality. Mesh density control provides the optimal balance between the solution accuracy and cost.

These are the stages of the triangulation process:

- Automatic calculation of the optimal mesh spacing in all vertices where the manual steps are not set;
- Breaking the model edges into segments (1D discretization);
- Breaking the model faces down to flat triangles (2D discretization);
- Breaking the model bodies down to tetrahedrons (3D discretization).

These four stages of the mesh generation provide the quality discretization of the model calculation region with controlled mesh density, and meshes of one, two and three dimensions are fully consistent. Model editor toolbar controls the parameters and visibility of the different dimension meshes:

If the view control button for the mesh of some dimension turns on visibility of the mesh which is not yet built, it will be created automatically. Volume mesh is easier to view using the model cut by plane.
In some cases it may be required to remove the finite element meshes of all the dimensions. Command **Remove Mesh** from the **Edit** menu allows it. If the solution process is initiated for the problem where the mesh is not yet built, mesh will be generated automatically.

**Editing material properties and boundary conditions**

In 3D problems the tree shows labels assigned to bodies, faces, edges, vertices. To edit the data associated with a label double click the label in the list.

**Solving 3D problems**

To obtain the problem solution, click the **Solve** button on the toolbar, or choose **Solve Problem** in the **Problem** menu. You may skip this action and directly proceed to the analysis results by clicking **Analyze Results** on the toolbar or in the **Problem** menu. If the problem has not been solved yet, or its results are out of date, the solver will be invoked automatically.

**Result analysis**

Problem solution in QuickField starts by choosing the command **Solve** in the **Problem** menu, or by pressing the button in the toolbar.

3D solution results may be presented in QuickField by following methods:
Different ways of the field picture display:
- Color painting of the surfaces according to the value of the chosen physical parameter,
- Geometry model presentation using the edges,
- Presenting the finite element mesh on the visible surfaces,
- Vector field plotting using scaled directed vectors,
- Scalar field plotting using small scattered color balls,
- Equipotential surfaces,
- Family of parallel slices, colored according to the value of the chosen physical parameter,
- Cut plane, which may be interactively controlled,
- 2D picture of the field view in the cut plane,
- Plot of the chosen physical parameter along the selected edge or edges.
- Local field values in the chosen point. Point may be selected by mouse or by entering the coordinates.
- Integral parameters calculated across the volume of selected bodies or along their external surface.

Calculation results window

Calculation results window is displayed after invoking the command **Field view** in the menu **Problem** or after pressing the button 🎨 in the problem toolbar.

Calculation results window contains following elements:
- Field view window with coordinate system icon and color scale;
- Upper toolbars: field view toolbar and camera toolbar.
- Field calculator panes (at the left): settings pane, local values pane and integral calculator pane

Field calculator panes are designed for numerical data input and output. In the beginning they are stacked at the left border of the results window. Whole stack of panes or any pane individually may be dragged by the mouse to any place, docked to any border or left floating. Mouse click over any of these three panes switches the calculation result window into the corresponding mode:
- Field view browsing (mouse cursor looks like 📷);
- Local values calculation for chosen point (mouse cursor turns to 📈);
- Integral values calculation across the selected bodies and their external surfaces (cursor turns to $\mathbf{J}_b$).

Besides this, the field view picture includes the 3D coordinate system icon, which turns along with the camera movement relating to the model and informs about the current orientation, and color map which shows the field parameter levels in physical units.

![Calculation results window](image)

**Result presentation modes control**

Menu **View** commands, often repeated by the toolbar icons, control the results presentation.

**Upper group of commands** switches the field calculator panes, which are stacked at the left form the field picture. There are three panes:

1. Settings pane;
2. Local values pane, and
3. Integral calculator pane
Group of panes in the middle part of menu turns the field presentation modes on and off. Most of presentations may be turned on and off independently to show the most impressive field view on a screen. Field view window opens two presentations at start: *model geometry* (shown with blue edges) and *colored surface* on visible faces, where color corresponds to the level of the physical parameter shown.

Majority of the presentations has control settings. The pane **Settings** includes all control settings grouped according to the presentation type.

![Menu View commands](image)

Pic. Menu **View** commands which control the results presentation

Group of commands in the lower part of the menu controls the visibility of the separate bodies. It is often required to hide unused parts of the model to make needed parts visible.

**Field view presentations**

Calculated field view may be shown by different graphical methods, called **presentations**. Each presentation has its own control settings.
Most presentations may be combined on the same screen picture, besides few presentations which are mutually exclusive.

Pressing the button in the field view toolbar turns the corresponding presentation on and off. Alternatively it is possible to expand the tree, controlling the chosen presentation, in the control settings and select Yes or This only for the field Show.

List of 3D field view presentations includes:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Show geometry</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Show Mesh</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Colored surfaces</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Vector plot</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Scatter plot</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Isosurface plot</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Slice plot</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Cut pane</td>
</tr>
</tbody>
</table>

In addition to 3D presentations, there are two presentations for 2D windows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>2D section</td>
</tr>
<tr>
<td>![Icon]</td>
<td>1D XY plot along the chosen edge(s)</td>
</tr>
</tbody>
</table>

To present the field clearly and informatively it is always required to adjust the picture using rotation, moving or scaling (see the Image control section) and hide the unused or covering bodies (see the Object hiding section). These actions, as well as selection of the geometrical objects in the field view window are performed same way as in the 3D view of the model editor.

Settings pane includes all control settings grouped according to the presentation types.
Pic. Field view and settings pane: model geometry, colored surfaces, vector plot, scatter plot and plane cut. Selected presentations are shown by red circles in the settings pane at the left.

Each presentation setting window includes one or more fields. The fields are positioned within a vertical column, each field takes one line. Field name is shown at the left, value is displayed at the right. Depending on the type, the value may be selected from the list, typed in or both.

The first control parameter of all presentations is the field **Show** which allows values **Yes**, **No** and **This only**. The last value keeps only this presentation and removes all others from the screen.

Other parameters of each presentation are explained in the corresponding sections below.

**Geometry elements: edges and the finite element mesh**

**Model geometry** presentation is turned on by default and displays the edges of the original geometry model. To turn the geometry on and off
there is a button in the field view toolbar. This presentation has no adjustment settings.

**Finite Element Mesh** presentation shows the finite element mesh on the visible surfaces. **Finite Element Mesh** command in the View menu or the field view toolbar button turns this presentation on and off. It does not have adjustment settings.
Colored surfaces

Colored surface presentation is turned on by default and displays the distribution of the chosen physical parameter on the visible surfaces as a color map, where every level of the physical parameter value corresponds to some color. Field view toolbar switches the colored surface presentation on and off.

Colored surface settings include:

1. Selection of the scalar physical quantity from the list. As a default parameter for electrostatic problems the electric potential $V$ is used, for thermal problems – temperature $T$ is used etc. List of alternative parameters includes the field potential, modules and coordinate components of vectors, and media properties (dielectric permeability etc.).

2. Minimum and maximum values of the parameter for the legend adjustment. Default range corresponds to the maximum and minimum parameter values in the whole calculation area.
3. Number of color grades, with 256 colors as a default.
4. Whether the legend should be displayed or not.

Pic. “Colored surface” presentation.

**Vector plot**

Vector plot shows the distribution of the vector quantity in the 3D region. Calculation region is covered by invisible uniform grid with specified step. Then in the each node of this grid the vector is drawn as a directed straight segment (arrow). Each arrow direction is agreed with the direction of the chosen vector quantity, and the length corresponds to the vector module in chosen scale. The **Vectors** command in the View menu or the button 🖼 in the field view toolbar turn the vector plot on and off.

*Note:* **Vector Plot** presentation may require considerable amount of computer resources (memory, processor time). It is thus advisable to gradually increase the parameters, which increase the load. Recommended presentation parameters are in the list.
Adjustment settings for the vector plot include:

1. List of vector physical quantities for selection.
2. Spatial step of the uniform grid, in each node of which the arrow will be drawn. If none of the three recommended values is good enough, other values may be typed in.
3. Scale level, controlling the arrow length. It is recommended to select one from the values offered. However, you may type in any other value.

To better see the “Vector plot” presentation on screen, it is recommended to turn off the “Color surface” presentation. However this is optional.

**Scatter plot**

Scatter plot is somewhat similar to the “Vector plot”, but designed to visualize the spatial distribution of the scalar quantity. Physical parameter value is shown by the color, which paints the small balls shown in the finite element mesh nodes. Scattered spheres command from the View menu or the field view toolbar button turn the scatter plot on and off.
Pic. “Scatter plot” presentation

If the number of finite elements is high, then for the nodes for scatter plot presentation are randomly selected with total number not exceeding 10 000.

Scatter plot settings include:

1. Scalar physical quantity selection from the list.
2. Sphere size. It is recommended to choose from six predefined numbers, however other numerical value may be entered.
3. Density factor, which controls the total number of spheres. It is measured in percent from the finite element mesh node number. It is recommended to choose from six predefined numbers; however other numerical value may be entered. Setting the density to 100% does not necessary mean that the ball number will be equal to finite element node number, because number of spheres cannot exceed 10 000.
4. Show or hide the color legend.

To make the “Scatter plot” more visible on the screen, it is recommended to turn off the “Color surface” presentation. Sometimes the combination of the scatter and vector plots is the most informative presentation.
**Isosurface plot**

**Isosurface plot presentation** displays the surfaces of equal potential. Surfaces could be monochromatic or color painted according to the potential values. Each of surfaces will always have a single color. The command **Isosurface plot** from the **View** menu or the button from the field view toolbar switches this presentation on or off.

Pic. “Isosurface plot” presentation

Selection of the physical quantity for isosurface plotting is not provided – it is always potential $U$ in the electric problems, temperature $T$ in the thermal problems etc.

Isosurface plot settings include:

1. Whether the surfaces should be colored according to potential values
2. Potential step $\Delta U$ between the neighboring surfaces
3. In case the color surfaces selected – whether the color legend should be shown as well.

**Model cutting with a plane, 2D field view**

**Cut plane** presentation cuts the model through by the arbitrary positioned plane. After the cut is performed, the color surfaces will be shown from one side of the plane and within the plane. Cut plane does not affect on other presentations (scatter plot, vector plot, isosurface plot etc.). The
command **Cut by plane** from the **View** menu or the button 🔄 from the field view toolbar turn the cut plane presentation on and off.

Pic. “Cut plane” presentation

“Cut plane” presentation has following specific features comparing to other presentations:

- When the presentation is turned on, interactive elements emerge on screen. Semi-transparent plane with the vector normal to it may be dragged to any direction by the mouse with left button pressed. The plane may be parallel dragged along the normal vector, and this vector may be tilted or turned around the point of intersection with the plane.
- “Cut plane” presentation should be combined with other presentations – color surface and finite element mesh – for producing informative picture on the screen.

Cut plane settings include:

1. **Normal direction** is possible to select from the list whether is it along one of coordinate axes X, Y or Z, or specify arbitrary orientation by entering three coordinates n_x, n_y, n_z of the normal vector.
2. **Distance to Origin** specifies the distance from the plane to the coordinate origin, if the normal vector is parallel to one
of coordinate axes, or thee of coordinates \( p_x, p_y, p_z \) set the position of the arbitrary point in the plane. Plane position is fully defined by the direction of the normal vector and coordinates of any point which belongs to this plane.

3. **Clip** setting controls the section which is created by the cut plane. Its value could be **No clip**, **Smooth** or **Rough**:

![Clip setting effect](image)

Pic **Clip** setting effect

4. **Show plane** settings with values **Yes/No** turn the visibility of the plane and its normal vector on and off. As a default the show plane is turned on. After the desired plane position is achieved, it is convenient to turn the show plane off, to return to usual mouse gestures control over the presentation view.

5. **Inside Out** setting with values **Yes/No** selects from what side from the cut plane the section should be shown

![Inside Out setting effect](image)

Pic. **Inside Out** setting effect.
Field picture in the cut plane

When the cut plane presentation is selected, the field picture in the section may be presented in 3D view, as it was shown in the previous paragraph, or as a 2D view in separate window. 2D field view in the cut plane window may be turned on by pressing the button in the toolbar. This button is active when the presentation “cut plane” is selected.

2D field view window is similar to 3D view window. It includes the toolbar, two panes of the field calculator stacked at the left, and a field picture window with coordinates and color legend.

Picture control principles for 2D window are the same as for 3D field view window. Image also consists from separately turned on/off presentations – model geometry, finite element mesh, colored surface and isolines plot (for the lines of equal potential).

Pic. 2D field picture in the cut plane: geometry model, colored surface and isolines.
Mouse gestures which control the field view are the same as in 3D case with obvious exceptions: model cannot be rotated, cut plane is always positioned in the screen plane.

Cut plane allows browsing the local field values similarly to how it could be done in 3D window.

The tab **Integral calculator** in the 2D window provides calculation of the integral values over the whole planar section, e.g. vector flux across the section. Surface integrals are calculated over all the visible bodies cut by the section plane.

Field distribution in the section plane may be also displayed as a plot or table. Table and plot present the field along the broken line contour consisting from one or more segments.

When the contour is ready, press one of the buttons in the toolbar to activate the plot or table window. If the table or plot window is already open, pressing the button **1D Plot** or **1D Table** changes the window content accordingly to the current contour.

**Contour for plots and tables**

Contour for making a plot or table of the field distribution is a flat broken line, built from one or more segments.

To start creating a contour click the button on the toolbox. The cursor will change its shape to a cross-hair. Click mouse button to create the initial node and then drag the mouse till the next node. Each left mouse click generates the new node. Right mouse click makes the last node. If the last node coincides with the first node, the contour will be closed polygon.

After creating the last contour node, it turns to the mode which allows dragging existent nodes by the mouse or creation new nodes on the edges. To pull the node you need to move the cursor to the node to change its color, and drag the cursor with the right mouse button pressed. Doing the same with the middle point of the contour will create a new intermediate node.
When the mouse cursor is over the contour, right mouse button click activates the context menu with contour editing commands:

Two upper commands select one of the alternative contour modes: adding new segments to the end of the broken line, or dragging the existent nodes. Next two commands remove the selected node or the whole contour.

- The contour is always directed, i.e. it is known which nodes are first and last. Contour direction may be changed using the **Change Direction** command.
- **Translate Contour** command allows dragging the contour as a whole by the mouse.

Context menu commands for the contour manipulation are also included into the **Contour** menu.

**Multiple parallel cuts – slice plot**

It is often useful to use not one, but multiple cut planes for complete field analysis. Presentation “Slice plot” is provided for such situations. Command **Parallel Slices** from the **View** menu or the button 📊 in the field view toolbar turns this presentation on and off.
Similarly to cut plane, when the “Slice plot” presentation is turned on, the interactive controls – plane and normal vector – are displayed. Manipulating with these controls adjusts the orientation of the cut slices family.

Selected physical quantity color map is shown on the parallel slices. When the slice plot presentation is turned on, color surfaces are automatically turned off to make the slices visible.

Slice plot settings include:

1. Choose of the physical quantity to be displayed as color maps on the slices. List of available choices includes all scalar quantities.
2. Show or hide the color legend.
3. Distance between the slices. Recommended values may be selected from the list, or arbitrary number may be entered.
4. **Show plane** value which may be **Yes** or **No** turns the visibility of the cut plane and normal vector on and off.
5. Two groups of fields including **Normal direction** and **Distance to Origin** control the position of the cut planes same way as corresponding settings of the **cut plane** presentation.

**Plots**

Field parameters distribution along the selected model edges or contour may be displayed in the plot. Plot window is displayed by using the command **1D XY Plot** in the **View** menu or by pressing the button ![button](image) from the field view toolbar.

The plot shows distribution of the selected physical quantity along the selected edge or the sequence of edges. The plot is automatically redrawn with the change of edge selection. Sequence of edges for plotting should form the spatial contiguous not self-crossing. The edge selection suitable for plotting should form a contiguous line without self-crossing segments. Beginning of this line may coincide with the end – no other crossings are allowed.

Toolbar above the plot area includes:

- ![zoom](image), Zoom buttons. To the left from the plot the legend pane is shown, which may be dragged to any side of the plot or left floating.
- ![legend](image) The legend pane allows selection of the physical parameter for plotting. Radio buttons provide the choice between the parameter families, expandable set of the flags turns on/off the specific parameter within the family.
- ![return](image) This button returns to the field view which is associated with this plot. If the plot is drawn along the selected edges, the button activates the 3D field view picture. If the plot is drawn along the flat contour, the button activates the 2D section window, which includes the contour.
- ![table](image) This button activates the table window, which includes the distribution of the physical parameters along the edges or contour.
Pic. XY-Plot of the electric field $\mathbf{E}$ along selected edges.

Right mouse button click activates the context menu.

**Tables**

Field parameter distribution along the selected edges or contour may be presented not only on a graph, but also as a table. Table window is activated by pressing the button in the 3D field view toolbar (table along the selected edges) or in the 2D section toolbar (table along the contour).

Table rows are related to the geometry model nodes, evenly distributed along the contour or the selected edges group. Table columns are the physical parameter values.

Table columns displayed may be modified by pressing the button in the table toolbar or in the context menu using the **Table columns** dialogue.
To specify the number of the table rows you need to press the button in the toolbar, which displays the dialogue window Table rows.

Number of the rows in the table may be defined directly, or by setting the desired space between the nodes in the model length units measured along the contour. If the contour consists from several segments, or there are several edges selected, dialogue allows defining different steps for different segments. All the segment ends are mandatory included into the table.

**Local field values calculation**

Physical field quantities calculated in the specific point are called local values.
It is required to switch on the Probing mode of the field calculator to display the local values in chosen point. This may be performed by pressing the button in the toolbar or by selecting the pane Local Values in the stack of field calculator panes, or by using the command Local Values from the View menu. This will be indicated by the cursor shape change to.

Every mouse click over the points at the model surface will lead to refreshing the coordinates and field values in the pane. Point coordinates for the local values calculation may also be manually entered into the corresponding fields of the local value pane.

In the upper part of the pane three fields X, Y and Z are prepared for entering the probing point coordinates. These fields are automatically refreshed when the mouse is clicked within the model.

**Integral calculation**

In addition to the local field values QuickField can calculate integral parameters, such as electric charge, mechanical force and electric field energy.

Integration region for the volume integrals includes the selected bodies, and for the surface integrals – the selected faces or the planar section of the 3D model.
Integration area of the surface integrals, calculated over the planar section includes the cross-sections of all the visible bodies which were cut by the plane. Turning their visibility on/off will control the integration area. Integration results are shown in the **Integral Calculator** tab of the 2D section window.

In the electrostatic problems the following integrals may be calculated:

- **Total electric charge in a particular volume**

  \[ q = \oint_D \mathbf{D} \cdot d\mathbf{s} \]

  where integral is evaluated over the boundary of the volume, and \( \mathbf{n} \) denotes the vector of the outward unit normal.

- **Total electric force acting on bodies contained in a particular volume**

  \[ \mathbf{F} = \frac{1}{2} \oint (\mathbf{E} \cdot \mathbf{n}) + \mathbf{D} (\mathbf{n} \cdot \mathbf{E}) - \mathbf{n} (\mathbf{E} \cdot \mathbf{D})) d\mathbf{s} \]

- **Energy of electric field**

  \[ w = \frac{1}{2} \int \mathbf{E} \mathbf{D} \cdot d\mathbf{v} \]

In the DC conduction problems the following integrals may be calculated:

- **Electric current through a particular surface**

  \[ I = \oint \mathbf{J} \cdot d\mathbf{s} \]

  where integral is evaluated over the boundary of the volume.

In the steady state heat transfer problems the following integrals may be calculated:

- **Heat flux through a particular surface**

  \[ \Phi = \oint \lambda \cdot \nabla T \cdot d\mathbf{s} \]

  where integral is evaluated over the boundary of the volume.
Integral calculation mode may be turned on by pressing the button $\int ds$ on the toolbar, or by selecting the pane **Integral Calculator** from the field calculator dialog, or by using the command **Integral Values** from the **View** menu. This mode is indicated by the cursor shape.

All available by the moment integral values are calculated by integration across the selected bodies (or their external surfaces). All changes in this selection invoke automatic calculation of the new integral values.
Add-in is a supplemental program or component that extends the capabilities of QuickField by adding custom features, such as custom menu items, toolbar buttons etc.

To view the list of add-ins available on your computer:

1. On the Tools menu click Add-in Manager.…
2. You will see the list of available add-ins. To get more information about some add-in, select it in the list. You will see its description in the box below the list.

Add-ins can be switched on and off. You can switch an add-in off if you do not plan to use it for some time. Switching an add-in off does not remove it from your computer; you can switch it on later.
To switch add-ins on or off:

1. On the **Tools** menu click **Add-in Manager**…
2. To switch an add-in on, select the check box next to its name.
3. To switch an add-in off, clear the check box next to its name.
4. Click **OK**.

**Add-ins Available in QuickField**

The following add-ins are supplied with QuickField:

**Insert Shape.** A simple tool that allows adding common shapes (rectangles, circles and ellipses) to your model.

**LabelMover.** A simple tool for parametric analysis. This tool allows you to study how the problem solution depends on changes of the model geometry or of the problem physical properties.

Various types of analysis are provided: serial analysis, tolerance analysis and optimization.

**Harmonic Analysis.** This add-in allows you to calculate and view harmonics (that is, phases and amplitudes for Fourier series) for any value for the current contour.

**Capacitance Matrix.** Automatically calculates the self- and mutual capacitances for a system with multiple conductors using a number of electrostatic analyses.

**Advanced Add-in Features**

**Adding, Editing and Deleting Add-ins**

There are some more advanced operations that you can do using **Add-in Manager** dialog box.

- You can register your own program or component as an add-in. To do it, click **Add** and use the **Add-in Properties** dialog box to specify the properties.
- You can change properties for an add-in, menu text, shortcut, toolbar icon etc. To do it, select an add-in, click **Edit** and use the **Add-in Properties** dialog box to change some properties.
• You can remove an add-in from the list of or available add-ins. To
do it, select an add-in and click **Delete**. Removing add-in from the
list does not delete the add-in file from your disk.

These features are typically used only when you create your own add-ins.
If you deal with standard QuickField add-ins only, you will not have to
use these features.

**Creating Your Own Add-ins**

You can easily create your own add-ins, using Visual Basic or any other
programming product that supports COM (C#, Visual C++, Delphi etc.).

With such add-ins, you can automate some of your tedious repeating tasks
and make your interaction with QuickField more effective and
convenient.

For more information about writing your own add-ins, see
**Creating Add-ins** in ActiveField help.

**Add-in Properties Dialog Box**

In this dialog you can specify the following fields:

**General Properties**

**Type.** Choose one of two variants: Simple COM Add-In or EXE Add-In.
If *Simple COM Add-In* is selected, add-in will be called from QuickField
using COM. So, this add-in should be a COM server. If *EXE Add-In* is
selected, you can use any EXE file as an add-in. QuickField start this EXE
file each time you click the corresponding menu item.

**Name of the COM object for the add-in** or **Command line to call the
add-in.** Specify the object name for COM add-in here. For EXE add-in,
specify the command line to invoke the add-in. Typically, it is the full
path to the add-in *.exe* file.
Menu items attached to this add-in. This box contains the list of menu items attached to the add-in. Typically, one menu item is attached to every add-in. However, for more advanced add-ins, you can associate several menu items with one add-in.

- To add a menu item, click Add Item.
- To delete a menu item, click Delete.
- To change menu item properties, click Edit.

Description Properties

Friendly name. It is recommended to specify a readable name here for add-in.

Description. It is recommended to provide detailed description of the add-in here.
Add-in Menu Item Dialog Box

In this dialog you can specify the following fields:

**Menu should be available.** Choose one of the following options:

- **Always** - menu item will be always available.
- **In model editor** - menu item will be available for model editor only.
- **In postprocessor** - menu item will be available for postprocessor only (that is, when we are viewing results only).

**Menu text.** Specify text for menu item here.

**Menu.** You can choose the menu this item will be added to.

**Status line.** In this field you can describe what this item does. This description will be shown in a status line for the item.

**Show in popup menu.** If this check box is selected, the menu item will also be added to context (right mouse button) menu.

**Show in toolbar as icon.** If this check box is selected, the menu item will also be available from the toolbar. You can choose icon for the toolbar button from the drop-down list next to the check box.

**Press a shortcut key.** You can set a shortcut for the menu item using this field.
CHAPTER 11

Theoretical Description

The objective of this chapter is to outline the theories on which the QuickField finite element analysis system is based. The chapter contains underlying mathematical equations, and considers various physical conditions and the ways how they are implemented in QuickField.

QuickField solves two-dimensional (2D) boundary value problems for elliptic partial differential equation for either scalar or one-component vector potential. It also solves 2D solid stress analysis problems (plane stress, plane strain, axisymmetric stress). There are three main classes of 2D problems: plane, plane-parallel and axisymmetric. Plane problems usually arise when describing heat transfer processes in thin plates. They are solved in planar rectangular coordinate system. Plane-parallel problems use right-handed Cartesian coordinate system \(xyz\). It is assumed that neither geometric shape and properties of material nor field sources vary in \(z\)-direction. The problem is described, solved and the results are analyzed in \(xy\)-plane, which we will call the **plane of model**. Axisymmetric problems are formulated in cylindrical coordinate system \(zr\theta\). The order of axes is chosen for conformity with the plane-parallel case. Physical properties and field sources are assumed to not depend on the angle coordinate. All operations with the model are done in \(zr\)-plane (more precise in a half plane \(r \geq 0\)). \(Z\)-axis is assumed to be horizontal and directed to the right, \(r\)-axis is directed up.

The geometric configuration of the problem is defined as a set of curved polygonal subregions in the plane of model. Each region corresponds to a domain with a particular set of physical properties. We will use term **blocks** for polygonal subregions, term **edges** for line segments and circular arcs that constitute their boundaries and term **vertices** for ends of edges and for isolated points. Those edges that separate whole problem region from other part of the plane, where no field is calculated,
Magnetostatics constitutes the *outward* boundary of the region. Other edges constitute *inner* boundaries.

Below you can find detailed mathematical formulations for dc, ac and transient magnetic, electrostatic, dc and ac conduction, steady state and transient heat transfer, and stress analysis problems.

**Magnetostatics**

QuickField can solve both linear and nonlinear magnetic problems. Magnetic field may be induced by the concentrated or distributed currents, permanent magnets or external magnetic fields.

The magnetic problem is formulated as the Poisson's equation for vector magnetic potential \( \mathbf{A} \) (\( \mathbf{B} = \text{curl} \ \mathbf{A} \), \( \mathbf{B} \)—magnetic flux density vector). The flux density is assumed to lie in the plane of model (xy or zr), while the vector of electric current density \( \mathbf{j} \) and the vector potential \( \mathbf{A} \) are orthogonal to it. Only \( j_z \) and \( A_z \) in planar or \( j_\theta \) and \( A_\theta \) in axisymmetric case are not equal to zero. We will denote them simply \( j \) and \( A \). The equation for planar case is

\[
\frac{\partial}{\partial x} \left( \frac{1}{\mu_y} \frac{\partial A}{\partial x} \right) + \frac{\partial}{\partial y} \left( \frac{1}{\mu_x} \frac{\partial A}{\partial y} \right) = -j + \left( \frac{\partial H_{cy}}{\partial x} - \frac{\partial H_{cx}}{\partial y} \right);
\]

and for axisymmetric case is

\[
\frac{\partial}{\partial r} \left( \frac{1}{r \mu_z} \frac{\partial (rA)}{\partial r} \right) + \frac{\partial}{\partial z} \left( \frac{1}{\mu_r} \frac{\partial A}{\partial z} \right) = -j + \left( \frac{\partial H_{cr}}{\partial z} - \frac{\partial H_{cz}}{\partial r} \right).
\]

where components of magnetic permeability tensor \( \mu_x \) and \( \mu_y \) (\( \mu_z \) and \( \mu_r \)), components of coercive force vector \( H_{cx} \) and \( H_{cy} \) (\( H_{cz} \) and \( H_{cr} \)), and current density \( j \) are constants within each block of the model.

*Note.* Isotropic (\( \mu_x = \mu_y \) or \( \mu_z = \mu_r \)) but field dependent permeability is assumed in nonlinear case. Magnetization characteristic of material is described by the \( B-H \) curve.

**Field Sources**

The field sources can be specified in blocks, at the edges or at the individual vertices of the model. Possible field sources include space,
surface and linear electric currents and permanent magnets. The coercive force is chosen to be primary characteristic for the permanent magnets.

A point source in the $xy$-plane describes a linear current in out-of-plane direction. In axisymmetric case the point source represents the current in a thin ring around the axis of symmetry. Edge-bound source in the plane of model represents a surface current in three-dimensional world. It is specified by the Neumann boundary condition for the edge. The space current is described either by the electric current density or total number of ampere-turns associated with the block density associated with the block. Current density in a coil can be obtained from the equation

$$j = n \cdot \frac{I}{S},$$

where $n$ is a number of turns, $I$ is a total current, and $S$ is a cross-sectional area of the coil.

Several blocks with the same number of ampere-turns specified can be considered as connected in series. In that case current density in each block would be calculated as common total ampere-turns divided by the square of the block.

In axisymmetric case if total number of ampere-turns is specified resulting current density could be described as varies as $\sim(1/r)$, where $r$ is a radius coordinate of the point. This approach allows simulate massive spiral coils.

**Boundary Conditions**

The following boundary conditions can be specified at outward and inner boundaries of the region.

**Dirichlet condition** specifies a known value of vector magnetic potential $A_0$ at the vertex or at the edge of the model. This boundary condition defines normal component of the flux density vector. It is often used to specify vanishing value of this component, for example at the axis of symmetry or at the distant boundary. QuickField also supports the Dirichlet condition with a function of coordinates. This approach allows you to model a uniform external field by specifying non-zero normal component of the flux density at arbitrary straight boundary segment.
Note. For problem to be defined correctly the Dirichlet condition has to be specified at least at one point. If the region consists of two or more disjoint subregions, the Dirichlet conditions have to be specified at least at one point of each part. Zero Dirichlet condition is defaulted at the axis of rotation for the axisymmetric problems.

**Neumann condition** has the following form

\[ H_t = \sigma \]  
— at outward boundaries,

\[ H_t^+ - H_t^- = \sigma \]  
— at inner boundaries,

where \( H_t \) is a tangent component of magnetic field intensity, "+" and "−" superscripts denote quantities to the left and to the right side of the boundary and \( \sigma \) is a linear density of the surface current. If \( \sigma \) value is zero, the boundary condition is called homogeneous. This kind of boundary condition is often used at an outward boundary of the region that is formed by the plane of magnetic antisymmetry of the problem (opposite sources in symmetrical geometry). The homogeneous Neumann condition is the natural one, it is assumed by default at all outward boundary parts where no explicit boundary condition is specified.

Note. Zero Dirichlet condition is defaulted at the axis of rotation for the axisymmetric problems.

If the surface electric current is to be specified at the plane of problem symmetry and this plane forms the outward boundary of the region, the current density has to be halved.

**Zero flux boundary condition** is used to describe superconducting materials that are not penetrated by the magnetic field. Vector magnetic potential is a constant within such superconducting body \((rA = \text{const})\) in axisymmetric case, therefore superconductor's interior can be excluded from the consideration and the constant potential condition can be associated with its surface.

Note. If the surface of a superconductor has common points with any Dirichlet edge, the whole surface has to be described by the Dirichlet condition with an appropriate potential value.
Permanent Magnets

Since the coercive force is considered in QuickField to be the piecewise constant function, its contribution to the equation is equivalent to surface currents which flow along the surface of the permanent magnet in direction orthogonal to the model plane. The density of such effective current is equal to jump of the tangent component of the coercive force across the magnet boundary. For example, rectangular magnet with the coercive force $H_c$ directed along $x$-axis can be replaced by two oppositely directed currents at its upper and lower surfaces. The current density at the upper edge is numerically equal to $H_c$, and $-H_c$ at the lower edge.

Therefore, the permanent magnet can be specified by either coercive force or Neumann boundary conditions at its edges. You can choose more convenient and obvious way in each particular case.

Permanent magnet with nonlinear magnetic properties needs some special consideration. Magnetic permeability is assumed to be defined by the following equation:

$$B = \mu(B) \cdot (H + H_c); \quad \mu(B) = \frac{B}{H + H_c}$$

It must be pointed out that $\mu(B)$ dependence is different from the analogous curve for the same material but without permanent magnetism. If the real characteristic for the magnet is not available for you, it is possible to use row material curve as an approximation. If you use such approximation and magnetic field value inside magnet is much smaller than its coercive force, it is recommended to replace the coercive force by the following effective value

$$H'_c = \frac{1}{\mu(B_r)} B_r$$

where $B_r$ is remanent induction.

Calculated Physical Quantities

For magnetostatic problems the QuickField postprocessor calculates the following set of local and integral physical quantities.

Local quantities:

- Vector magnetic potential $A$ (flux function $rA$ in axisymmetric case);
• Vector of the magnetic flux density \( \mathbf{B} = \text{curl} \mathbf{A} \)

\[
B_x = \frac{\partial A_y}{\partial y}, \quad B_y = -\frac{\partial A_x}{\partial x} \quad \text{— for planar case;}
\]

\[
B_z = \frac{1}{r} \frac{\partial (rA)}{\partial r}, \quad B_r = -\frac{\partial A_z}{\partial z} \quad \text{— for axisymmetric case;}
\]

• Vector of magnetic field intensity

\[
\mathbf{H} = \frac{1}{\mu} \mathbf{B},
\]

where \( \mu \) is the magnetic permeability tensor.

Integral quantities:

• Total magnetic force acting on bodies contained in a particular volume

\[
\mathbf{F} = \frac{1}{2} \oint_S \left( \mathbf{H}(\mathbf{n} \cdot \mathbf{B}) + \mathbf{B}(\mathbf{n} \cdot \mathbf{H}) - \mathbf{n}(\mathbf{H} \cdot \mathbf{B}) \right) ds,
\]

where integral is evaluated over the boundary of the volume, and \( \mathbf{n} \) denotes the vector of the outward unit normal.

• Total torque of magnetic forces acting on bodies contained in a particular volume

\[
\mathbf{T} = \frac{1}{2} \oint S \left( [\mathbf{r} \times \mathbf{H}](\mathbf{n} \cdot \mathbf{B}) + [\mathbf{r} \times \mathbf{B}](\mathbf{n} \cdot \mathbf{H}) - [\mathbf{r} \times \mathbf{n}](\mathbf{H} \cdot \mathbf{B}) \right) ds,
\]

where \( \mathbf{r} \) is a radius vector of the point of integration.

The torque vector is parallel to \( z \)-axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \( \mathbf{F} \times \mathbf{r}_0 \), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_0 \) is the radius vector of the point.

• Magnetic field energy
\[ W = \frac{1}{2} \int_V (\mathbf{H} \cdot \mathbf{B}) dv \] — linear case;

\[ W = \int \left( \int_{B'} H(B') dB' \right) dv \] — nonlinear case.

- Flux linkage per one turn of the coil

\[ \Psi = \frac{\Phi Ads}{S} \] — for planar case;

\[ \Psi = \frac{2\pi \Phi (rA) ds}{S} \] — for axisymmetric case.

the integral has to be evaluated over the cross section of the coil, and 
\( S \) is the area of the cross section.

For planar problems all integral quantities are considered per unit length
in \( z \)-direction.

The domain of integration is specified in the plane of the model as a
closed contour consisting of line segments and circular arcs.

### Inductance Calculation

To get self inductance of a coil, leave the current on in this coil only and
make sure that all other currents are turned off. After solving the problem

go to the Postprocessor and obtain flux linkage for the contour coinciding
with the cross section of the coil. Once you’ve done that, the inductance
of the coil can be obtained from the following equation:

\[ L = \frac{n\Psi}{I}, \]

where \( n \) is a number of turns in the coil, \( \Psi \) is a flux linkage, \( j \) is a current
per one turn of the coil.

Mutual inductance between two coils can be obtained in a similar way.
The only difference from the previous case is that electric current has to
be turned on in one coil, and the flux linkage has to be evaluated over the
cross section of another.
\[ L_{12} = \frac{n_2 \Psi_2}{I_1}, \]

In plane-parallel case every coil has to be represented by at least two conductors with equal but opposite currents. In some cases both conductors are modeled, in other cases only one of two conductors is included in the model and the rest is replaced by the boundary condition \( A = 0 \) at the plane of symmetry. If the magnetic system is symmetric, the inductance can be obtained based on the flux linkage for one of the conductors only. The result has to be then multiplied by a factor of two to account for the second conductor. If the model is not symmetric, then the total inductance can be obtained by adding up the analogous terms for each conductor. Note that the current should be turned on in all conductors corresponding to one coil.

In plane-parallel case the inductance is calculated per unit length in \( z \)-direction.

**Transient Magnetics**

Transient magnetic analysis is the generalized form of computation of electric and magnetic field, induced by direct or time-varying currents (alternating, impulse, etc.), permanent magnets, or external magnetic fields, in linear or nonlinear (ferromagnetic) media, and takes into account eddy current (skin) effect in conductors of electric current.

The formulation is derived from Maxwell's equations for vector magnetic potential \( A \) (\( B = \text{curl} \ A \)) and scalar electric potential \( U \) (\( E = -\text{grad} \ U \)):

\[
\text{curl} \frac{1}{\mu} \text{curl} A = j + \text{curl} H_c,
\]

\[
j = \sigma E = -\sigma \frac{\partial A}{\partial t} - \sigma \cdot \text{grad} U
\]

where \( 1/\mu \) is an inverse permeability tensor, and \( \sigma \) is electric conductivity. In accordance with the second equation, vector \( j \) of the total current in a conductor can be considered as a combination of a source current produced by the external voltage and an eddy current induced by the time-varying magnetic field

\[
j = j_0 + j_{\text{eddy}},
\]

where
\( \mathbf{j}_0 = - \sigma \cdot \nabla U, \)

\( \mathbf{j}_{\text{eddy}} = -\sigma \frac{\partial \mathbf{A}}{\partial t}. \)

If a field simulation is coupled with an electric circuit, the branch equation for a conductor is:

\[ I = \frac{U}{R} - \sigma \int_{\Omega} \frac{\partial \mathbf{A}}{\partial t} \, ds \]

where \( U \) is the voltage difference between the two terminals of the solid conductor, and \( R \) is the DC resistance of the conductor.

The flux density is assumed to lie in the plane of model (\( xy \) or \( zr \)), while the vector of electric current density \( \mathbf{j} \) and the vector potential \( \mathbf{A} \) are orthogonal to it. Only \( j_z \) and \( A_z \) in planar or \( j_0 \) and \( A_0 \) in axisymmetric case are not equal to zero. We will denote them simply \( j \) and \( A \). Finally, the equation for planar case is

\[ \frac{\partial}{\partial x} \left( \frac{1}{\mu_y} \frac{\partial A}{\partial x} \right) + \frac{\partial}{\partial y} \left( \frac{1}{\mu_x} \frac{\partial A}{\partial y} \right) - \sigma \frac{\partial A}{\partial t} = -j_0 + \left( \frac{\partial H_{cy}}{\partial x} - \frac{\partial H_{cx}}{\partial y} \right), \]

and for axisymmetric case is

\[ \frac{\partial}{\partial r} \left( \frac{1}{r \mu_z} \frac{\partial (rA)}{\partial r} \right) + \frac{\partial}{\partial z} \left( \frac{1}{\mu_r} \frac{\partial A}{\partial z} \right) - \sigma \frac{\partial A}{\partial t} = -j_0 + \left( \frac{\partial H_{cr}}{\partial z} - \frac{\partial H_{cz}}{\partial r} \right), \]

where components of magnetic permeability tensor \( \mu_x \) and \( \mu_y \) (\( \mu_z \) and \( \mu_r \)), components of coercive force vector \( H_{cx} \) and \( H_{cy} \) (\( H_{cz} \) and \( H_{cr} \)) are constants within each block of the model. Source current density \( j_0 \) is assumed to be constant within each model block in planar case and vary as \( 1/r \) in axisymmetric case.

**Note.** Isotropic (\( \mu_x = \mu_y \) or \( \mu_z = \mu_r \)) but field dependent permeability is assumed in nonlinear case. Magnetization characteristic of material is described by the \( B-H \) curve.

In time domain, the problem is solved within a given time interval, starting with time \( t_0 = 0 \), and initial field distribution is considered to be zero in the whole region, or can be imported from another problem (magnetostatics or transient).
Field Sources

The field sources can be specified in blocks, at the edges or at the individual vertices of the model. Possible field sources include space, surface and linear electric currents; voltages applied to conductive areas; and permanent magnets. The coercive force is chosen to be primary characteristic for the permanent magnets.

A point source in the xy-plane describes a linear current in out-of-plane direction. In axisymmetric case the point source represents the current in a thin ring around the axis of symmetry. Edge-bound source in the plane of model represents a surface current in three-dimensional world. It is specified by the Neumann boundary condition for the edge.

The space-distributed current is defined differently in areas, where the eddy current effect is considered (non-zero conductivity is specified) or not considered (conductivity is set to zero). In latter case, the space current is described either by the electric current density or total number of ampere-turns associated with the block density associated with the block. Current density in a coil can be obtained from the equation

\[ j = n \cdot I / S, \]

where \( n \) is a number of turns, \( I \) is a total current, and \( S \) is a cross-sectional area of the coil.

Several blocks with the same number of ampere-turns specified can be considered as connected in series. In that case current density in each block would be calculated as common total ampere-turns divided by the square of the block.

In axisymmetric case if total number of ampere-turns is specified resulting current density could be described as varies as \( 1/r \), where \( r \) is a radius coordinate of the point. This approach allows simulate massive spiral coils.

In a massive conductor, you specify a voltage applied to the conductor. In planar problems, voltage drop is specified per unit depth of the model, and in axisymmetric case voltage is assumed per one turn around the axis of symmetry. Nonzero voltage applied to a conductor in axisymmetric problem means that the conductor has a radial cut, and the voltage is applied to sides of the cut. In practice this option could be used to describe known voltage applied to massive spiral wiring, in which case the total
voltage drop for the coil should be divided by number of turns in the coil. Zero voltage means that the conductor’s ends are short circuit.

Any voltage or current sources, specified for a massive (solid) conductor, are ignored when the electric circuit is present. In this case, you can specify time-dependent voltage and current sources while editing the circuit.

Voltage, current, or the current density can be specified as arbitrary function of time. This allows you to perform analysis of any possible type of time-varying sources – periodic or not.

**Boundary Conditions**

The following boundary conditions can be specified at outward and inner boundaries of the region.

**Dirichlet condition** specifies a known value of vector magnetic potential $A_0$ at the vertex or at the edge of the model. This boundary condition defines normal component of the flux density vector. It is often used to specify vanishing value of this component, for example at the axis of symmetry or at the distant boundary. QuickField also supports the Dirichlet condition with a function of coordinates. This approach allows you to model a uniform external field by specifying non-zero normal component of the flux density at arbitrary straight boundary segment.

*Note.* For problem to be defined correctly the Dirichlet condition has to be specified at least at one point. If the region consists of two or more disjoint subregions, the Dirichlet conditions have to be specified at least at one point of the each part. Zero Dirichlet condition is defaulted at the axis of rotation for the axisymmetric problems.

**Neumann condition** has the following form

\[
H_t = \sigma \quad \text{— at outward boundaries,}
\]

\[
H_t^+ - H_t^- = \sigma \quad \text{— at inner boundaries,}
\]

where $H_t$ is a tangent component of magnetic field intensity, "+" and "−" superscripts denote quantities to the left and to the right side of the boundary and $\sigma$ is a linear density of the surface current. If $\sigma$ value is zero,
the boundary condition is called homogeneous. This kind of boundary condition is often used at an outward boundary of the region that is formed by the plane of magnetic antisymmetry of the problem (opposite sources in symmetrical geometry). The homogeneous Neumann condition is the natural one, it is assumed by default at all outward boundary parts where no explicit boundary condition is specified.

*Note.* Zero Dirichlet condition is defaulted at the axis of rotation for the axisymmetric problems.

If the surface electric current is to be specified at the plane of problem symmetry and this plane forms the outward boundary of the region, the current density has to be halved.

**Zero flux boundary condition** is used to describe superconducting materials that are not penetrated by the magnetic field. Vector magnetic potential is a constant within such superconducting body \((rA = consi\) in axisymmetric case), therefore superconductor's interior can be excluded from the consideration and the constant potential condition can be associated with its surface.

*Note.* If the surface of a superconductor has common points with any Dirichlet edge, the whole surface has to be described by the Dirichlet condition with an appropriate potential value.

### Permanent Magnets

Since the coercive force is considered in QuickField to be the piecewise constant function, its contribution to the equation is equivalent to surface currents which flow along the surface of the permanent magnet in direction orthogonal to the model plane. The density of such effective current is equal to jump of the tangent component of the coercive force across the magnet boundary. For example, rectangular magnet with the coercive force \(H_c\) directed along \(x\)-axis can be replaced by two oppositely directed currents at its upper and lower surfaces. The current density at the upper edge is numerically equal to \(H_c\), and \(-H_c\) at the lower edge.

Therefore, the permanent magnet can be specified by either coercive force or Neumann boundary conditions at its edges. You can choose more convenient and obvious way in each particular case.
Permanent magnet with nonlinear magnetic properties needs some special consideration. Magnetic permeability is assumed to be defined by the following equation

\[ B = \mu(B) \cdot (H + H_c); \quad \mu(B) = \frac{B}{H + H_c} \]

Please note that \( \mu(B) \) dependence is different from the analogous curve for the same material but without permanent magnetism. If the real characteristic for the magnet is not available for you, it is possible to use row material curve as an approximation. If you use such approximation and magnetic field value inside magnet is much smaller than its coercive force, it is recommended to replace the coercive force by the following effective value

\[ H'_c = \frac{1}{\mu(B)} B_r \]

where \( B_r \) is remanent induction.

**Calculated Physical Quantities**

For problems of transient magnetics, QuickField postprocessor calculates the following set of local and integral physical quantities. These quantities can be observed at any given moment of time in the transient process.

Local quantities:
- Vector magnetic potential \( A \) (flux function \( rA \) in axisymmetric case);
- Voltage \( U \) applied to the conductor;
- Total current density \( j = j_0 + j_{\text{eddy}} \), source current density \( j_0 \) and eddy current density

\[ j_{\text{eddy}} = -\sigma \frac{\partial A}{\partial t} \]

- Vector of the magnetic flux density \( \mathbf{B} = \text{curl} \ A \)

\[ B_x = \frac{\partial A}{\partial y}, \quad B_y = -\frac{\partial A}{\partial x} \quad \text{— for planar case;} \]

\[ B_z = \frac{1}{r} \cdot \frac{\partial (rA)}{\partial r}, \quad B_r = -\frac{\partial A}{\partial z} \quad \text{— for axisymmetric case;} \]
- Vector of magnetic field intensity
  \[ \mathbf{H} = \frac{1}{\mu} \mathbf{B}, \]
  where \( \mu \) is the magnetic permeability tensor.

- Joule heat density
  \[ Q = \frac{1}{\sigma} j^2 \]

- Magnetic field energy density \( w = (\mathbf{B} \cdot \mathbf{H})/2; \)

- Magnetic permeability \( \mu \) (its largest component in anisotropic media);

- Electric conductivity \( \sigma \).

Integral quantities:

- Electric current through a particular surface
  \[ I = \int j \, ds \]
  and its source \( I_0 \) and eddy \( I_e \) components.

- Joule heat in a volume
  \[ P = \int \frac{1}{\sigma} j^2 \, dv \]

- Total magnetic force acting on bodies contained in a volume
  \[ \mathbf{F} = \frac{1}{2} \oint_S \left( \mathbf{H}(\mathbf{n} \cdot \mathbf{B}) + \mathbf{B}(\mathbf{n} \cdot \mathbf{H}) - \mathbf{n}(\mathbf{H} \cdot \mathbf{B}) \right) ds, \]
  where integral is evaluated over the boundary of the volume, and \( \mathbf{n} \) denotes the vector of the outward unit normal.

- Total torque of magnetic forces acting on bodies contained in a volume
  \[ \mathbf{T} = \frac{1}{2} \oint_S \left( [\mathbf{r} \times \mathbf{H}](\mathbf{n} \cdot \mathbf{B}) + [\mathbf{r} \times \mathbf{B}](\mathbf{n} \cdot \mathbf{H}) - [\mathbf{r} \times \mathbf{n}](\mathbf{H} \cdot \mathbf{B}) \right) ds, \]
  where \( \mathbf{r} \) is a radius vector of the point of integration.

The torque vector is parallel to \( z \)-axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is
considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of $F \times r_0$, where $F$ is the total force and $r_0$ is the radius vector of the point.

- Magnetic field energy

$$W = \frac{1}{2} \int_V (\mathbf{H} \cdot \mathbf{B}) dv$$ — linear case;

$$W = \int \left( \int_0^B H(B') dB' \right) dv$$ — nonlinear case.

- Flux linkage per one turn of the coil

$$\Psi = \oint_A ds$$ — for planar case;

$$\Psi = \frac{2\pi \oint (rA) ds}{S}$$ — for axisymmetric case.

the integral has to be evaluated over the cross section of the coil, and $S$ is the area of the cross section.

For planar problems, all integral quantities are considered per unit length in $z$-direction.

The domain of integration is specified in the plane of the model as a closed contour consisting of line segments and circular arcs..

**AC Magnetic**

AC magnetic analysis is the study of magnetic and electric fields arising from the application of an alternating (AC) current source, or an imposed alternating external field.

Variation of the field with respect to time is assumed to be sinusoidal. All field components and electric currents vary with time like

$$z = z_0 \cos(\omega t + \phi_z),$$
where \( z_0 \) is a peak value of \( z \), \( \phi_z \) — its phase angle, and \( \omega \) — the angular frequency.

Complex representation of harmonic time dependency facilitates multiple phase analysis based on one complex solution. Real and imaginary parts of a complex quantity

\[
z = z_0 e^{i(\omega t + \phi_z)}, \quad i = \sqrt{-1}
\]

have phase angles shifted by 90 degrees, and their linear combination may be used to represent any arbitrary phase angle.

Depending on the phase shift between two oscillating components of a vector, the vector can rotate clockwise or counterclockwise, or oscillate along certain direction. Generally, the end of such a vector draws an ellipse. The semi-major axis of the ellipse corresponds to the peak value of the vector. The ratio between minor and major axes of the ellipse defines the coefficient of polarization. The coefficient of polarization is assumed to be positive for the counterclockwise and negative for the clockwise rotation. Zero coefficient corresponds to the linear polarization.

Total current in a conductor can be considered as a combination of a source current produced by the external voltage and an eddy current induced by the oscillating magnetic field

\[
j = j_0 + j_{\text{eddy}}
\]

If a field simulation is coupled with an electric circuit, the branch equation for a conductor is:

\[
I = \frac{U}{R} - \sigma \int_{\Omega} \frac{\partial A}{\partial t} ds
\]

where \( U \) is the voltage difference between the two terminals of the solid conductor, and \( R \) is the DC resistance of the conductor.
The problem is formulated as a partial differential equation for the complex amplitude of vector magnetic potential \( \mathbf{A} \) (\( \mathbf{B} = \text{curl} \, \mathbf{A} \), magnetic flux density vector). The flux density is assumed to lie in the plane of model (xy or zr), while the vector of electric current density \( \mathbf{j} \) and the vector potential \( \mathbf{A} \) are orthogonal to it. Only \( j_z \) and \( A_z \) in planar or \( j_0 \) and \( A_\theta \) in axisymmetric case are not equal to zero. We will denote them simply \( j \) and \( A \). The equation for planar case is

\[
\frac{\partial}{\partial x} \left( \frac{1}{\mu_y} \frac{\partial A}{\partial x} \right) + \frac{\partial}{\partial y} \left( \frac{1}{\mu_x} \frac{\partial A}{\partial y} \right) - i\omega \sigma A = -j_0
\]

and for axisymmetric case is

\[
\frac{\partial}{\partial r} \left( \frac{1}{r\mu_z} \frac{\partial (rA)}{\partial r} \right) + \frac{\partial}{\partial z} \left( \frac{1}{\mu_r} \frac{\partial A}{\partial z} \right) - i\omega \sigma A = -j_0
\]

where electric conductivity \( \sigma \) and components of magnetic permeability tensor \( \mu_x \) and \( \mu_y \) (\( \mu_z \) and \( \mu_r \)) are constants within each block of the model. Source current density \( j_0 \) is assumed to be constant within each model block in planar case and vary as \( \sim(1/r) \) in axisymmetric case.

**Note.** QuickField allows nonlinear materials with field-dependent permeability (ferromagnets) in AC magnetic formulation. This harmonic estimation makes use of a specially adjusted B-H curves providing energy conservancy over the AC period. This adjustment is performed automatically in the Curve Editor, it is recalculated after every change of the original curve made by the user. The curve editor for AC Magnetic problem presents both the user-defined and adjusted B-H curves.

The described formulation ignores displacement current density term \( \partial \mathbf{D}/\partial t \) in the Ampere’s Law. Typically the displacement current density is not significant until the operating frequency approaches the MHz range.

**Note.** Permanent magnets cannot be simulated in a time-harmonic analysis. Since the entire field must vary sinusoidally, this would prevent permanent magnets from being simulated using the harmonic analysis as the permanent magnets supply a constant flux to the system.
Field Sources

The field sources can be specified in the blocks, at the edges or at the individual vertices of the model. Possible field sources include space, surface and linear electric currents and voltages applied to conductive areas.

A point source in the xy-plane corresponds to a linear current in out-of-plane direction. In axisymmetric case the point source represents the current in a thin ring around the axis of symmetry. Edge-bound source in the plane of model represents a surface current in three-dimensional world. It is specified by the Neumann boundary condition for the edge.

There are several ways to specify space-distributed electric current. In a massive conductor, you can specify either a total current or a voltage applied to the conductor. In planar problems, voltage drop is specified per unit depth of the model, and in axisymmetric case voltage is assumed per one turn around the axis of symmetry. Nonzero voltage applied to a conductor in axisymmetric problem means that the conductor has a radial cut, and the voltage is applied to sides of the cut. In practice this option could be used to describe known voltage applied to massive spiral wiring, in which case the total voltage drop for the coil should be divided by number of turns in the coil.

Several blocks with the same value of total current or voltage applied can be considered as connected in series. In that case each conductor carries the same total current, and voltage (if any) is applied to the terminals of the whole group of conductors connected in series.

Note. The meanings of zero total current and zero voltage applied to a conductor are very different. Zero voltage means that the conductor’s ends are short circuit, and zero value of the total current means open ends of the conductor.

Field source could also be specified in non-conductive areas. This option is useful to specify current in coils made of thin wire, where skin effect is insignificant. You can specify either a total current or a current density, whichever is easier to calculate in a specific case. Current density in a coil can be obtained from the equation

\[ j = n \cdot \frac{I}{S}, \]
where \( n \) is a number of turns, \( I \) is a total current, and \( S \) is a cross-sectional area of the coil.

\[
\text{Note. In order to properly model thin wire coils, the source current density } j_0 \text{ in non-conductive areas is assumed to be uniform in both plane and axisymmetric cases. Its behavior is different for massive conductors, where source current density varies as } -(1/r) \text{ in axisymmetric case.}
\]

**Boundary Conditions**

The following boundary conditions can be specified at outward and inner boundaries of the region.

**Dirichlet condition** specifies a known value of vector magnetic potential \( A_0 \) at the vertex or at the edge of the model. This boundary condition defines normal component of the flux density vector. It is often used to specify vanishing value of this component, for example at the axis of symmetry or at the distant boundary. QuickField also supports the Dirichlet condition with a function of coordinates. This approach allows you to model a uniform external field by specifying non-zero normal component of the flux density at arbitrary straight boundary segment.

**Neumann condition** has the following form

\[
H_t = \sigma \quad \text{—— at outward boundaries,}
\]

\[
H_t^+ - H_t^- = \sigma \quad \text{—— at inner boundaries,}
\]

where \( H_t \) is a tangent component of magnetic field intensity, "+" and "−" superscripts denote quantities to the left and to the right side of the boundary and \( \sigma \) is a linear density of the surface current. If \( \sigma \) value is zero, the boundary condition is called homogeneous. This kind of boundary condition is often used at an outward boundary of the region that is formed by the plane of magnetic antisymmetry of the problem (opposite sources in symmetrical geometry). The homogeneous Neumann condition is the natural one, it is assumed by default at all outward boundary parts where no explicit boundary condition is specified.

\[
\text{Note. Zero Dirichlet condition is defaulted at the axis of rotation for the axisymmetric problems.}
\]
If the surface electric current is to be specified at the plane of problem symmetry and this plane forms the outward boundary of the region, the current density has to be halved.

**Zero flux boundary condition** is used to describe superconducting materials that are not penetrated by the magnetic field. Vector magnetic potential is a constant within such superconducting body \((rA = \text{const})\) in axisymmetric case), therefore superconductor's interior can be excluded from the consideration and the constant potential condition can be associated with its surface.

---

**Note.** If the surface of a superconductor has common points with any Dirichlet edge, the whole surface has to be described by the Dirichlet condition with an appropriate potential value.

---

**Calculated Physical Quantities**

The following local and integral physical quantities are calculated in the process of harmonic magnetic field analysis.

Local quantities:

- Complex amplitude of vector magnetic potential \(A\) (flux function \(rA\) in axisymmetric case);
- Complex amplitude of voltage \(U\) applied to the conductor;
- Complex amplitude of total current density \(j = j_0 + j_{\text{eddy}}\), source current density \(j_0\) and eddy current density \(j_{\text{eddy}} = -i\omega\sigma A\);
- Complex vector of the magnetic flux density \(\mathbf{B} = \text{curl} \ A\)
  
  \[
  B_x = \frac{\partial A}{\partial y}, \quad B_y = -\frac{\partial A}{\partial x} \quad \text{— for planar case};
  \]
  
  \[
  B_z = \frac{1}{r} \cdot \frac{\partial (rA)}{\partial r}, \quad B_r = -\frac{\partial A}{\partial z} \quad \text{— for axisymmetric case};
  \]
- Complex vector of magnetic field intensity
  
  \[
  \mathbf{H} = \frac{1}{\mu} \mathbf{B},
  \]
  where \(\mu\) is the magnetic permeability tensor;
- Time average and peak Joule heat density
\[ Q = \frac{1}{\sigma} j^2 + k_h \cdot f \cdot B^2 + k_c \cdot f^2 \cdot B^2 + k_e \cdot (f \cdot B)^3 \]

- Time average and peak magnetic field energy density \( w = B \cdot H / 2 \);
- Time average Poynting vector (local power flow) \( S = E \times H \);
- Time average Lorentz force density vector \( F = j \times B \);
- Magnetic permeability \( \mu \) (its largest component in anisotropic media);
- Electric conductivity \( \sigma \).

Integral quantities:
- Complex magnitude of electric current through a particular surface and its source and eddy components
  \[ I = \int j \, ds \]
- Time average and peak Joule heat in a volume
  \[ P = \int \frac{1}{\sigma} j^2 \, dv \]
  oscillating component
- Time average core loss in a volume
  \[ P_{core} = \int \left[ k_h \cdot f \cdot B^2 + k_c \cdot f^2 \cdot B^2 + k_e \cdot (f \cdot B)^3 \right] \, dv, \]
  where \( B \) – is the flux density magnetide and \( k_h, k_c, k_e \) are user defined coefficients.
- Time average and peak magnetic field energy
  \[ W = \frac{1}{2} \int_V (H \cdot B) \, dv \]
• Time average and peak power flow through the given surface (Poynting vector flow)

\[ S = \int (S \cdot n) ds \]

• Time average and oscillating part of Maxwell force acting on bodies contained in a particular volume

\[ F = \frac{1}{2} \oint_s (H(n \cdot B) + B(n \cdot H) - n(H \cdot B)) ds, \]

where integral is evaluated over the boundary of the volume, and \( n \) denotes the vector of the outward unit normal.

• Time average and peak Maxwell force torque acting on bodies contained in a particular volume

\[ T = \frac{1}{2} \oint_s ([r \times H](n \cdot B) + [r \times B](n \cdot H) - [r \times n](H \cdot B)) ds, \]

where \( r \) is a radius vector of the point of integration.

• Time average and oscillating part of Lorentz force acting on conductors contained in a particular volume

\[ F = \int \nabla \times [j \times B] dv. \]

• Time average and peak Lorentz force torque acting on bodies contained in a particular volume

\[ T = \int \nabla \times [j \times B] dv. \]

where \( r \) is a radius vector of the point of integration.

The torque vector is parallel to \( z \)-axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \( F \times r_0 \), where \( F \) is the total force and \( r_0 \) is the radius vector of the point.
Note. Magnetic field produces forces acting on the current carrying conductors and on the ferromagnetic bodies. The force acting on conductors is known as Lorentz force, while the Maxwell force incorporates both components.

The domain of integration is specified in the plane of the model as a closed contour consisting of line segments and circular arcs.

**Impedance Calculation**

Impedance in ac magnetic analysis is a complex coefficient between complex values of current and voltage, \( V = ZI \). Its real part represents active resistance of the conductor, calculated with the skin effect taken into account. The imaginary part of the impedance is the inductance multiplied by the angular frequency \( \omega \).

\[
Z = R + i\omega L
\]

As values of voltage and current in any conductor are easily accessible in the postprocessor, you can determine the impedance by dividing voltage by current using complex arithmetic. Let \( V \) and \( I \) be peak values of voltage and current, and \( \phi_V \) and \( \phi_I \) be phases of those quantities. Then the active resistance is calculated as

\[
R = \frac{V}{I} \cos(\phi_V - \phi_I),
\]

and the inductance as

\[
L = \frac{V}{I \cdot 2\pi f} \sin(\phi_V - \phi_I),
\]

To get mutual inductance between two conductors, you can specify non-zero total current in one of them, make the ends of the other open (applying zero total current), and measure the voltage induced in the second conductor by the current in the first one.

Note. As in planar case, voltage is applied and measured per unit length, the impedance is also calculated per unit length in \( z \)-direction.
Electrostatics

Electrostatic problems are described by the Poisson's equation for scalar electric potential $U$ ($\mathbf{E} = -\nabla U$, $\mathbf{E}$—electric field intensity vector). The equation for planar case is

$$\frac{\partial}{\partial x} \left( \varepsilon_x \frac{\partial U}{\partial x} \right) + \frac{\partial}{\partial y} \left( \varepsilon_y \frac{\partial U}{\partial y} \right) = -\rho,$$

for axisymmetric case:

$$\frac{1}{r} \frac{\partial}{\partial r} \left( \varepsilon_r r \frac{\partial U}{\partial r} \right) + \frac{\partial}{\partial z} \left( \varepsilon_z \frac{\partial U}{\partial z} \right) = -\rho,$$

And for 3D formulation:

$$\frac{\partial}{\partial x} \left( \varepsilon \frac{\partial U}{\partial x} \right) + \frac{\partial}{\partial y} \left( \varepsilon \frac{\partial U}{\partial y} \right) + \frac{\partial}{\partial z} \left( \varepsilon \frac{\partial U}{\partial z} \right) = -\rho,$$

where components of electric permittivity tensor $\varepsilon_x$, $\varepsilon_y$, $\varepsilon_z$ or $\varepsilon_r$, $\varepsilon_z$ and electric charge density $\rho$ are constants within each block of the model. Anisotropy is not accounted for in 3D formulation.

Field Sources

QuickField provides possibility to specify electric charges located in the bodies, on the faces, at the edges or at the individual vertices of the model. In planar case, the electric charge specified at a point of the $xy$-plane corresponds to a charged string that is perpendicular to the plane of the model, and is described by the linear charge density. In axisymmetric case the vertex charge represents a charged circle around the axis of symmetry or a point charge located on the axis. To incorporate both these cases a total charge value is associated with the vertex. For the charged circle the total charge is connected with its linear density by the relationship $q = 2\pi r \rho$. Edge-bound charge in the plane of model represents a surface-bound charge in three-dimensional world. It is described by surface charge density and is specified by the Neumann boundary condition for the edge. The charge density associated with a body or within a block is equivalent to the space charge.
Boundary Conditions

The following boundary conditions can be specified at outward and inner boundaries of the region.

**Dirichlet condition** specifies a known value of electric potential $U_0$ at the vertex, at the edge, or on the face of the model (for example on a capacitor plate). This kind of boundary condition is also useful at an outward boundary of the region that is formed by the plane of electric antisymmetry of the problem (opposite charges in symmetrical geometry). $U_0$ value can be specified as a linear function of coordinates. The function parameters can vary from one entity to another, but have to be adjusted to avoid discontinuities at entities' junction points.

*Note.* For problem to be defined correctly the Dirichlet condition has to be specified at least at one point. If the region consists of two or more disjoint subregions, the Dirichlet conditions have to be specified at least at one point of every part.

**Neumann condition** is defined by the following equations:

\[
D_n = \sigma \quad \text{— at outward boundaries},
\]

\[
D_n^+ - D_n^- = \sigma \quad \text{— at inner boundaries},
\]

where $D_n$ is a normal component of electric induction, "+" and "−" superscripts denote quantities to the left and to the right side of the boundary, $\sigma$ is a surface charge density. If $\sigma$ value is zero, the boundary condition is called homogeneous. It indicates vanishing of the normal component of electric field intensity vector. This kind of boundary condition is used at an outward boundary of the region that is formed by the symmetry plane of the problem. The homogeneous Neumann condition is the natural one, it is defaulted at all outward boundary parts where no explicit boundary condition is specified.

If the surface-bound charge is to be specified at the plane of problem symmetry and this plane is the outward boundary of the region, the surface charge density has to be halved.
Constant potential boundary condition is used to describe surface of an isolated "floating" conductor that has constant but unknown potential value.

Note. The edge or the face described as possessing constant potential should not have common points with any Dirichlet entity. In that case the constant potential entity has to be described by a Dirichlet condition with appropriate potential value.

Calculated Physical Quantities

For electrostatic problems the QuickField postprocessor calculates the following set of local and integral physical quantities.

Local quantities:

- Scalar electric potential $U$;
- Vector of electric field intensity $\mathbf{E} = -\nabla U$

\[
E_x = -\frac{\partial U}{\partial x}, \quad E_y = -\frac{\partial U}{\partial y}, \quad E_z = -\frac{\partial U}{\partial z}
\] — for planar or 3D case;

\[
E_z = -\frac{\partial U}{\partial z}, \quad E_r = -\frac{\partial U}{\partial r}
\] — for axisymmetric case;

- Tensor of the gradient of electric field intensity $\mathbf{G} = \nabla \mathbf{E}$

\[
G_{xx} = \frac{\partial E_x}{\partial x}, \quad G_{yy} = \frac{E_y}{\partial y}, \quad G_{xy} = \frac{1}{2} \left( \frac{\partial E_x}{\partial y} + \frac{\partial E_y}{\partial x} \right)
\] — for planar case;

\[
G_{zz} = \frac{\partial E_z}{\partial x}, \quad G_{rr} = \frac{E_r}{\partial r}, \quad G_{zr} = \frac{1}{2} \left( \frac{\partial E_z}{\partial r} + \frac{\partial E_r}{\partial z} \right)
\] — for axisymmetric case;

and also its principal components $G1$ and $G2$.

- Vector of electric induction $\mathbf{D} = \varepsilon \mathbf{E}$, where $\varepsilon$ is electric permittivity tensor.

Integral quantities:

- Total electric charge in a particular volume

\[
q = \int \mathbf{D} \cdot \mathbf{n} \, ds,
\]
where integral is evaluated over the boundary of the volume, and \( \mathbf{n} \) denotes the vector of the outward unit normal.

- Total electric force acting on bodies contained in a particular volume

\[
\mathbf{F} = \frac{1}{2} \oint_{S} \left( \mathbf{E}(\mathbf{n} \cdot \mathbf{D}) + \mathbf{D}(\mathbf{n} \cdot \mathbf{E}) - \mathbf{n}(\mathbf{E} \cdot \mathbf{D}) \right) ds,
\]

- Total torque of electric forces acting on bodies contained in a particular volume

\[
\mathbf{T} = \frac{1}{2} \oint_{S} \left( [\mathbf{r} \times \mathbf{E}](\mathbf{n} \cdot \mathbf{D}) + [\mathbf{r} \times \mathbf{D}](\mathbf{n} \cdot \mathbf{E}) - [\mathbf{r} \times \mathbf{n}](\mathbf{E} \cdot \mathbf{D}) \right) ds,
\]

where \( \mathbf{r} \) is a radius vector of the point of integration.

The torque vector is parallel to \( z \)-axis in planar case, and is identically equal to zero in axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \( \mathbf{F} \times \mathbf{r}_0 \), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_0 \) is the radius vector of the point.

- Energy of electric field

\[
W = \frac{1}{2} \int_{V} (\mathbf{E} \cdot \mathbf{D}) dv
\]

For planar problems all integral quantities are considered per unit length in \( z \)-direction.

The domain of integration is specified in the plane of the model as a closed contour consisting of line segments and circular arcs.

## Capacitance Calculation

There are several ways to calculate capacitance using QuickField. The easiest one of them is based on measuring an electric potential produced by a known charge. To get capacitance of a conductor, put constant potential boundary condition on its surface, specify an arbitrary non zero electric charge in one of the vertices on the surface of the conductor (in fact, the charge will be distributed over the conductor’s surface), and turn off all other field sources in the model. Once the problem is solved, go to the Postprocessor and take the value of electric potential somewhere on
the surface of the conductor. The capacitance of the conductor can be obtained from the equation

\[ C = \frac{q}{U}, \]

where \( q \) is the electric charge and \( U \) is the potential of the conductor.

To calculate mutual capacitance between two conductors put a charge on one conductor and measure electric potential on another. Constant potential boundary condition has to be applied to the surfaces of both conductors.

\[ C_{12} = \frac{q_1}{U_2}. \]

Self- and mutual partial capacitance matrix calculation in the multi-conductor system is discussed in the “Partial Capacitance Matrix Calculation for the System of Conductors” chapter.

### DC Conduction Analysis

QuickField is able to calculate the distribution of electric current in systems of conductors. The problems of current distribution are described by the Poisson's equation for scalar electric potential \( U \).

The equation for planar case is

\[ \frac{\partial}{\partial x} (\sigma_x \frac{\partial U}{\partial x}) + \frac{\partial}{\partial y} (\sigma_y \frac{\partial U}{\partial y}) = 0, \]

for axisymmetric case:

\[ \frac{1}{r} \frac{\partial}{\partial r} (\sigma_r r \frac{\partial U}{\partial r}) + \frac{\partial}{\partial z} (\sigma_z \frac{\partial U}{\partial z}) = 0, \]

and for 3D formulation:

\[ \frac{\partial}{\partial x} (\sigma \frac{\partial U}{\partial x}) + \frac{\partial}{\partial y} (\sigma \frac{\partial U}{\partial y}) + \frac{\partial}{\partial z} (\sigma \frac{\partial U}{\partial z}) = 0, \]

where components of electric conductivity tensor \( \sigma_x, \sigma_y \) or \( \sigma_z, \sigma_r \) are constant within each model block. Anisotropy is not accounted for in 3D formulation.

The electric current density \( j \) can be obtained from the equation \( j = -\sigma \text{grad } U \).
Field Sources

With the problems of dc conduction, the field sources are external currents supplied to the boundary of a conductor. QuickField provides possibility to specify external current density at the edges or at the individual vertices of the model. The current density specified at a point of the xy-plane corresponds to a knife-edge current collector that is perpendicular to the plane of the model, and is described by the linear current density. In axisymmetric case the vertex source represents a circular collector around the axis of symmetry or a point collector located on the axis. To incorporate both these cases, a total current value is associated with the vertex. For the circular knife-edge collector the total current value is connected with its linear density by the relationship \( I = 2\pi r \sigma \). Edge-bound current density in the plane of model represents a surface-bound external current density in three-dimensional world. It is specified by the Neumann boundary condition for the edge.

Boundary Conditions

The following boundary conditions can be specified at outward and inner boundaries of the region.

**Dirichlet condition** specifies a known value of electric potential \( U_0 \) at the vertex or at the edge of the model. \( U_0 \) value at the edge can be specified as a linear function of coordinates. The function parameters can vary from one edge to another, but have to be adjusted to avoid discontinuities at edges' junction points.

*Note.* For problem to be defined correctly the Dirichlet condition has to be specified at least at one point. If the region consists of two or more disjoint subregions, the Dirichlet conditions have to be specified at least at one point of every part.

**Neumann condition** is defined by the following equations:

\[
\begin{align*}
    j_n &= j & \text{— at outward boundaries,} \\
    j_n^+ - j_n^- &= j & \text{— at inner boundaries,}
\end{align*}
\]
where \( jn \) is a normal component of the current density vector, "+" and "−" superscripts denote quantities to the left and to the right side of the boundary, and \( j \) at right hand side is a density of the external current. If \( j \) value is zero, the boundary condition is called homogeneous. This kind of boundary condition is used at an outward boundary of the region that is formed by the symmetry plane of the problem. The homogeneous Neumann condition is the natural one, it is defaulted at all outward boundary parts where no explicit boundary condition is specified.

If the surface-bound current density is to be specified at the plane of problem symmetry and this plane is the outward boundary of the region, the surface current density has to be halved.

**Constant potential boundary condition** is used to describe surface of a conductor having much greater conductivity than the surrounding medium. This conductor is assumed to have constant but unknown potential value.

*Note.* The edge described as possessing constant potential should not have common points with any Dirichlet edge. In that case the constant potential edge has to be described by the Dirichlet condition with an appropriate potential value.

### Calculated Physical Quantities

For problems of dc conduction, the QuickField postprocessor calculates the following set of local and integral physical quantities.

Local quantities:

- Scalar electric potential \( U \);
- Vector of electric field intensity \( \mathbf{E} = -\nabla U \)

\[
E_x = -\frac{\partial U}{\partial x}, \quad E_y = -\frac{\partial U}{\partial y}, \quad E_z = -\frac{\partial U}{\partial z} \quad \text{— for planar or 3D case;}
\]

\[
E_z = -\frac{\partial U}{\partial z}, \quad E_r = -\frac{\partial U}{\partial r} \quad \text{— for axisymmetric case;}
\]

- Vector of current density \( \mathbf{j} = \sigma \mathbf{E} \), where \( \sigma \) - is electric conductivity tensor.

Integral quantities:
Electric current through a given surface

\[ I = \int_S \mathbf{j} \cdot \mathbf{n} \, ds, \]

where \( \mathbf{n} \) denotes the vector of the unit normal.

- Joule heat produced in a volume

\[ W = \int_V (\mathbf{E} \cdot \mathbf{j}) \, dv. \]

For planar problems all integral quantities are considered per unit length in \( z \) direction.

The domain of integration is specified in the plane of the model as a closed contour consisting of line segments and circular arcs.

**AC Conduction Analysis**

AC conduction analysis is the study of electric field, current and losses arising in conductors and imperfect (lossy) dielectrics from the application of an alternating (AC) voltage or external current to electrodes.

Similar to problems of AC magnetics, variation of the field with respect to time is assumed to be sinusoidal. All field components and electric current vary with time like

\[ z = z_0 \cos(\omega t + \phi_z), \]

where \( z_0 \) is a peak value of \( z \), \( \phi_z \) — its phase angle, and \( \omega \) — the angular frequency.

Complex arithmetic is used to represent harmonic time-dependency.

The problem formulation combines equations for electrostatics (\( \nabla \cdot \mathbf{E} = \rho \)) and dc conduction (\( \nabla \cdot \mathbf{j} = -i\omega \sigma \)), taking into account the Ohm’s law, \( \mathbf{j} = \sigma \mathbf{E} \). Final equation with respect to electric potential \( U \) is

\[ \nabla \left( \left[ \varepsilon - \frac{i\sigma}{\omega} \right] \nabla U \right) = 0; \]

where electric conductivity \( \sigma \) and components of electric permittivity tensor \( \varepsilon_z \) and \( \varepsilon_y \) (\( \varepsilon_z \) and \( \varepsilon_r \)) are constants within each block of the model.
Field Sources

With ac conduction problems, the field sources are external currents or voltages supplied to the boundary of a conductor. QuickField provides possibility to specify external current density at the edges or at the individual vertices of the model. The current density specified at a point of the $xy$-plane corresponds to a knife-edge current collector, which is perpendicular to the plane of the model, and is described by the linear current density. In axisymmetric case the vertex source represents a circular collector around the axis of symmetry or a point collector located on the axis. To incorporate both these cases, a total current value is associated with the vertex. For the circular knife-edge collector the total current value is connected with its linear density by the relationship $I = 2\pi r \sigma$. Edge-bound current density in the plane of model represents a surface-bound external current density in three-dimensional world. It is specified by the Neumann boundary condition for the edge. Every condition is defined by its magnitude and phase.

Boundary Conditions

The following boundary conditions can be specified at outward and inner boundaries of the region.

**Dirichlet condition** specifies a known value of electric potential $U_0$ at the vertex or at the edge of the model. $U_0$ value at the edge can be specified as a linear function of coordinates. The function parameters can vary from one edge to another, but have to be adjusted to avoid discontinuities at edges' junction points.

*Note.* For problem to be defined correctly the Dirichlet condition has to be specified at least at one point. If the region consists of two or more disjoint subregions, the Dirichlet conditions have to be specified at least at one point of every part.

**Neumann condition** is defined by the following equations:

$$j_n = j$$
— at outward boundaries,

$$j_n^+ - j_n^- = j$$
— at inner boundaries,
where \( j_n \) is a normal component of the current density vector, "+" and "−" superscripts denote quantities to the left and to the right side of the boundary, and \( j \) at right hand side is a density of the external current. If \( j \) value is zero, the boundary condition is called homogeneous. This kind of boundary condition is used at an outward boundary of the region that is formed by the symmetry plane of the problem. The homogeneous Neumann condition is the natural one; it is defaulted at all outward boundary parts where no explicit boundary condition is specified.

If the surface-bound current density is to be specified at the plane of problem symmetry and this plane is the outward boundary of the region, the surface current density has to be halved.

**Constant potential boundary condition** is used to describe surface of a conductor having much greater conductivity than the surrounding medium. This conductor is assumed to have constant but unknown potential value.

**Note.** The edge described as possessing constant potential should not have common points with any Dirichlet edge. In that case the constant potential edge has to be described by the Dirichlet condition with an appropriate potential value.

### Calculated Physical Quantities

For ac conduction problems, the QuickField postprocessor calculates the following set of local and integral physical quantities.

Local quantities:
- Complex amplitude of electric potential \( U \);
- Complex vector of electric field intensity \( \mathbf{E} = -\nabla U \)

\[
E_x = -\frac{\partial U}{\partial x}, \quad E_y = -\frac{\partial U}{\partial y} \quad \text{— for planar case;}
\]

\[
E_z = -\frac{\partial U}{\partial z}, \quad E_r = -\frac{\partial U}{\partial r} \quad \text{— for axisymmetric case;}
\]
- Complex vector of active \( j_{\text{active}} = \sigma \mathbf{E} \), reactive \( j_{\text{reactive}} = i \omega \varepsilon \mathbf{E} \) and apparent \( j_{\text{apparent}} = j_{\text{active}} + j_{\text{reactive}} \) current density;
- Time average and peak active power (losses) density \( Q_{\text{active}} \) = \( \mathbf{j}_{\text{active}} \cdot \mathbf{E} \), reactive \( Q_{\text{reactive}} = \mathbf{j}_{\text{reactive}} \cdot \mathbf{E} \), and apparent \( Q_{\text{apparent}} = \mathbf{j}_{\text{apparent}} \cdot \mathbf{E} \) power density;

- Electric permittivity \( \varepsilon \) (its largest component in anisotropic media);

- Electric conductivity \( g \) (its largest component in anisotropic media).

Integral quantities:

- Complex magnitude of electric current (active \( I_{\text{active}} \), reactive \( I_{\text{reactive}} \) and apparent \( I \)) through a given surface
  \[
  I = \int_S (\mathbf{j} \cdot \mathbf{n}) \, ds
  \]
  where \( \mathbf{n} \) denotes the vector of the unit normal.

- Time average and peak active \( P_{\text{active}} \), reactive \( P_{\text{reactive}} \), and apparent \( P \) power produced in a volume
  \[
  P = \int_V (\mathbf{E} \cdot \mathbf{j}) \, dv
  \]

- Time average and oscillating part of electric force acting on bodies contained in a particular volume
  \[
  \mathbf{F} = \frac{1}{2} \oint_S (\mathbf{E}(\mathbf{n} \cdot \mathbf{D}) + \mathbf{D}(\mathbf{n} \cdot \mathbf{E}) - \mathbf{n}(\mathbf{E} \cdot \mathbf{D})) \, ds,
  \]
  where integral is evaluated over the boundary of the volume, and \( \mathbf{n} \) denotes the vector of the outward unit normal.

- Time average and peak electric force torque acting on bodies contained in a particular volume
  \[
  \mathbf{T} = \frac{1}{2} \oint_S ([\mathbf{r} \times \mathbf{E}](\mathbf{n} \cdot \mathbf{D}) + [\mathbf{r} \times \mathbf{D}](\mathbf{n} \cdot \mathbf{E}) - [\mathbf{r} \times \mathbf{n}](\mathbf{E} \cdot \mathbf{D})) \, ds,
  \]
  where \( \mathbf{r} \) is a radius vector of the point of integration.

The torque vector is parallel to \( z \)-axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \( \mathbf{F} \times \mathbf{r}_o \), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_o \) is the radius vector of the point.
The domain of integration is specified in the plane of the model as a closed contour consisting of line segments and circular arcs.

**Transient Electric Analysis**

Transient electric is the most generic formulation of electric field analysis in the absence of magnetic field. In this formulation, the field sources (voltage or current) can be arbitrary functions of time, and electric properties of materials can vary with electric field.

The problem formulation is similar to AC conduction:

\[
- \nabla \cdot [\sigma(E) \nabla U] - \frac{\partial}{\partial t} \nabla [\varepsilon(E) \nabla U] = 0
\]

where electric conductivity \( \sigma \) and electric permittivity \( \varepsilon \) can be nonlinear or anisotropic.

**Field Sources**

The field sources are external currents or voltages supplied to the boundary of a conductor. QuickField provides possibility to specify external current density at the edges or at the individual vertices of the model. The current density specified at a point of the \( xy \)-plane corresponds to a knife-edge current collector, which is perpendicular to the plane of the model, and is described by the linear current density. In axisymmetric case the vertex source represents a circular collector around the axis of symmetry or a point collector located on the axis. To incorporate both these cases, a total current value is associated with the vertex. For the circular knife-edge collector the total current value is connected with its linear density by the relationship \( I = 2\pi r \sigma \). Edge-bound current density in the plane of model represents a surface-bound external current density in three-dimensional world. It is specified by the Neumann boundary condition for the edge. Every condition is defined by the formula involving spatial coordinates and time.

**Boundary Conditions**

The following boundary conditions can be specified at outward and inner boundaries of the region.
Dirichlet condition specifies a known value of electric potential $U_0$ at the vertex or at the edge of the model. $U_0$ value at the edge can be specified as a linear function of coordinates. The function parameters can vary from one edge to another, but have to be adjusted to avoid discontinuities at edges' junction points.

Note. For problem to be defined correctly the Dirichlet condition has to be specified at least at one point. If the region consists of two or more disjoint subregions, the Dirichlet conditions have to be specified at least at one point of every part.

Neumann condition is defined by the following equations:

\[ j_n = j \] — at outward boundaries,

\[ j_n^+ - j_n^- = j \] — at inner boundaries,

where $j_n$ is a normal component of the current density vector, "+" and "−" superscripts denote quantities to the left and to the right side of the boundary, and $j$ at right hand side is a density of the external current. If $j$ value is zero, the boundary condition is called homogeneous. This kind of boundary condition is used at an outward boundary of the region that is formed by the symmetry plane of the problem. The homogeneous Neumann condition is the natural one; it is defaulted at all outward boundary parts where no explicit boundary condition is specified.

If the surface-bound current density is to be specified at the plane of problem symmetry and this plane is the outward boundary of the region, the surface current density has to be halved.

Constant potential boundary condition is used to describe surface of a conductor having much greater conductivity than the surrounding medium. This conductor is assumed to have constant but unknown potential value.

Note. The edge described as possessing constant potential should not have common points with any Dirichlet edge. In that case the constant potential edge has to be described by the Dirichlet condition with an appropriate potential value.
Calculated Physical Quantities

The QuickField postprocessor calculates the following set of local and integral physical quantities at any given moment of time or as time-dependent graphs and tables:

Local quantities:
- Electric potential $U$;
- Electric field intensity $\mathbf{E} = -\text{grad} U$
- Tensor of the gradient of electric field intensity $\mathbf{G} = \text{grad} \mathbf{E}$

$$
G_{xx} = \frac{\partial E_x}{\partial x}, G_{yy} = \frac{E_y}{\partial y}, G_{xy} = \frac{1}{2} \left( \frac{\partial E_x}{\partial y} + \frac{\partial E_y}{\partial x} \right) \quad \text{— for planar case;}
$$

$$
G_{zz} = \frac{\partial E_z}{\partial x}, G_{rr} = \frac{E_r}{\partial r}, G_{zr} = \frac{1}{2} \left( \frac{\partial E_z}{\partial r} + \frac{\partial E_r}{\partial z} \right) \quad \text{— for axisymmetric case;}
$$

and also its principal components $G1$ and $G2$.

- Vector of active $\mathbf{j} = \sigma \mathbf{E}$ and displacement $\mathbf{j}_d = \frac{\partial}{\partial t} (\varepsilon \mathbf{E})$ current;
- Active power (losses) density $Q = \mathbf{j} \cdot \mathbf{E}$;
- Electric permittivity $\varepsilon(E)$;
- Electric conductivity $\sigma(E)$.

Integral quantities:
- Electric current (active $I_{\text{active}}$ and reactive $I_{\text{reactive}}$) through a given surface

$$
I = \int_S \mathbf{j} \cdot \mathbf{n} \, ds,
$$

where $\mathbf{n}$ denotes the vector of the unit normal.

- Active $P_{\text{active}}$ and reactive $P_{\text{reactive}}$ power produced in a volume

$$
P = \int_V (\mathbf{E} \cdot \mathbf{j}) \, dv.
$$

- Electric force acting on bodies contained in a particular volume

$$
\mathbf{F} = \frac{1}{2} \int_S \left( \mathbf{E}(\mathbf{n} \cdot \mathbf{D}) + \mathbf{D}(\mathbf{n} \cdot \mathbf{E}) - \mathbf{n}(\mathbf{E} \cdot \mathbf{D}) \right) \, ds,
$$
where integral is evaluated over the boundary of the volume, and \( \mathbf{n} \) denotes the vector of the outward unit normal.

- Electric force torque acting on bodies contained in a particular volume

\[
\mathbf{T} = \frac{1}{2} \oint_S \left( [\mathbf{r} \times \mathbf{E}](\mathbf{n} \cdot \mathbf{D}) + [\mathbf{r} \times \mathbf{D}](\mathbf{n} \cdot \mathbf{E}) - [\mathbf{r} \times \mathbf{n}](\mathbf{E} \cdot \mathbf{D}) \right) ds,
\]

where \( \mathbf{r} \) is a radius vector of the point of integration.

The torque vector is parallel to \( z \)-axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of \( \mathbf{F} \times \mathbf{r}_0 \), where \( \mathbf{F} \) is the total force and \( \mathbf{r}_0 \) is the radius vector of the point. The domain of integration is specified in the plane of the model as a closed contour consisting of line segments and circular arcs.

### Heat Transfer

With QuickField you can analyze linear and nonlinear temperature fields in one of two formulations: steady state or transient: heating or cooling of the system.

Heat-transfer equation for linear problems is:

\[
\frac{\partial}{\partial x} \left( \lambda_x \frac{\partial T}{\partial x} \right) + \frac{\partial}{\partial y} \left( \lambda_y \frac{\partial T}{\partial y} \right) = -q - c\rho \frac{\partial T}{\partial t} \quad \makebox{— planar case;}
\]

\[
\frac{1}{r} \frac{\partial}{\partial r} \left( \lambda_r r \frac{\partial T}{\partial r} \right) + \frac{\partial}{\partial z} \left( \lambda_z \frac{\partial T}{\partial z} \right) = -q - c\rho \frac{\partial T}{\partial t} \quad \makebox{— axisymmetric case;}
\]

\[
\frac{\partial}{\partial x} \left( \lambda \frac{\partial T}{\partial x} \right) + \frac{\partial}{\partial y} \left( \lambda \frac{\partial T}{\partial y} \right) + \frac{\partial}{\partial z} \left( \lambda \frac{\partial T}{\partial z} \right) = -q \quad \makebox{— 3D case;}
\]

for nonlinear problems:

\[
\frac{\partial}{\partial x} \left( \lambda(T) \frac{\partial T}{\partial x} \right) + \frac{\partial}{\partial y} \left( \lambda(T) \frac{\partial T}{\partial y} \right) = -q(T) - c(T)\rho \frac{\partial T}{\partial t} \quad \makebox{— planar case;}
\]
\[ \frac{1}{r} \frac{\partial}{\partial r} \left( \lambda(T) r \frac{\partial T}{\partial r} \right) + \frac{\partial}{\partial z} \left( \lambda(T) \frac{\partial T}{\partial z} \right) = -q(T) - c(T) \rho \frac{\partial T}{\partial t} \]  — axisymmetric case;

where:

\( T \) — temperature;
\( t \) — time;
\( \lambda_{\alpha(y,z,r)} \) — components of heat conductivity tensor, anisotropy is not accounted for in 3D formulation;
\( \lambda(T) \) — heat conductivity as a function of temperature approximated by cubic spline (anisotropy is not supported in nonlinear case);
\( q(T) \) — volume power of heat sources, in linear case—constant, in nonlinear case—function of temperature approximated by cubic spline.
\( c(T) \) — specific heat, in nonlinear case—function of temperature approximated by cubic spline;
\( \rho \) — density of the substance.

In steady state case the last term in these equations equals zero. In linear case all the parameters are constants within each block of the model.

**Heat Sources**

QuickField provides possibility to specify the heat sources located in the blocks, at the edges or at the individual vertices of the model. The heat source specified at a point of the \( xy \)-plane corresponds to a linear string-like heater which is perpendicular to the plane of the model, and is described by the generated power per unit length. In axisymmetric case the vertex heat source represents a heating circle around the axis of symmetry or a point heater located on the axis. To incorporate both these cases a total generated power value is associated with the vertex. For the heating circle the total power is connected with its linear density by the relationship \( q = 2\pi r q_i \). Edge-bound heat source in the plane of model represents a surface heat source in three-dimensional world. It is described by power per unit area and is specified by the Neumann boundary condition for the edge. The volume power density associated with a block corresponds to the volume heat source.
Boundary Conditions

The following boundary conditions can be specified at outward and inner boundaries of the region.

**Known temperature boundary condition** (known also as boundary condition of the first kind) specifies a known value of temperature $T_0$ at the vertex or at the edge of the model (for example on a liquid-cooled surface). $T_0$ value at the edge can be specified as a linear function of coordinates. The function parameters can vary from one edge to another, but have to be adjusted to avoid discontinuities at edges' junction points.

This boundary condition sometimes is called the boundary condition of the first kind.

**Heat flux boundary condition** (known also as boundary condition of the second kind) is defined by the following equations:

\[ F_n = -q_s \quad \text{— at outward boundaries,} \]

\[ F_{n^+} - F_{n^-} = -q_s \quad \text{— at inner boundaries,} \]

where $F_n$ is a normal component of heat flux density, "$+"$ and "$-"$ superscripts denote quantities to the left and to the right side of the boundary. For inner boundary $q_s$ denotes the generated power per unit area, for outward boundary it specifies the known value of the heat flux density across the boundary. If $q_s$ value is zero, the boundary condition is called homogeneous. The homogeneous condition at the outward boundary indicates vanishing of the heat flux across the surface. This type of boundary condition is the natural one, it is defaulted at all outward boundary parts where no explicit boundary condition is specified. This kind of boundary condition is used at an outward boundary of the region which is formed by the symmetry plane of the problem.

If the surface heat source is to be specified at the plane of problem symmetry and this plane constitutes the outward boundary of the region, the surface power has to be halved.

This boundary condition sometimes is called the boundary condition of the second kind.
Convection boundary condition can be specified at outward boundary of the region. It describes convective heat transfer and is defined by the following equation:

\[ F_n = \alpha(T - T_0), \]

where \( \alpha \) is a film coefficient, and \( T_0 \)—temperature of contacting fluid medium. Parameters \( \alpha \) and \( T_0 \) may differ from part to part of the boundary.

This boundary condition sometimes is called the boundary condition of the third kind.

Radiation boundary condition can be specified at outward boundary of the region. It describes radiative heat transfer and is defined by the following equation:

\[ F_n = k_{SB}\beta(T^4 - T_0^4), \]

where \( k_{SB} \) is a Stephan-Boltzman constant, \( \beta \) is an emissivity coefficient, and \( T_0 \)—ambient radiation temperature. Parameters \( \beta \) and \( T_0 \) may differ from part to part of the boundary.

*Note.* For heat transfer problem to be defined correctly the known temperature boundary condition, or the convection, or the radiation has to be specified at least at some parts of the boundary.

Constant temperature boundary condition may be used to describe bodies with very high heat conductivity. You can exclude interior of these bodies from the consideration and describe their surface as the constant temperature boundary.

*Note.* The edge described as possessing constant temperature cannot have common points with any edge where the temperature is specified explicitly. In that case the constant temperature edge has to be described by the boundary condition of the first kind with an appropriate temperature value.

## Calculated Physical Quantities

For heat transfer problems the QuickField postprocessor calculates the following set of local and integral physical quantities.
Local quantities:
- Temperature \( T \);
- Vector of the heat flux density \( \mathbf{F} = -\lambda \ \text{grad} \ T \)

\[
F_x = -\lambda_x \frac{\partial T}{\partial x}, \quad F_y = -\lambda_y \frac{\partial T}{\partial y}
\]
— for planar case;

\[
F_z = -\lambda_z \frac{\partial T}{\partial z}, \quad F_r = -\lambda_r \frac{\partial T}{\partial r}
\]
— for axisymmetric case;

\[
F_x = -\lambda \frac{\partial T}{\partial x}, \quad F_y = -\lambda \frac{\partial T}{\partial y}, \quad F_z = -\lambda \frac{\partial T}{\partial z}
\]
— for 3D case;

The postprocessor can calculate the heat flux through an arbitrary closed or unclosed surface

\[
\Phi = \int_S (\mathbf{F} \cdot \mathbf{n}) \, ds
\]

where \( \mathbf{n} \) denotes the unit vector of normal to the surface. The surface is specified by a contour consisting of line segments and circular arcs in the plane of the model.

**Stress Analysis**

Within QuickField package, the plane stress, the plane strain and the axisymmetric stress models are available with both isotropic and orthotropic materials. The plane stress model is suitable for analyzing structures that are thin in the out-of-plane direction, e.g., thin plates subject to in-plane loading. Out-of-plane direct stress and shear stresses are assumed to be negligible. The plane strain model is formulated by assuming that out-of-plane strains are negligible. This model is suitable for structures that are thick in the out-of-plane direction.

**Displacement, Strain and Stress**

The displacement field is assumed to be completely defined by the two components of the displacement vector \( \delta \) in each point:

\[
\{\delta\} = \begin{pmatrix} \delta_x \\ \delta_y \end{pmatrix} \quad — \text{for plane problems};
\]
\[ \{ \delta \} = \begin{Bmatrix} \delta_z \\ \delta_r \end{Bmatrix} \quad \text{for axisymmetric problems.} \]

Only three components of strain and stress tensors are independent in both plane stress and plane strain cases. The strain-displacement relationship is defined as:

\[ \{ \varepsilon \} = \begin{Bmatrix} \varepsilon_x \\ \varepsilon_y \\ \gamma_{xy} \end{Bmatrix} = \begin{bmatrix} \frac{\partial \delta_x}{\partial x} \\ \frac{\partial \delta_y}{\partial y} \\ \frac{\partial \delta_x}{\partial y} + \frac{\partial \delta_y}{\partial x} \end{bmatrix} \]

The corresponding stress components:

\[ \{ \sigma \} = \begin{Bmatrix} \sigma_x \\ \sigma_y \\ \tau_{xy} \end{Bmatrix} \]

The axisymmetric problem formulation also includes the out-of-plane direct strain \( \varepsilon_\theta \), caused by the radial deformation. The strain-displacement relationship is defined as:

\[ \{ \varepsilon \} = \begin{Bmatrix} \varepsilon_z \\ \varepsilon_r \\ \varepsilon_\theta \\ \gamma_{rz} \end{Bmatrix} = \begin{bmatrix} \frac{\partial \delta_z}{\partial z} \\ \frac{\partial \delta_r}{\partial r} \\ \frac{\partial \delta_r}{\partial r} + \frac{\partial \delta_z}{\partial z} \end{bmatrix} \]

The corresponding stress components:

\[ \{ \sigma \} = \begin{Bmatrix} \sigma_z \\ \sigma_r \\ \sigma_\theta \\ \tau_{rz} \end{Bmatrix} \]

The equilibrium equations for the plane problems are:
\[
\begin{align*}
\frac{\partial \sigma_x}{\partial x} + \frac{\partial \tau_{xy}}{\partial y} &= -f_x \\
\frac{\partial \tau_{xy}}{\partial x} + \frac{\partial \sigma_y}{\partial y} &= -f_y
\end{align*}
\]

and for the axisymmetric problems are:
\[
\begin{align*}
\frac{1}{r} \frac{\partial \left( r \sigma_r \right)}{\partial r} + \frac{\partial \tau_{rz}}{\partial z} &= -f_r \\
\frac{1}{r} \frac{\partial \left( r \tau_{rz} \right)}{\partial r} + \frac{\partial \sigma_z}{\partial z} &= -f_z
\end{align*}
\]

where \( f_x, f_y \) and \( f_z, f_r \) are components of the volume force vector.

For linear elasticity, the stresses are related to the strains using relationship of the form
\[
\{\sigma\} = [D] \left( \{\varepsilon\} - \{\varepsilon_0\} \right),
\]

where \([D]\) is a matrix of elastic constants, and \(\{\varepsilon_0\}\) is the initial thermal strain. The specific form of the matrix depends on a particular problem formulation.

For plane stress and isotropic material:
\[
[D] = \frac{E}{1 - \nu^2} \begin{bmatrix}
1 & \nu & 0 \\
\nu & 1 & 0 \\
0 & 0 & 1 - \nu
\end{bmatrix}
\]

For plane stress and orthotropic material:
\[
[D] = \begin{bmatrix}
\frac{1}{E_x} & -\frac{\nu_{yx}}{E_y} & 0 \\
-\frac{\nu_{yx}}{E_y} & \frac{1}{E_y} & 0 \\
0 & 0 & \frac{1}{G_{xy}}
\end{bmatrix}^{-1}
\]
Chapter 11 Theoretical Description

For plane strain and isotropic material:

\[
[D] = \frac{E(1 - \nu)}{(1 + \nu)(1 - 2\nu)} \begin{bmatrix}
1 & \frac{\nu}{1 - \nu} & 0 \\
\frac{\nu}{1 - \nu} & 1 & 0 \\
0 & 0 & \frac{1 - 2\nu}{2(1 - \nu)}
\end{bmatrix}
\]

For plane strain and orthotropic material:

\[
[D] = \left[ \begin{array}{ccc}
\frac{1}{E_x} - \frac{v_{zx}^2}{E_z} & -\frac{v_{yx}}{E_y} & \frac{v_{yz}v_{zy}}{E_z} \\
-\frac{v_{yx}}{E_y} & \frac{1}{E_y} - \frac{v_{zy}^2}{E_z} & 0 \\
0 & 0 & 1
\end{array} \right]^{-1}
\]

For axisymmetric problem and isotropic material:

\[
[D] = \frac{E(1 - \nu)}{(1 + \nu)(1 - 2\nu)} \begin{bmatrix}
1 & \frac{\nu}{1 - \nu} & \frac{\nu}{1 - \nu} & 0 \\
\frac{\nu}{1 - \nu} & \frac{1}{1 - \nu} & \frac{1}{1 - \nu} & 0 \\
\frac{\nu}{1 - \nu} & \frac{\nu}{1 - \nu} & 1 & 0 \\
0 & 0 & 0 & \frac{1 - 2\nu}{2(1 - \nu)}
\end{bmatrix}
\]

For axisymmetric problem and orthotropic material:

\[
[D] = \left[ \begin{array}{cccc}
\frac{1}{E_z} - \frac{v_{rz}}{E_r} & -\frac{v_{rz}}{E_r} & -\frac{v_{rz}}{E_\theta} & 0 \\
-\frac{v_{rz}}{E_r} & \frac{1}{E_r} - \frac{v_{rz}}{E_\theta} & \frac{v_{rz}}{E_\theta} & 0 \\
-\frac{v_{rz}}{E_\theta} & -\frac{v_{rz}}{E_\theta} & \frac{1}{E_\theta} & 0 \\
0 & 0 & 0 & \frac{1}{G_{rz}}
\end{array} \right]^{-1}
\]

In all these equations $E$ denotes Young's modulus of the isotropic material; $E_x$, $E_y$, $E_z$, $E_r$, $E_\theta$ are the Young's moduli of the orthotropic material along the corresponding axes; $\nu$ is a Poisson's ratio for isotropic
Stress Analysis

material; $\nu_{yx}$, $\nu_{zx}$, $\nu_{zy}$, $\nu_{rz}$, $\nu_{\theta z}$, $\nu_{\theta r}$ are the Poisson's ratios for orthotropic material; $G_{xy}$ and $G_{zr}$ are the shear moduli.

Thermal Strain

Temperature strain is determined by the coefficients of thermal expansion and difference of temperatures between strained and strainless states. Components of the thermal strain for plane stress and isotropic material are defined by the following equation:

$$
\{\varepsilon_0\} = \begin{Bmatrix} \alpha \\ \alpha \\ 0 \end{Bmatrix} \Delta T;
$$

plane stress, orthotropic material:

$$
\{\varepsilon_0\} = \begin{Bmatrix} \alpha_x \\ \alpha_y \\ 0 \end{Bmatrix} \Delta T;
$$

plane strain, isotropic material:

$$
\{\varepsilon_0\} = (1 + \nu) \begin{Bmatrix} \alpha \\ \alpha \\ 0 \end{Bmatrix} \Delta T;
$$

plane strain, orthotropic material:

$$
\{\varepsilon_0\} = \begin{Bmatrix} \alpha_x + \nu_{zx} \alpha_z \\ \alpha_y + \nu_{zy} \alpha_z \\ 0 \end{Bmatrix} \Delta T;
$$

axisymmetric problem, isotropic material:

$$
\{\varepsilon_0\} = \begin{Bmatrix} \alpha \\ \alpha \\ 0 \end{Bmatrix} \Delta T;
$$

axisymmetric problem, orthotropic material:

$$
\{\varepsilon_0\} = \begin{Bmatrix} \alpha_z \\ \alpha_r \\ \alpha_\theta \end{Bmatrix} \Delta T;
$$

where $\alpha$ is a coefficient of thermal expansion for isotropic material; $\alpha_x$, $\alpha_y$, $\alpha_z$, $\alpha_r$, $\alpha_\theta$ are the coefficients of thermal expansion along the
corresponding axes for orthotropic material; \( \Delta T \) is the temperature difference between strained and strainless states.

**External Forces**

QuickField provides way to specify concentrated loads, surface and body forces. The concentrated loads are defined at vertices as two components of the corresponding vector. The surface forces at the edges of the model are specified by the vector components or by the normal pressure. The body forces are defined by their components within blocks of the model. Each component of the body force vector can be specified as a function of the coordinates. This feature can be used, for example, to model centrifugal forces. The normal pressure also can be a function of the coordinates that is useful for hydrostatic pressure.

*Note.* The concentrated load is specified by the **force per thickness unit** for plane problems and by the **total force value** for axisymmetric ones. In the last case the force can be applied to the point at the axis of symmetry or distributed along the circle around the axis.

Any surface force which is directed along the normal to the surface can be described as a pressure. The pressure is considered positive if it is directed inside region at its outward boundary or from right to left at the inner boundary. Left and right are referred relative to the edge intrinsic direction, which is always counterclockwise for arcs and is determined for line segments by the order of picking vertices when the edge is created.

**Restriction Conditions**

Rigid constraint condition along one or both axes can be specified at any vertex or along any edge of the model. Prescribed displacement at restrained edge can be specified as a linear function of the coordinates.

Elastic support condition describes a vertex subject to springy force which is proportional to difference between actual and predetermined displacement. The elastic support condition is characterized by the predetermined displacement and the support elasticity.
Note. For problem to be defined correctly the constraint or elastic support conditions have to be specified in such a way to exclude rigid body shifts and rotations of the model or its parts without increasing the potential energy. Two translational and one rotational degrees of freedom have to be restricted for plane problem, in axisymmetric case only shift in $z$-direction has to be excluded.

Calculated Physical Quantities

For the stress analysis problems the QuickField postprocessor calculates the following set of physical quantities:

Local quantities:

- The absolute value of displacement
  \[ \delta = \sqrt{\delta_x^2 + \delta_y^2}, \text{ or } \delta = \sqrt{\delta_z^2 + \delta_r^2} \]
- Maximum and minimum principal stresses in the plane of model $\sigma_1$ and $\sigma_2$;
- Normal and tangential stresses along coordinate axes $\sigma_x$, $\sigma_y$ and $\tau_{xy}$ ($\sigma_z$, $\sigma_r$ and $\tau_{rz}$ in axisymmetric case);
- Normal stress in out-of-plane direction ($\sigma_z$—for $xy$-plane, $\sigma_0$—for $rz$-plane). For the plane stress problems this component vanishes by the definition;
- Von Mises criterion (stored energy of deformation):
  \[ \sigma_e = \sqrt{\frac{1}{2} \left[ (\sigma_1 - \sigma_2)^2 + (\sigma_2 - \sigma_3)^2 + (\sigma_3 - \sigma_1)^2 \right]} \]
  where $\sigma_1$, $\sigma_2$ and $\sigma_3$ denote the principal stresses in descending order.
- Tresca criterion (maximum shear):
  \[ \sigma_e = \sigma_1 - \sigma_3; \]
- Mohr-Coulomb criterion:
  \[ \sigma_e = \sigma_1 - \chi \sigma_3, \]
  where $\chi = [\sigma^+] / [\sigma^-]$;
  $[\sigma^+]$ and $[\sigma^-]$ denote tensile and compressive allowable stress.
- Drucker-Prager criterion:
\[ \sigma_e = (1 + \sqrt{\chi}) \sigma_i - \frac{\sqrt{\chi} - \chi}{1 + \sqrt{\chi}} \bar{\sigma} + \frac{1}{[\sigma_\text{min}]} \left( \frac{1 - \sqrt{\chi}}{1 + \sqrt{\chi}} \right)^2 \]

where \[\sigma_i = \sqrt{\frac{1}{2} [(\sigma_1 - \sigma_2)^2 + (\sigma_2 - \sigma_3)^2 + (\sigma_3 - \sigma_1)^2]}; \quad \bar{\sigma} = \frac{\sigma_1 + \sigma_2 + \sigma_3}{3}\]

- Tsai-Hill failure index for orthotropic materials:
\[ C_{th} = \frac{\sigma_1^2}{X_1^2} - \frac{\sigma_1 \sigma_2}{X_1^2 X_2^2} + \frac{\sigma_2^2}{X_2^4} + \frac{\tau_{12}^2}{S_{12}^2} \]

where \(\sigma_1, \sigma_2\) and \(\tau_{12}\) are computed stresses in the material directions and,
\(X_1 = X_1^T\) if \(\sigma_1 > 0\); \(X_1 = X_1^C\) if \(\sigma_1 < 0\)
\(X_2 = X_2^T\) if \(\sigma_2 > 0\); \(X_2 = X_2^C\) if \(\sigma_2 < 0\)
\(S_{12} = S_{12}^+\) if \(\tau_{12} > 0\); \(S_{12} = S_{12}^-\) if \(\tau_{12} < 0\)

where \(X_1^T, X_2^T, X_1^C, X_2^C, S_{12}^+\) and \(S_{12}^-\) are tensile, compressive and shear allowable stresses.

Integral quantities:
- Total force acting on a particular volume
\[ F = \oint_S (\sigma \cdot n) \, ds \]
where \(\sigma\) is the stress tensor.

The integral is evaluated over the boundary of the volume, and \(n\) denotes the vector of the outward unit normal.

- Total torque of the forces acting on a particular volume
\[ T = \frac{1}{2} \oint_S [r \times (\sigma \cdot n)] \, ds \]
where \(r\) is a radius vector of the point of integration.
The torque vector is parallel to $z$-axis in the planar case, and is identically equal to zero in the axisymmetric one. The torque is considered relative to the origin of the coordinate system. The torque relative to any other arbitrary point can be obtained by adding extra term of $\mathbf{F} \times \mathbf{r}_0$, where $\mathbf{F}$ is the total force and $\mathbf{r}_0$ is the radius vector of the point.

**Coupled Problems**

QuickField is capable of importing loads (distributed sources) calculated in some problem into the problem of another type. Following coupling types are supported:

- Heat transfer caused by Joule heat generated in the transient or AC magnetic problem, or DC or AC conduction problem.
- Thermal stresses based on a calculated temperature distribution.
- Stress analysis of the system loaded by magnetic or electric forces.
- Electrical conductivity depending on temperature.
- A special case of coupling allows for importing of the field distribution in some steady state or transient problem into another transient problem as its initial state. This applies to transient magnetic and transient heat transfer analysis.

In addition to imported loads, you can define any other loads and boundary conditions, similar to non-coupled problem.

You can combine several coupling types in one problem. E.g., after calculating currents distribution, electrostatic and magnetic fields as separate problems based on the same model file, you can calculate temperature distribution from Joule heat and then find stresses caused by temperature and magnetic and electric forces at once. However, such problems are rather rare.

Further we will call the problem, from which the data are being loaded, *the source problem*, and the problem, which imports the data, *the target problem*.

There are several rules to follow with coupled problems:

- Both source and target problem must share a single model file.
- Both problems must use the same formulation (plane or axisymmetric).
Source problem must be up-to-date when solving the target problem.

*Note.* In spite of the requirement that coupled problems must use the same model file, the geometrical region for the problems need not coincide, i.e. some subregions those are in use in one problem, could be excluded from consideration in the other one.

---

**Importing Joule Heat to Heat Transfer Problem**

While importing data from DC or AC conduction problem to heat transfer problem, heat sources due to Joule law are assumed in all subregions included into consideration in both source and target problems. In transient or AC magnetic problems, Joule heat is generated in all conductors. When importing Joule heat from transient magnetic problem into transient heat transfer, both processes are assumed to run synchronously. With this feature, you can simulate time-dependent heat distribution arising from time-dependent electric current distribution (including eddy currents) in a magnetic device.

**Importing Temperature Field to Stress Analysis Problem**

While calculating thermal stresses, initial strains are assumed in all subregions, which are included into consideration in both problems and possess nonzero value of thermal expansion coefficient (or at least one of its components in anisotropic case). While importing the temperature distribution from the transient problem, you can choose the moment of time, the state at which you wish to import.

**Importing Magnetic Forces to Stress Analysis Problem**

While importing magnetic force to stress analysis problem:

- Body force is assumed in all subregions included into consideration in both source and target problems, if those subregions have
nonlinear magnetic properties and/or current density is defined (Lorentz force).

- Surface force is assumed at the boundaries separating subregions with different magnetic properties, boundaries with surface current, or outward boundaries in sense of magnetic problem. The surface force is also generated in the cases, when only one subregion, say, to the left of the boundary is active in sense of magnetic problem, and only the subregion to the right of it is active in stress analysis problem.

While importing the magnetic forces from the transient problem, you choose the moment of time, the state at which you wish to import.

**Importing Electric Forces to Stress Analysis Problem**

While importing electric force to stress analysis problem:

- Body force is assumed for all subregions included into consideration in both source and target problems and carrying distributed charge density.
- Surface force is assumed at the boundaries separating subregions with different permittivity, boundaries with surface charge, or outward boundaries in sense of electric problem. The surface force is also generated in the cases, when only one subregion, say, to the left of the boundary is active in sense of electric problem, and only the subregion to the right of it is active in stress analysis problem.

**Importing Magnetic State to DC or AC Magnetic Problem**

QuickField is able to remember the magnetic state of the media in the source problem for further use in target problems, where it is necessary to take into account the actual magnetic saturation.

Quantity, transferred from DC Magnetic problem is the value of magnetic permeability, calculated in every finite element of the source problem.
• In non-linear materials the remembered value of magnetic permeability is calculated using the magnetic flux density in the source problem;
• In linear materials the remembered value of magnetic permeability is taken from the corresponding block label properties of the source problem.

Target problem will become linear, and the magnetic permeability values entered into the target problem description will be ignored and replaced by imported data. Magnetic state remembering is equivalent to the working point fixation for magnetic system. This gives the possibility to calculate the differential mutual and self-inductances of multi-coil system in the target problems, by calculating the magnetic flux induced by current in only one of coils at time.

**Importing Temperature Field to AC Magnetic Problem**

QuickField allows importing the calculated temperature field into a problem of AC magnetics. This temperature field may be then used for calculating the values of the electrical conductivity for materials where the conductivity is temperature-dependent.
Index

.m3d (model) files 31

2

2D and 3D problems 189

3

3D

2D sketch 187
extrusion 187, 190, 192
geometry model 191
import 190
level 192, 193
level, add 194
level, change 194
level, remove 195
problem 186
problem definition 190
view manipulation 200, 213
workflow 186

3D model

boundary conditions 209
camera 201
cutting by plane 205
import 196
labels 206
mesh spacing 207
object hiding 204
object selection 202
view 195, 197
zooming 201

3D problem

cut plane 220, 223
cut plane normal direction 221
electric charge 231
electric force 231
energy of electric field 231
field calculator 210
field presentation modes 212
field view presentations 212
finite element mesh 214

integral values 211, 230
local values 210, 229
objects hiding 213
result analysis 209
results 211
results window 210
results, colored surfaces 216
results, isosurface plot 220
results, scatter plot 218
results, vector plot 217
slice plot 225
solving 209
XY plot 227

A

AC conduction 27, 268
data for 85
ac magnetic 128, 252
AC magnetic 24
data for 76
adaptive meshing 118
add-in 182
analysis capabilities 22
animation 131
attraction distance 44
axisymmetric problem 238, 241, 248, 249, 256

B

background grid 64
beam of charged particles 175
B-H curve 22, 23, 72, 239, 246
block 41, 42, 238
and DC conduction data 83
and electric charge 261
and electric current 240, 247
and electric data 87
and electrostatic data 81
and heat source 276
and heat transfer data 89
and magnetic data 71
and mesh 61
and stress analysis data 91
copying 45
Theoretical Description

excluding from analysis 72, 81, 83, 85, 87, 89, 92
labeling 59
boundary
inner 239
outward 239
boundary condition 68, 240, 248, 256, 262, 266, 269, 272, 277
constant potential 263, 264, 267, 270, 273
constant temperature 278
convection 278
displacement 94, 284
electric potential 262, 266, 269, 273
heat flux 277
known temperature 277
periodic 95
radiation 278
zero flux 241, 249, 257

C

CAD systems 65
calculated quantities 121
calculator 132, 136
capacitance 26, 136, 140
calculation 264
wizard 140
capacitance matrix 182
charge
electric 26, 140, 146, 261, 263, 264
circuit 111
element 112
coefficient
of convection 278
of emissivity 278
of polarization 253
of thermal expansion 283
coercive force See force: coercive
coil
spiral 240, 247, 255
color legend 175
color map 126
conductivity
electric 23, 25, 26, 72, 76, 77, 85, 124, 265, 287, 290, See also
resistivity: electric, See also
resistivity: electric
temperature dependent 34, 83
thermal 29, 89, 96, 125, 276
temperature dependent 90
very high 278
conductivity, electric 83
conductor
connected in series 73, 78, 240, 247, 255
electric 25
floating 263
isolated See conductor: floating
contour
editing 143
convection 91, 278
coordinates
Cartesian 39
polar 39
copying
pictures 66, 179
core loss 258
coupled problems 287
coupling 33
electro-structural 26, 27, 289
electro-thermal 24, 25, 27, 288
initial magnetic state 24
initial thermal state 29
magneto-structural 23, 24, 25, 288
remembering magnetic state 23
remembering the magnetic state 289
thermo-structural 29, 93, 288
creating
circuit 112
to 43
label 70
model 42
problem 31
vertex 43
criterion
Drucker-Prager 93, 125, 285
Hill 93
Theoretical Description

Mohr-Coulomb 93, 125, 285
Tresca 125, 285
Tsai-Hill 125, 286
von Mises 125, 285
current 146, 240, 255
active 124, 270, 274
alternating 24, 27, 252, 268
apparent 124, 270
density 22, 23, 25, 26, 71, 73, 76, 123, 239, 254, 265
density, units of 38
density, volume 254
displacement 274
eddy 24, 121, 122, 245, 250, 253, 257
electric 27, 246, 254
reactive 124, 270
source 24, 121, 122, 245, 250, 253, 256, 257
surface 241, 249, 257
time-dependent 23
total 24, 73, 121, 122, 250, 257
volume 239, 240, 246, 247
curve
ing 96

D
data
AC conduction 85
AC magnetics 76
DC conduction 83
electrostatics 81
heat transfer 89
magnetostatics 71
stress analysis 91
transient electric 87
transient magnetics 71
dc conduction 265
DC conduction 26
data for 83
dcf(dc conduction data) files 31
dec(ac conduction data) files 31
deformed shape 127
des (electrostatic data) files 31
describing
geometry 42
dhe (ac magnetic data) files 31
dht (steady-state and transient heat transfer data) files 31
dielectric constant See electric permittivity
displacement 30, 125, 130, 279, 285
boundary condition 94
components 280
prescribed 30
units of 38
dms (magnetostatic and transient magnetic data) files 31
dsa (stress analysis data) files 31
dtv (transient electric data) files 31
DXF file
export 66
import 65

E
drive 41, 42, 238, 241, 257
and AC conduction data 86
and AC magnetic data 80
and boundary condition 240, 248, 256, 263, 266, 269, 273, 277, 284
and DC conduction data 84
and electric charge 261
and electric current 266, 269, 272
and electric data 88
and electrostatic data 82
and heat source 276
and heat transfer data 91
and magnetic data 74
and stress analysis data 94
copying 45
creating 43, 44
deleting 47
direction of 284
labeling 59
electric
boundary condition 262, 266
electric conductivity 83, 272
electric motor 22, 23, 24
electric permittivity 26, 81, 85, 87, 123, 124, 125, 261, 263, 268, 271, 272, 274
electrostatic analysis 25, 261
data for 81
emissivity coefficient 278
emitter 175
energy
  of deformation 125
  of electric field 26, 123, 140, 264
  of magnetic field 23, 24, 25, 121,
    123, 137, 244, 251, 252, 258
exporting
  DXF file 66
  pictures 66

field 59
  electric 245, 272
  electric, transient 28
  lines 126
  local data 133
  magnetic 239, 241, 242, 245, 249,
    250, 257
  magnetic, uniform external 22, 23,
    25, 240, 248, 256
  picture 126, 130
  presentation methods 126
  source 42, 59, 68, 147, 238, 239,
    247, 255, 261, 266, 269, 272
film coefficient See coefficient: of
convection
floating conductor 26
flux
density 22, 23, 24, 25, 96, 121, 122,
  239, 240, 243, 248, 250, 254, 256,
  257
  function 242
  lines 126
  linkage 22, 23, 24, 139, 147, 244,
    245, 252
  thermal 29, 91, 146, 279
    boundary condition 277
    density 277
force 146
  centrifugal 284
  coercive 71, 239, 240, 242, 246, 247,
    249
  electric 26, 27, 30, 33, 264, 271, 274,
    289
  Lorentz 123, 258, 289
magnetic 22, 23, 24, 25, 30, 33, 243,
  251, 259
Maxwell 259
formula
  editing 98
frequency 253, 254
  angular 253, 268

G
  geometric objects
    copying 45
    moving 46
    selecting 44
  geometry
    describing 42

H
  hardware requirements 12
  heat
    specific 29
  heat flow 125
  heat transfer 24, 25, 28, 275
    coupling 33
    data for 89
    transient 29

I
  impedance 24, 25, 136, 142, 260, See also
  inductance
    wizard 142
importing
  data 33
  DXF file 65
  electric forces to stress analysis 289
  Joule heat to heat transfer analysis 288
  magnetic forces to stress analysis
    288
  temperatures to stress analysis 288
inductance 23, 24, 25, 136, 137, 260
  calculation 244
  wizard 137
induction
of electric field 123, 124, 125, 262, 263
remanent 242, 250
inductor 24
installing QuickField 12
autorun 13
integral quantities 146, 243, 251, 258, 263, 267, 271, 279, 286
intensity
of electric field 123, 124, 261, 267, 270, 274
of electric field, gradient of 123, 124
of magnetic field 22, 23, 24, 96, 121, 123, 241, 243, 248, 251, 256, 257
isotherm 126

J
Joule heat 24, 122, 151, 152, 251, 257, 258, 268, See power: losses

L
label 41, 42, 117
assigning data to 70
assigning to geometric objects 59
copying data 109
deleting data 109
editing data 70
renaming 109
legend 175
loading See also field source
AC magnetic analysis 25
DC conduction analysis 26
electrostatic analysis 26
force 30, 284
heat transfer analysis 29
magnetostatic analysis 22
pressure 30, 284
thermal 30, 93, 130, 283
local field data 133
copying to clipboard 133

M
magnetic permeability 23, 25, 71, 72, 76, 121, 123, 239, 242, 243, 246, 250, 251, 254, 257, 258
magnetostatic analysis 22, 239
data for 71
manipulating
objects 44
material
isotropic 30, 282, 283
orthotropic 22, 23, 25, 26, 27, 28, 29, 30, 125, 281, 283, 286
memory 118
mesh 42, 43, 117
building 59
deleting 61
density 43, 60
nonuniform 59
refinement 118
spacing 41, 42, 60, 63
visibility 61, 63
visibility options 63
mod (model) files 31
model
creating 42
editing 39
genetry 41
plane of 238
printing 67
three-dimensional 186
view options 63

O
objects
manipulating 44
ohmic losses See power: losses

P
particle 175
particles trajectory 175
password 14
pbm (problem description) files 31
peak value 253, 268
periodic boundary conditions 95
permanent magnet 22, 23, 71, 239, 240, 242, 245, 247, 249, 250, 254
equivalent current 242, 249
phase angle 253, 268
physical quantities 242, 250, 257, 267, 270, 274
heat transfer 278
stress analysis 285
picture
copying 66, 179
exporting 66
printing 179
picture, of the field 127
plane strain See strain: plane
plane stress 285, See stress: plane
Poisson's ratio 282
polarization
coefficient of 253
linear 253
potential
electric 123, 124, 261, 263, 264, 265, 267
magnetic 23, 24, 25, 121, 239, 245, 254
power
active 271, 274
apparent 271
losses 24, 25, 26, 29, 34, 123, 124, 257, 258, 271, 274
reactive 271, 274
Poynting vector 123, 258, 259
pressure 30, 94
hydrostatic 284
printing
pictures 67, 179
X-Y plots 179
problem
creating 31
database 31
description 31
editing 31
solving 117
temperature units 97
three-dimensional See. 3D:problem
properties window
problem 22, 39

R
radiation 91, 278
res (results) files 31
resistivity
electric 26, 28, 124, 267

S
selecting
circuit elements 114
geometric objects 44
vertices 60
serial conductor 78
shear modulus 283
solenoid 22, 24
source
thermal 25, 27, 276, 277
specific heat 276
spiral coil 247
Stephan-Boltsman constant 278
strain 125
coupling 33
data for 91
presentation methods 127
with imported loads 287, 288, 289
superconductor 22, 24, 25, 241, 249, 257

T
tables
in postprocessor 131, 169
versus time 174
Theoretical Description

temperature  28, 29, 34, 90, 96, 125, 275
ambient, for convection  278
ambient, for radiation  278
curve  90
difference  130
terminology  20, 41
three-dimensional problem  See 3D:problem
torque  146
  of electric forces  26, 27, 264, 271, 275
  of magnetic forces  22, 23, 24, 243, 251, 259
transformer  23
transient analysis
electric  272
transient analysis
  heat transfer  29
  data for  89
  initial condition  34
  magnetic  23, 33, 245
    data for  71
  plot versus time  171
  time layer selecting  130
timing  35, 36

U
units of length  38

V
vertex  41, 42, 238, 239, 255
  and AC conduction data  87
  and AC magnetic data  81
  and boundary condition  240, 248, 256, 266, 269, 273, 277, 284
  and DC conduction data  85
  and electric charge  261
  and electric current  266, 269, 272
  and electric data  88
  and electrostatic data  83
  and heat source  276
  and heat transfer data  91
  and magnetic data  75
  and mesh spacing  43, 60, 61
  and stress analysis data  94
copying  45
creating  43, 44
deleting  47
labeling  59
voltage  24, 25, 27, 76, 247, 255,  See potential: electric
volume power  89

W
window
document  21
  problem  20
tools  21
wizard  136
capacitance  26, 140
impedance  25, 142
inductance  23, 25, 137

X
X-Y plot  131, 144
  copying  179
  printing  179
  versus time  172

Y
Young's modulus  282
Young's modulus  92

Z
zooming  63, 130